should not be relied upon in making purchasing decisions. The development, release, and timing of any
features or functionality described in this document remains at the sole discretion of Oracle.

This document in any form, software or printed matter, contains proprietary information that is the
exclusive property of Oracle. Your access to and use of this confidential material is subject to the terms
and conditions of your Oracle Master Agreement, Oracle License and Services Agreement, Oracle
PartnerNetwork Agreement, Oracle distribution agreement, or other license agreement which has
been executed by you and Oracle and with which you agree to comply. This document and information
contained herein may not be disclosed, copied, reproduced, or distributed to anyone outside Oracle
without prior written consent of Oracle. This document is not part of your license agreement nor can it be
incorporated into any contractual agreement with Oracle or its subsidiaries or affiliates.

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website

Oracle customers that have purchased support have access to electronic support through My Oracle
Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://
www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Sample Code

Oracle may provide sample code in SuiteAnswers, the Help Center, User Guides, or elsewhere through
help links. All such sample code is provided “as is” and “as available”, for use only with an authorized
NetSuite Service account, and is made available as a SuiteCloud Technology subject to the SuiteCloud
Terms of Service at www.netsuite.com/tos.

Oracle may modify or remove sample code at any time without notice.

No Excessive Use of the Service

As the Service is a multi-tenant service offering on shared databases, Customer may not use the Service
in excess of limits or thresholds that Oracle considers commercially reasonable for the Service. If Oracle
reasonably concludes that a Customer's use is excessive and/or will cause immediate or ongoing
performance issues for one or more of Oracle's other customers, Oracle may slow down or throttle
Customer's excess use until such time that Customer's use stays within reasonable limits. If Customer's
particular usage pattern requires a higher limit or threshold, then the Customer should procure a
subscription to the Service that accommodates a higher limit and/or threshold that more effectively aligns
with the Customer's actual usage pattern.

Beta Features

Oracle may make available to Customer certain features that are labeled “beta” that are not yet generally
available. To use such features, Customer acknowledges and agrees that such beta features are subject
to the terms and conditions accepted by Customer upon activation of the feature, or in the absence of
such terms, subject to the limitations for the feature described in the User Guide and as follows: The beta
feature is a prototype or beta version only and is not error or bug free and Customer agrees that it will
use the beta feature carefully and will not use it in any way which might result in any loss, corruption or
unauthorized access of or to its or any third party's property or information. Customer must promptly
report to Oracle any defects, errors or other problems in beta features to support@netsuite.com or
other designated contact for the specific beta feature. Oracle cannot guarantee the continued availability
of such beta features and may substantially modify or cease providing such beta features without
entitling Customer to any refund, credit, or other compensation. Oracle makes no representations or
warranties regarding functionality or use of beta features and Oracle shall have no liability for any lost
data, incomplete data, re-run time, inaccurate input, work delay, lost profits or adverse effect on the
performance of the Service resulting from the use of beta features. Oracle's standard service levels,
warranties and related commitments regarding the Service shall not apply to beta features and they may
not be fully supported by Oracle's customer support. These limitations and exclusions shall apply until the
date that Oracle at its sole option makes a beta feature generally available to its customers and partners
as part of the Service without a “beta” label.
Send Us Your Feedback

We'd like to hear your feedback on this document.

Answering the following questions will help us improve our help content:

- Did you find the information you needed? If not, what was missing?
- Did you find any errors?
- Is the information clear?
- Are the examples correct?
- Do you need more examples?
- What did you like most about this document?

Click [here](#) to send us your comments. If possible, please provide a page number or section title to identify the content you're describing.

To report software issues, contact NetSuite Customer Support.
## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboards Overview</td>
<td>1</td>
</tr>
<tr>
<td>Dashboards</td>
<td>2</td>
</tr>
<tr>
<td>Dashboards Overview</td>
<td>2</td>
</tr>
<tr>
<td>Dashboard Portlets</td>
<td>2</td>
</tr>
<tr>
<td>Portlet Types Table</td>
<td>3</td>
</tr>
<tr>
<td>Dashboard Personalization</td>
<td>10</td>
</tr>
<tr>
<td>Dashboard Layouts</td>
<td>11</td>
</tr>
<tr>
<td>Adding a Portlet to a Dashboard</td>
<td>11</td>
</tr>
<tr>
<td>Arranging Dashboard Portlets</td>
<td>13</td>
</tr>
<tr>
<td>Setting Up Dashboard Portlet Content</td>
<td>13</td>
</tr>
<tr>
<td>Calendar Portlets</td>
<td>15</td>
</tr>
<tr>
<td>Custom Portlets</td>
<td>17</td>
</tr>
<tr>
<td>Custom Search Portlets</td>
<td>36</td>
</tr>
<tr>
<td>KPI Meter Portlets</td>
<td>36</td>
</tr>
<tr>
<td>KPI Scorecard Portlet</td>
<td>37</td>
</tr>
<tr>
<td>Key Performance Indicators Portlet</td>
<td>37</td>
</tr>
<tr>
<td>List Portlets</td>
<td>38</td>
</tr>
<tr>
<td>Phone Calls Portlet</td>
<td>38</td>
</tr>
<tr>
<td>Quick Add Portlet</td>
<td>39</td>
</tr>
<tr>
<td>Quick Search Portlet</td>
<td>41</td>
</tr>
<tr>
<td>Project Tasks Portlets</td>
<td>42</td>
</tr>
<tr>
<td>RSS/Atom Feed Portlets</td>
<td>42</td>
</tr>
<tr>
<td>Reviewing Recent Records</td>
<td>44</td>
</tr>
<tr>
<td>Setting Up Reminders</td>
<td>45</td>
</tr>
<tr>
<td>Report Snapshot Portlets</td>
<td>55</td>
</tr>
<tr>
<td>Search Form Portlet</td>
<td>55</td>
</tr>
<tr>
<td>Settings Portlet</td>
<td>56</td>
</tr>
<tr>
<td>Shortcuts Portlet</td>
<td>56</td>
</tr>
<tr>
<td>SMT Links Portlet</td>
<td>59</td>
</tr>
<tr>
<td>SuiteApp Portlets</td>
<td>59</td>
</tr>
<tr>
<td>Tasks Portlet</td>
<td>60</td>
</tr>
<tr>
<td>Trend Graph Portlets</td>
<td>60</td>
</tr>
<tr>
<td>Printing and Exporting Dashboard Content</td>
<td>61</td>
</tr>
<tr>
<td>Customer Dashboards</td>
<td>61</td>
</tr>
<tr>
<td>Key Performance Indicators Overview</td>
<td>64</td>
</tr>
<tr>
<td>Setting Up the Key Performance Indicators Portlet</td>
<td>64</td>
</tr>
<tr>
<td>Viewing Key Performance Indicator Data</td>
<td>67</td>
</tr>
<tr>
<td>Setting Up KPI Comparisons</td>
<td>68</td>
</tr>
<tr>
<td>Highlighting KPIs</td>
<td>69</td>
</tr>
<tr>
<td>Standard Key Performance Indicators Table</td>
<td>70</td>
</tr>
<tr>
<td>KPI Meters</td>
<td>80</td>
</tr>
<tr>
<td>Trend Graphs</td>
<td>82</td>
</tr>
<tr>
<td>Setting Up Popup Trend Graphs</td>
<td>85</td>
</tr>
<tr>
<td>Setting Up Trend Graph Portlets</td>
<td>88</td>
</tr>
<tr>
<td>Custom KPIs</td>
<td>90</td>
</tr>
<tr>
<td>Selecting an Existing Search to be a Custom KPI</td>
<td>91</td>
</tr>
<tr>
<td>Creating a New Search to be a Custom KPI</td>
<td>92</td>
</tr>
<tr>
<td>Adding a Custom KPI to the Key Performance Indicators Portlet</td>
<td>93</td>
</tr>
<tr>
<td>Using a Custom KPI in a KPI Scorecard</td>
<td>93</td>
</tr>
<tr>
<td>KPI Scorecards Overview</td>
<td>95</td>
</tr>
<tr>
<td>Enabling the KPI Scorecards Feature</td>
<td>96</td>
</tr>
<tr>
<td>Adding a KPI Scorecard Portlet to a Dashboard</td>
<td>96</td>
</tr>
<tr>
<td>Creating a KPI Scorecard</td>
<td>97</td>
</tr>
<tr>
<td>Entering Basic Scorecard Information</td>
<td>98</td>
</tr>
</tbody>
</table>
Defining KPI Scorecard Comparisons ................................................................. 99
Defining KPI Scorecard Formulas ................................................................. 100
Defining KPI Scorecard Date Ranges or Periods ............................................. 104
Highlighting KPI Scorecard Results ............................................................... 116
Sharing a Custom KPI Scorecard ................................................................. 117
Editing a KPI Scorecard .............................................................................. 118
Financial Ratios Scorecard ........................................................................... 118
Financial Ratios Scorecard Formulas ............................................................ 119
Report Snapshots Overview ......................................................................... 121
Adding a Report Snapshot Portlet ................................................................. 122
Standard Report Snapshots Table ................................................................. 123
Setup Options for Comparative Sales Report Snapshots ................................ 128
Creating Custom Report Snapshots .............................................................. 130
Deleting a Custom Report Snapshot .............................................................. 131
Reports Available for Custom Report Snapshots .......................................... 131
Sales Management Snapshots ...................................................................... 132
Setting Up a Report Snapshot Portlet ............................................................ 133
Workbooks Overview ................................................................................ 137
Adding an Analytics Portlet ........................................................................... 137
Setting Up the Analytics Portlet ................................................................. 138
Viewing the Workbook Data in the Analytics Portlet ..................................... 139
Opening Workbooks from the Analytics Portlet .......................................... 139
Publishing Dashboards Overview ............................................................... 140
Publish Dashboards Permission ................................................................. 141
Publishing a Dashboard ............................................................................... 142
Assigning Published Dashboards to Users .................................................. 144
Restricting Users' Dashboard Personalizations .......................................... 145
Applying Changes to Published Dashboards .............................................. 145
Copying a Published Dashboard to Another Account .................................. 146
FAQ: Dashboards ....................................................................................... 147
Dashboards

- Dashboards Overview
- Key Performance Indicators Overview
- KPI Scorecards Overview
- Report Snapshots Overview
- Workbooks Overview
- Publishing Dashboards Overview
- FAQ: Dashboards
Dashboards Overview

You can create a unique dashboard setup to ensure maximum efficiency and ease when you use NetSuite. For each user, NetSuite displays a variable set of tabbed pages, called a **center**. The center is based on the user's assigned role. Each NetSuite center provides the pages and links that users with the same role need to do their jobs.

Most tabbed pages of each center display a collection of real-time data relevant to the page and to the role of the user viewing the page. This collection, called a **dashboard**, provides a visual workspace that gives users instant, uninterrupted access to accurate information. A dashboard is available not only on your home page, but on every page you see in NetSuite except the Documents, Setup, and Customization pages. On your dashboards, you can view the data you need to make decisions, and edit records.

Dashboard content is displayed in a variety of **portlets**, dynamic data display windows. Some portlets provide direct access to raw data, and others display data that has been synthesized into critical business metrics, such as key performance indicators (KPIs), performance scorecards, trend graphs, chart-based workbooks, and report snapshots. Other portlets enable you to display data from website RSS feeds.

For each page, NetSuite provides a default dashboard configuration that can be changed to meet individual users' business needs. Administrators can personalize the dashboards for one or more pages and **publish** them to a group of users so that they all see a consistent interface. The dashboards that users see depend on their roles. Administrators can choose whether to give individual users the ability to personalize their own dashboards further.

To set up dashboards, you need to understand the following:

- The different types of content available. See **Dashboard Portlets**.
- How to modify a default dashboard to include the content you need. See **Dashboard Personalization**.
- How to publish dashboards to groups of users. (You must have the Publish Dashboards permission for this task.) See **Publishing Dashboards Overview**.

**Note:** NetSuite dashboards include functionality provided by HighCharts JS, which is software owned by and licensed through Highsoft Solutions AS.

Dashboard Portlets

NetSuite offers many types of content for dashboard portlets. To see the content available on a particular page, click **Personalize Dashboard** in the Settings portlet or **Personalize** in the upper right corner of the
Using portlets

Portlet controls are hidden until you move your pointer over the portlet.

If a dashboard contains a portlet that is extremely slow to load, the first time the portlet opens, NetSuite may display a popup suggesting that you minimize the portlet to speed dashboard loading time.

- To minimize a portlet, click its title bar. When you move your pointer over the title bar, it changes to crossed arrows as shown.

  ![Reminders Portlet](image)

  Click the title bar again to expand the portlet's content.

Portlets with content that is calculated from current data include a Refresh icon on the right of the title bar.

- Click the icon to refresh the portlet content and ensure it includes the latest data.

  ![Reminders Portlet](image)

You can expand certain portlets to full-screen view. This option is available for Trend Graph, Report Snapshots, List, Custom Search, Tasks, and Phone Calls portlets. The full-screen view of the portlet displays more columns and rows in the search results for List, Custom Search, Tasks, and Phone Calls portlets.

- Maximize the portlet into full-screen view by clicking the double arrow icon in the upper right corner of the portlet.

Portlet Types Table

The following table describes content available for display in dashboard portlets, and notes how you can set up content after adding portlets to your dashboard.

---

### Note:
Not all content is available on all pages. To see the content that is available for a specific page, click Personalize in the upper right corner of the page or the Personalize Dashboard in the Settings portlet. The Personalize Dashboard panel lists the content you can add. Portlets have task links, in some cases, including a Set Up link, available under icons in their upper right corner. For details, see Setting Up Dashboard Portlet Content.

---

For most content, you can display one portlet per dashboard on a standard NetSuite tab. The table explicitly notes content that can be displayed in multiple portlets. Custom NetSuite tabs may have multiple portlets with other content as well.
<table>
<thead>
<tr>
<th>Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Account Reconciliation Summary</strong></td>
<td>Lists your bank and credit card accounts and displays the key data for matching and reconciliation activities.</td>
</tr>
<tr>
<td></td>
<td>Information for each account includes the currency, GL account balance, last reconciled balance, last reconciled date, bank (imported) statement balance, bank (imported) statement date, and the number of items that require matching. To view the Bank Register Report for one of the listed accounts, click the hyperlinked account name.</td>
</tr>
<tr>
<td></td>
<td>If your user role has the permissions for the Reconcile Account Statement page, this portlet is on your dashboard by default. If you remove it, the portlet is available in the Personalize Dashboard panel.</td>
</tr>
<tr>
<td></td>
<td>For details on account reconciliation, see the help topic Bank Data Matching and Reconciliation.</td>
</tr>
<tr>
<td><strong>Analytics</strong></td>
<td>(Can display up to 10.)</td>
</tr>
<tr>
<td></td>
<td>Shows one workbook-based chart or pivot table per portlet.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, click Set Up to select a chart or pivot table from the list. You can also define layout options for the displayed portlets, such as the portlet title and specific options for charts and pivot tables.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Workbooks Overview.</td>
</tr>
<tr>
<td><strong>Calendar</strong></td>
<td>Lists activities for a selected period ordered by date and time, with links to drill down into individual activity records.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, you can select between a daily, weekly, monthly, or agenda view. You can choose to display your own calendar or a public calendar for another entity within the organization.</td>
</tr>
<tr>
<td></td>
<td>You can click the Set Up menu option for the portlet to display a popup where you can define the types of activities to display in the calendar.</td>
</tr>
<tr>
<td></td>
<td>Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon. The full-screen view of the portlet displays more columns and rows in the search results.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Calendar portlet is supported by the Copy to Account feature. If the portlet is included in a published dashboard and the dashboard is copied to another account, the portlet is also copied. For more information, see the help topics Copy to Account Overview and Copying a Published Dashboard to Another Account.</td>
</tr>
<tr>
<td></td>
<td>For more details, see Calendar Portlets.</td>
</tr>
<tr>
<td><strong>Custom Portlet</strong></td>
<td>(Can display up to six.)</td>
</tr>
<tr>
<td></td>
<td>Shows results from a portlet SuiteScript, which can be lists, data entry forms, free-form HTML, or links to external data.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, click Set Up to select the source file for the SuiteScript results.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The custom portlet is supported by the Copy to Account feature. If the portlet is included in a published dashboard and the dashboard is copied to another account, the portlet is also copied. You can also use the Copy to Account feature to copy an individual script to another of your accounts. For more information, see the help topics Copy to Account Overview and Copying a Published Dashboard to Another Account.</td>
</tr>
<tr>
<td></td>
<td>For information about creating scripts, see the help topic Portlet Scripts.</td>
</tr>
<tr>
<td><strong>Custom Search</strong></td>
<td>(Can display up to six on the Home page.)</td>
</tr>
<tr>
<td></td>
<td>Shows results from a saved search.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, click Set Up to select the saved search, specify a custom title for the portlet, the number of results to display, whether to drill down into search results in the portlet or on a new page.</td>
</tr>
<tr>
<td>Content</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Dashboard Portlets</strong></td>
<td></td>
</tr>
</tbody>
</table>

page, and, if the Inline Editing feature is enabled, whether to enable inline editing of search results.

Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon ‣. The full-screen view of the portlet displays more columns and rows in the search results.

**Note:** When placed in the right or left columns of a dashboard, custom search portlets display only the first 4 results columns of the saved search. When placed in the center column, they display the first 9 results columns. Custom search portlets also include New, Edit, and View columns with links for each result record.

**Note:** The Custom Search portlet is supported by the Copy to Account feature. If the portlet is included in a published dashboard and the dashboard is copied to another account, the portlet is also copied. You can also use the Copy to Account feature to copy an individual saved search to another of your accounts. For more information, see the help topics Copy to Account Overview and Copying a Published Dashboard to Another Account.

For more details, see the help topic Displaying Saved Search Results in Dashboard Portlets.

**KPI Meter**

(Can display up to three.)

Shows up to three graphical meters of key performance indicator (KPI) data. The KPI meter also displays the currency symbol of the data for values represented by currencies.

In the portlet, select a KPI to display from the dropdown list. Click Set Up to select date range(s), highlighting, and comparison options. You also can click menu options to print the KPI meter or download it to a PNG, JPG, PDF, or SVG file.

Choices of KPIs for a meter are limited to the KPIs displayed in the dashboard's Key Performance Indicators portlet, plus the following: Actual vs. Forecast, Actual vs. Quota, and Forecast vs. Quota.

**Note:** The KPI Meter portlet is supported by the Copy to Account feature. If the portlet is included in a published dashboard and the dashboard is copied to another account, the portlet is also copied. You can also use the Copy to Account feature to copy an individual saved search to another of your accounts. For more information, see the help topics Copy to Account Overview and Copying a Published Dashboard to Another Account.

For more information, see KPI Meters.

**KPI Scorecard**

Shows a performance scorecard with comparisons of selected key performance indicator (KPI) data.

In the portlet, click Set Up to select a KPI Scorecard and layout options.

For more information, see KPI Scorecards Overview.

**Key Performance Indicators**

Shows key business metrics. These metrics are summary data from reports or saved searches for selected date ranges, with options to show comparisons between date ranges and to highlight results not meeting defined thresholds. You can define up to eight KPIs as headlines. Each KPI headline appears in bold and is represented in a trend graph. The lower panel lists the rest of KPIs. You can collapse and expand the list of KPI as needed.

In the portlet, click Refresh to refresh all KPIs, or click the Refresh icon next to an individual KPI to refresh one at a time. If available, click the Trend Graph icon next to a KPI to view a popup trend graph of KPI data.

Click **Set Up** to select standard KPIs or custom KPIs based on custom saved searches. You can define comparison and highlighting options, and define the appearance of popup trend graphs.
<table>
<thead>
<tr>
<th>Content</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The KPI Portlet can be displayed in a wide or narrow column. If the KPI portlet is shown in a narrow column, the headlines are not represented in a trend graph due to the compact format of the narrow column. You can view a popup trend graph by clicking the Trend Graph icon next to a KPI in the list of KPIs, if available. This option is enabled by default.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The Key Performance Indicator (KPI) portlet is supported by the Copy to Account feature. If the portlet is included in a published dashboard and the dashboard is copied to another account, the portlet is also copied. You can also use the Copy to Account feature to copy an individual saved search to another of your accounts. For more information, see the help topics Copy to Account Overview and Copying a Published Dashboard to Another Account.</td>
<td></td>
</tr>
<tr>
<td>For more information, see Key Performance Indicators Overview.</td>
<td></td>
</tr>
<tr>
<td>Links</td>
<td>Shows links to pages that NetSuite has defined as related.</td>
</tr>
<tr>
<td>This portlet is available on the Activities, Cases, Customers, Lists, Reports, and Transactions pages.</td>
<td></td>
</tr>
<tr>
<td>Unlike other portlets, which are column-oriented and sorted top to bottom, the Links portlet is row-oriented and sorted left to right.</td>
<td></td>
</tr>
<tr>
<td>List</td>
<td>Shows a list of records of a selected type, with links to view, and if you have permission, to edit, individual records. Shows 9 columns when placed in the center column of the dashboard; shows 4 columns when placed in the right or left column.</td>
</tr>
<tr>
<td>In the portlet, click Set Up to select a type of record and the number of records shown.</td>
<td></td>
</tr>
<tr>
<td>If the Inline Editing feature is enabled and you have permission, you can edit records directly in the portlet. See the help topic Using Inline Editing.</td>
<td></td>
</tr>
<tr>
<td>Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon. The full-screen view of the portlet displays more columns and rows in the search results.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> On some tabs, the available List portlets are configured to show predefined types of records. For example, the Activities page offers Tasks and Phone Calls list portlets.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The List portlet is supported by the Copy to Account feature. If the portlet is included in a published dashboard and the dashboard is copied to another account, the portlet is also copied. You can also use the Copy to Account feature to copy an individual list view to another of your accounts. For more information, see the help topics Copy to Account Overview and Copying a Published Dashboard to Another Account.</td>
<td></td>
</tr>
<tr>
<td>My Login Audit</td>
<td>Shows information about your login activity. You can display the My Login Audit portlet on your dashboard to track your previous successful login, your previous failed login, the IP address associated with your login activity, the date when your password will expire, and other login information.</td>
</tr>
<tr>
<td><strong>Note:</strong> The date and time displayed in the My Login Audit portlet is based on the Time Zone preference you set on the General subtab at Home &gt; Set Preferences. For more information, see the help topic General Personal Preferences.</td>
<td></td>
</tr>
<tr>
<td>For more information, see the help topic My Login Audit Portlet.</td>
<td></td>
</tr>
<tr>
<td>New Release</td>
<td>Shows a summary of new features from the latest release of NetSuite, with links to more detailed descriptions.</td>
</tr>
<tr>
<td>Content</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Phone Calls</strong></td>
<td>Shows a list of upcoming phone calls, with links to view, and if you have permission, to edit, individual records.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, select a view and a sorting method, and click Set Up to define the number of phone calls shown.</td>
</tr>
<tr>
<td></td>
<td>If the Inline Editing feature is enabled and you have permission, you can edit records directly in the portlet list.</td>
</tr>
<tr>
<td></td>
<td>Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon. The full-screen view of the portlet displays more columns and rows in the search results.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Phone Calls Portlet.</td>
</tr>
<tr>
<td><strong>Project Tasks</strong></td>
<td><strong>(Available when the Project Management feature is enabled. To learn how to enable Project Management, see the help topic Enabling Project Features.)</strong></td>
</tr>
<tr>
<td></td>
<td>This portlet is available on the Projects tab.</td>
</tr>
<tr>
<td></td>
<td>Shows a list of project tasks with links to view, and if you have permission, to edit, individual records. Shows project tasks assigned to you and other project resources,</td>
</tr>
<tr>
<td></td>
<td>In the portlet, select a view and a sorting method. Click Set Up to define the number of tasks shown.</td>
</tr>
<tr>
<td></td>
<td>For more information, see the help topic Tasks and Project Tasks Portlets on Your Dashboard.</td>
</tr>
<tr>
<td><strong>Quick Add</strong></td>
<td>Shows a form where you can quickly add records of a selected type.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, click Set Up if you want to change the type of records to be added. For more information, see Quick Add Portlet.</td>
</tr>
<tr>
<td><strong>Quick Search</strong></td>
<td>Shows a form where you can quickly search for records of a selected type, using one selected filter field and entered keywords.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, click Set Up to define the type of records to search, then enter keywords in the portlet's text box and select a field name from the Search For dropdown list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Quick Search portlet is supported by the Copy to Account feature. If the portlet is included in a published dashboard and the dashboard is copied to another account, the portlet is also copied. For more information, see the help topics Copy to Account Overview and Copying a Published Dashboard to Another Account.</td>
</tr>
<tr>
<td></td>
<td>For more information about Quick Search, see the help topic Quick Search Portlet.</td>
</tr>
<tr>
<td><strong>RSS/Atom Feed</strong></td>
<td><strong>(Can display up to two.)</strong></td>
</tr>
<tr>
<td></td>
<td>Shows RSS or Atom feed URL content, from an external website or HTML document.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, click Set Up to select display options and a URL. NetSuite provides a number of standard RSS feed URLs, or you can choose Custom and enter another URL.</td>
</tr>
<tr>
<td></td>
<td>For more information, see RSS/Atom Feed Portlets.</td>
</tr>
<tr>
<td><strong>Recent Records</strong></td>
<td>Shows a list of records that you have recently created, modified, or viewed.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, click the record to view it. If you have permission, an Edit link is also available. You can click it to open the record in Edit mode.</td>
</tr>
<tr>
<td></td>
<td><strong>Important:</strong> Recent record links are also listed in a menu under the clock icon, to the left of the Home tab on every NetSuite page.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Reviewing Recent Records.</td>
</tr>
<tr>
<td>Content</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Recent Reports</td>
<td>(Available on the Reports tabbed page.)</td>
</tr>
<tr>
<td></td>
<td>Shows a list of reports that you have recently created, modified, or viewed.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, click the report name to view the individual report.</td>
</tr>
<tr>
<td>Reminders</td>
<td>Shows important tasks of selected types, usually that are past due or soon due to be completed.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, click Set Up to select types of reminders and to define the number of days in advance that reminders should be shown. Click on a reminder to go to the page where action needs to be taken.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Setting Up Reminders.</td>
</tr>
<tr>
<td>Report Snapshots</td>
<td>(Can display up to 10.)</td>
</tr>
<tr>
<td></td>
<td>Each added portlet provides a graphical or list summary of a selected standard or custom report's data, with a link to view the underlying report.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, you can select a date range for data and click thumbnails to choose among chart types for graphical data. You can click Set Up to select the type of display and other layout options, including chart themes. You also can click menu options to print the report snapshot chart, download it to a PNG, JPG, PDF, or SVG file, or view the underlying report results. Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon «.</td>
</tr>
<tr>
<td></td>
<td>Report snapshot list text truncates at 25 characters when the report snapshot portlet is in the left or right dashboard column. To avoid this truncation, place the portlet in the middle column.</td>
</tr>
<tr>
<td></td>
<td>Report snapshot list amounts are rounded to the nearest whole number and do not display decimal places.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Report Snapshots Overview.</td>
</tr>
<tr>
<td>Saved Searches</td>
<td>Shows the top ten saved searches in your account, including their execution time and the number of users who have accessed the search during a specified period.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, you can sort the searches that are displayed according to the most requested, most timeouts, most users, or highest execution time. For more information, see the help topic Using the Saved Searches Portlet.</td>
</tr>
<tr>
<td>Scheduler</td>
<td>(Available on the Activities page.)</td>
</tr>
<tr>
<td></td>
<td>Shows an interface where you can view others' schedules and add activities.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This portlet cannot be removed or modified.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, you can select the date and use the View Group dropdown menu to select others' schedules. Click the buttons to create new events, add invitees or resources.</td>
</tr>
<tr>
<td>Search Form</td>
<td>Shows a form to search for records of a selected type. Filter fields are based on system-defined defaults or a custom search form that you defined as preferred.</td>
</tr>
<tr>
<td></td>
<td>In the portlet, click Set Up to select the search form to be used. Click Full Search to switch to the default search page for the selected record type. Click Edit to open the definitions page for the selected search form and make edits.</td>
</tr>
<tr>
<td></td>
<td>See the help topic Adding Personalized Search Forms to NetSuite Pages.</td>
</tr>
<tr>
<td>Content</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The Search Form portlet is supported by the Copy to Account feature. If the portlet is included in a published dashboard and the dashboard is copied to another account, the portlet is also copied. You can also use the Copy to Account feature to copy an individual saved search to another of your accounts. For more information, see the help topics Copy to Account Overview and Copying a Published Dashboard to Another Account.</td>
</tr>
<tr>
<td>Settings</td>
<td>Shows links to user-level setup tasks.</td>
</tr>
<tr>
<td><strong>Important:</strong></td>
<td>The contents of this portlet are system-defined. This portlet cannot be removed or modified.</td>
</tr>
<tr>
<td>Shortcuts</td>
<td>Shows links to selected pages, so you can navigate quickly to frequently used pages.</td>
</tr>
<tr>
<td>In the portlet, click Set Up to reorder the listing of existing shortcut links or click New Shortcut to add a shortcut, if you know the URL of the page. If you do not know the URL, go to the upper right corner of that page, and then from the More list, select Add to Shortcuts.</td>
<td></td>
</tr>
<tr>
<td>For more information, see Shortcuts Portlet.</td>
<td></td>
</tr>
<tr>
<td>SMT Links</td>
<td>The Site Management Tools Links portlet shows links to all available domains in your administrator role.</td>
</tr>
<tr>
<td>In the portlet, use the dropdown menu to choose from your available websites. Once you have chosen the website, you can choose to Preview or Edit any of the available domains.</td>
<td></td>
</tr>
<tr>
<td>For more information, see SMT Links Portlet.</td>
<td></td>
</tr>
<tr>
<td>Tasks</td>
<td>Shows a list of upcoming CRM tasks assigned to you, with links to view, and if you have permission, to edit, individual records.</td>
</tr>
<tr>
<td>In the portlet, select a view and a sorting method, and click Set Up to define the number of tasks shown. Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon ↪. The full-screen view of the portlet displays more columns and rows in the search results.</td>
<td></td>
</tr>
<tr>
<td>For more information, see the help topic Tasks and Project Tasks Portlets on Your Dashboard.</td>
<td></td>
</tr>
<tr>
<td>Trend Graphs</td>
<td>(Can display up to five.)</td>
</tr>
<tr>
<td>Shows up to three Key Performance Indicators (KPIs) in a single chart with time-based X axis.</td>
<td></td>
</tr>
<tr>
<td>In the portlet, click thumbnails to choose among different chart types. You can enter a title for your portlet to quickly identify it. You also can change the graph’s X axis scale by selecting different time intervals from the dropdown list. Click Set Up to select the KPIs to be graphed and layout options, including chart themes. You also can click menu options to print the trend graph chart or download it to a PNG, JPG, PDF, or SVG file.</td>
<td></td>
</tr>
<tr>
<td>Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon ↪.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The Trend Graph portlet is supported by the Copy to Account feature. If the portlet is included in a published dashboard and the dashboard is copied to another account, the portlet is also copied. For more information, see the help topics Copy to Account Overview and Copying a Published Dashboard to Another Account.</td>
</tr>
<tr>
<td>For more information, see Trend Graphs.</td>
<td></td>
</tr>
</tbody>
</table>
Dashboard Personalization

NetSuite provides a default set of dashboard portlets for each tab in each center. Depending on your role, you can personalize most default dashboard configurations. The Settings portlet and a few other portlets are required on many dashboards and cannot be removed.

You may want to personalize only your home page dashboard, or you may want to change dashboards on other pages that you use frequently. In addition to changing page content, you can set personal preferences that apply to all pages by going to Home > Set Preferences. For example, use Set Preferences to specify your preferred color scheme and number formatting. For information, see the help topic Setting Personal Preferences.

Dashboard Personalization for Users

If your administrator has published a dashboard for one of your NetSuite tabs, you may not be able to personalize that page's dashboard yourself. The personalization options vary depending on the mode of the published dashboard. The available modes are as follows:

- **Locked mode** – If the published dashboard is in Locked mode, you cannot make any changes to its content, nor the layout. However, you can change the viewing options by clicking the Viewing Link at the top right of the home page. When the popup window appears, you can select the Date Range for all your portlet content at one time. If you use multi-book accounting, you can also select the Accounting Book in this window. When you close the popup window, the link changes to display your viewing options.

- **Add/Move Content mode** – If the published dashboard is in Add/Move Content mode, you can add or move portlets. You can also remove the portlets you added, but not the predefined portlets or those portlets that were added as part of the published dashboard. However, you can change the layout options. For more information, see Dashboard Layouts.

- **Unlocked mode** – If the published dashboard is in Unlocked mode, you can change content and move, add or remove portlets. You can also change the layout options. For more information, see Dashboard Layouts.

Dashboard Personalization for Administrators

If you are an administrator, you can personalize your dashboard and then share it with users whose roles share your center. For information, see Publishing Dashboards Overview.

- Adding a Portlet to a Dashboard
Dashboard Personalization

Setting Up Dashboard Portlet Content
Arranging Dashboard Portlets
Selecting an Existing Search to be a Custom KPI

Dashboard Layouts

You can choose among four layout types for every page that supports dashboards. Select your preference from the Layout dropdown list in the upper right of the page.

The available layout options are as follows:
- Two-column, narrow on the left.
- Two-column, narrow on the right.
- Three-column, wide in the middle. For three-column layouts, the minimum screen width is 1400 pixels.
- One-column.

Adding a Portlet to a Dashboard

You can add a portlet to a dashboard at any time, unless your administrator has published that dashboard in Locked mode. If a dashboard is locked, you cannot personalize it by adding or removing portlets.

Some portlet types allow you to add multiple portlets to your home dashboard. For example, you can add up to five Trend Graph portlets. You can see the number of available portlets on the upper-right corner of each portlet type by hovering over the icon.

To add a portlet to a dashboard:

1. Click Personalize Dashboard in the Settings portlet or the Personalize link in the top right corner of the page. The Personalize Dashboard palette opens at the top of the page.

The portlets that already appear on your dashboard are shown when you click the Currently Used tab.
2. In the other tabs, click a portlet icon to add it to the top of the page. The portlet automatically selects the column with the width that is best suited to its content. If you prefer, you can drag the portlet to a specific location.

- The **Standard Content** tab includes all standard portlets. The available portlet types vary based on the features you have enabled in your account.
- Rest your pointer over a portlet icon to see popup help and the number of available portlets.

To learn more about portlet types, see [Portlet Types Table](#) and [Dashboard Portlets](#).

After you have added a portlet, you can modify its contents and layout and move it to another location on the dashboard. For information, see [Setting Up Dashboard Portlet Content](#) and [Arranging Dashboard Portlets](#).

**To delete a portlet from a dashboard:**

There are three ways to remove portlets:

- Click **Remove** in the portlet menu.

- Click the portlet icon in the **Currently Used** tab of the Personalize Dashboard palette. As you move your pointer over the portlet icons, the corresponding portlet on your page is outlined.

- Click **Personalize Dashboard** in the Settings portlet or the **Personalize** link in the top right corner of the page.
The **Personalize Dashboard** palette opens. Move your pointer to the title of the portlet that you want to remove. When the pointer changes to crossed arrows, drag the portlet to the Personalize Dashboard palette.

Some portlets cannot be removed from a dashboard. One of these is the Settings portlet. Your administrator can also prohibit you from deleting a portlet.

### Arranging Dashboard Portlets

You can arrange the portlets on your dashboard to best fit your needs. You can move portlets up or down and from one column to another. For more information on Dashboard Layouts, see [Dashboard Layouts](#).

**To move a portlet on the dashboard:**

1. Move your pointer to the title of the portlet.
2. When the pointer changes to crossed arrows, drag the portlet to its new location.

Portlet content may change if you move a portlet from a wide column location to a narrow one.

- The Key Performance Indicators portlet displays more data and options when it is placed in the wide column than when in a narrow column. For more details, see [Setting Up the Key Performance Indicators Portlet](#).
- Custom search and list portlets display only the first 4 results columns when they are placed in a narrow column. When placed in the wide column, they display the first 9 results columns.
- Report snapshot text truncates at 25 characters when the report snapshot portlet is in a narrow dashboard column. To avoid this truncation, place the portlet in the wide column.

### Setting Up Dashboard Portlet Content

As you add portlets to your dashboard, you can review the data and layout for each portlet. Initially, portlets show default data or no data because you need to perform portlet setup tasks after you have added portlets to a dashboard.

Most portlets have a menu that includes a Set Up link. When you click Set Up, a popup window opens where you can define data and layout. The menu is located on the right side of the title bar:
Some portlets, such as the KPI Meter, also have dropdown lists where you choose portlet content.

**Note:** If a portlet does not contain a dropdown list or a menu with a Set Up link, its data and layouts are not configurable.

The setup options for most portlets are self-explanatory. The following list includes brief tips about setting up different portlets. Links to more detailed explanations are provided as needed.

- **Analytics** – Click Set Up to select the chart you want to display from the list of available workbooks. After selecting the chart, you can define the layout options such as the portlet size, chart type and portlet title. For more information, see the help topic Workbook-based Portlets.
- **Calendar** – Select a calendar to display. By default, your calendar is shown. For details, see Calendar Portlets.
- **Custom Portlet** – Click Set Up to select the source file for the SuiteScript results to display. For more information, see Custom Portlets.
  - **Dashboard Tiles** – Click Set Up and select Dashboard Tiles from the Source field. For more information, see Dashboard Tiles.
  - **Navigation Portlet** – Click Set Up to select Navigation Portlet from the Source field. For more information, see Navigation Portlet.
- **Custom Search** – Click Set Up to select the saved search and the number of results to display. You can also give your portlet a custom title and choose whether to drill down into search results in the portlet or on a new page. If Inline Editing feature is enabled, you can choose whether to enable inline editing of search results. For more information, see Custom Search Portlets.
- **KPI Meter** – From the dropdown list, select a KPI to display. Click Set Up to select date ranges, comparison, and highlighting options. For more information, see KPI Meter Portlets.
- **KPI Scorecard** – Click Set Up to select a KPI scorecard and define layout options. For more information, see KPI Scorecard Portlet.
- **Key Performance Indicators** – Click Set Up to select standard KPIs or custom KPIs based on custom saved searches. After you select the KPIs, you can select comparison and highlighting options. For more information, see Key Performance Indicators Portlet.
- **List** – Click Set Up to select the type of record and the number of records to show. To edit records directly in the portlet, enable the Inline Editing feature. See the help topic Using Inline Editing. For more information on List portlets, see List Portlets.
- **My Login Audit** – Click Set up to set display options for monitoring your own login activity. For more information, see the help topic My Login Audit Portlet.
- **Phone Calls** - Click Set Up to enter the number of records to show. For more information, see Phone Calls Portlet.
- **Project Tasks** – Add a List portlet to your dashboard, click Set Up in the portlet menu and choose Project Task as List Type. For more information, see Project Tasks Portlets.
- **Quick Add** – Click Set Up to select the type of record to be added. For more information, see Quick Add Portlet.
Setting Up Dashboard Portlet Content

■ **Quick Search** – Click Set Up to define the type of records to search, then enter keywords in the portlet’s text box and select a field name from the Search For dropdown list. For more information, see Quick Search Portlet.

■ **RSS/Atom Feed** – Click Set Up to select a feed and set display options. NetSuite provides a number of standard feeds, or you can choose custom and enter a URL for another feed. For more information, see RSS/Atom Feed Portlets.

■ **Reminders** – Click Set Up to select types of reminders and to define the number of days in advance that reminders should be shown. For more information, see Setting Up Reminders.

■ **Report Snapshot** – Select a date range for graphed data. If available, click Set Up to select a type of display and other layout options. For more information, see Report Snapshot Portlets.

■ **Search Form** – If any of your saved searches is used as the preferred search form for a particular record type, you can display this search form in a portlet on your dashboard. For more information, see Search Form Portlet.

■ **SMT Links** – Select a website and domain to preview or edit. For more information, see SMT Links Portlet.

■ **Shortcuts** – Click Set Up to reorder the listing of existing shortcut links. Click New Shortcut to add a shortcut if you know the URL of the page. If you do not know the URL, go to the page, and then from the More list, select Add to Shortcuts. For more information, see Shortcuts Portlet.

■ **Tasks** – Select the Basic view to be able to display tasks assigned to other users in your system. For details, see Tasks Portlet.

■ **Trend Graph** – Click Set Up to select up to 3 KPIs to graph and layout options. To change the graph’s X axis scale, click on time period options in the portlet. For more information, see Trend Graph Portlets.

**Calendar Portlets**

Calendar portlets list your activities ordered by date and time, with links to drill down into individual activity records. The calendar portlet is displayed by default on the Activities tab, and can be added to dashboards on other tabs.

You can add multiple calendar portlets to each dashboard. They act independently of each other and so provide the flexibility of displaying different calendar and time frame configurations on one page.

1. Calendar portlets are standalone items. They can be set up to display other calendars and date periods. For example, you may choose to display a Group calendar in the *Monthly* view to assist with meeting scheduling.

2. The center portlet is set up with a *Weekly* view of your personal calendar, providing a snapshot of the week ahead.
In each calendar portlet, you can select among a daily, weekly, monthly, or agenda view. You also can choose to display your own calendar or the public calendar for another entity within the organization. See Toggling Calendar Portlet Settings.

To change the types of activities listed in a calendar portlet, click the Set Up menu option for the portlet. See Choosing the Activities Shown in a Calendar Portlet.

You can print the details from a calendar portlet by clicking its Print menu option.

Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon ↵. The full-screen view of the portlet displays more columns and rows in the search results.

To add a Calendar portlet to a dashboard:

1. Click Personalize in the upper right corner of your dashboard or use Personalize Dashboard in the Settings portlet.
2. On the Standard Content tab of the Personalize Dashboard palette, click the Calendar icon or drag it onto the dashboard.

Toggling Calendar Portlet Settings

In each calendar portlet, you can quickly toggle the following settings:

- Displayed Calendar: By default, the calendar portlet displays My Calendar, a calendar of your own activities. To display activities for another entity within your organization that has a public calendar, click My Calendar and select that entity from the list. Entities with private calendars are not listed. To learn how to make a calendar public, see the help topic Setting Calendar Preferences.
- Calendar View: Daily, Weekly, Monthly, or Agenda.

If you want to change the default values for these settings, click Calendar Preferences in the upper right corner of the Activities tab. For details about setting calendar preferences, see the help topic Setting Calendar Preferences.

You can move the calendar forward and backward in time by clicking the > and < buttons.
Choosing the Activities Shown in a Calendar Portlet

You can click the **Set Up** menu option for a calendar portlet to bring up a popup where you can set the types of activity records that are shown in the portlet. The Calendar popup may include the following options:

- **Show Events** – Enabled by default.
- **Show Blocking Tasks** – Enabled by default.
- **Show Non-Blocking Tasks** – Enabled by default. Non-blocking tasks are those that do not reserve time. They appear first on your calendar on the day for which they are scheduled.
- **Show Blocking Phone Calls** – Enabled by default.
- **Show Non-Blocking Phone Calls** – Enabled by default. Non-blocking phone calls are those that do not reserve time. They appear first on your calendar on the day for which they are scheduled.
- **Show Canceled Events** – Disabled by default. If this option is enabled, canceled events display in the calendar in strikethrough text.
- **Show Campaign Events** – Disabled by default. Available if your role gives you access to Campaign records.
- **Show Resource Allocations** – Disabled by default. This option appears when you are designated a project resource and have active allocations. If this option is enabled, the project name for each allocation is displayed for each day you are allocated.
- **Show Weekends in Monthly View** – Enabled by default.
- **Records to Display in Agenda View** – Is set to **Today’s Activities Only** by default. Can be set to **Today’s and Upcoming Activities**.
- **Number of Records to Display in Agenda View** – Is set to 7 by default. This field must have a value set.

Custom Portlets

Custom portlets enable you to display SuiteScript results on your dashboard. You can add the following custom portlets on your dashboard:

- **Dashboard Tiles** – For more information, see Dashboard Tiles.
- **Navigation Portlet** – For more information, see Navigation Portlet.

To use custom portlets, you first need to create a SuiteScript portlet script. To learn how to create portlet scripts, see the help topics Portlet Scripts and SuiteScript 2.0 Portlet Script Type.

**To add a custom portlet to your dashboard:**

1. Click **Personalize** in the upper right corner of your dashboard or use **Personalize Dashboard** in the **Settings** portlet.
2. On the **Standard Content** tab of the **Personalize Dashboard** palette, click the **Custom Portlet** icon or drag it onto the dashboard.
3. To specify the script to be used by the portlet, click **Set Up** in the portlet or the portlet menu, select the script from the **Source** list, and click **Save**.

**Dashboard Tiles**

Read the following topics to get you started in using the Dashboard Tiles SuiteApp.

- Installing the Dashboard Tiles SuiteApp
- Setting Up Dashboard Tiles
- Types of Dashboard Tiles
- Creating Dashboard Tiles
  - Creating a Static Tile
  - Creating a Reminder Tile
  - Creating a Scorecard Tile
    - Creating a Comparison Scorecard Tile
- Translating Dashboard Tiles
  - Entering Dashboard Tile Translations
- Customizing Dashboard Tiles
  - Modifying the Appearance of a Dashboard Tile
  - Applying Conditional Alerts to a Dashboard Tile
- Modifying the Title and Font Sizes of the Dashboard Tiles Portlet
- Adding Roles That Can View Dashboard Tiles

**Dashboard Tiles Overview**

The Dashboard Tiles SuiteApp lets you to create a dashboard with tiles that display your business critical KPIs in a bold visual layout with images and blinking alerts. The blinking alerts serve as reminders for metrics that do not meet certain conditions. You can configure the content of the tiles based on how they will be displayed or translated in the dashboard.

There are three tile types that you can create and customize:

- Static
- Reminder
- Scorecard

For more information on these tile types, see **Types of Dashboard Tiles**.

**Dashboard Tiles SuiteApp Availability**

The Dashboard Tiles SuiteApp is a managed SuiteApp that is automatically updated whenever enhancements or new features are added.

For instructions on installing this SuiteApp, see **Installing the Dashboard Tiles SuiteApp**.

**Multi-Language Support**

The Dashboard Tiles SuiteApp is automatically translated into the following supported languages, depending on your language preference:
Setting Up Dashboard Portlet Content

- English
- Chinese (Simplified)
- Chinese (Traditional)
- Czech
- Danish
- Dutch
- German
- Italian
- Indonesian
- Finnish
- French
- French (Canada)
- Latin American Spanish
- Japanese
- Korean
- Norwegian
- Portuguese (Brazil)
- Russian
- Spanish
- Swedish
- Thai
- Turkish
- Vietnamese

The only exceptions are the entries for the Name, Prefix, Display Value, and Suffix fields. An administrator or users with edit permissions to dashboard tile records can enter translations for these fields in languages supported by NetSuite. For more information on entering dashboard tile translations, see Translating Dashboard Tiles. For more information on the languages supported by NetSuite, see the help topic Configuring Multiple Languages.

Installing the Dashboard Tiles SuiteApp

**Note:** Only users with an Administrator role can install this SuiteApp.

**To install the Dashboard Tiles SuiteApp:**

1. Go to Customization > SuiteBundler > Search & Install Bundles.
2. On the Search and Install Bundles page, use the following information to search for the SuiteApp:
   - **Bundle Name:** Dashboard Tiles
   - **Bundle ID:** 185219
3. Click **Dashboard Tiles** to display its Bundle Details page.
   For more information, see the help topic Bundle Details.
4. Click Install.
   If asked, indicate your agreement to allow NetSuite to automatically upgrade the SuiteApp in your account when updates become available.
   During installation, click Refresh to get the latest status.

Setting Up Dashboard Tiles

Setting up the Dashboard Tiles SuiteApp involves the following tasks:

- Granting Permissions to Use Dashboard Tiles
- Setting the Language Preference for Dashboard Tiles

Granting Permissions to Use Dashboard Tiles

When the Dashboard Tiles SuiteApp is installed, the dashboard tiles custom record becomes available.

An administrator must add the required permission to roles that will use the SuiteApp. The following table lists the permissions required to access the dashboard tiles custom record. For information on customizing roles, see the help topic Customizing or Creating NetSuite Roles.

<table>
<thead>
<tr>
<th>Custom Record</th>
<th>Minimum Permission Level</th>
<th>Maximum Permission Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard Tiles</td>
<td>View</td>
<td>Full</td>
</tr>
</tbody>
</table>

Setting the Language Preference for Dashboard Tiles

To set the language preference for the Dashboard Tiles SuiteApp:

1. Enable the Multi-Language feature:
   a. Go to Setup > Company > Enable Features.
   b. Check the Multi-Language box.
   c. Click Save.

   **Important:** Enable the Multi-Language feature in your account before setting your preferred language. If you do not enable this feature, you cannot select other languages and can only use the base language.

2. Set your language preference:
   a. Go to Home > Set Preferences.
   b. In the Language field under the General subtab, select your preferred language.
   c. Click Save.

Types of Dashboard Tiles

These are the three tile types that you can create and customize:

- Static tile
- Reminder tile

Dashboards
Setting Up Dashboard Portlet Content

- Scorecard tile

Static Tile

A static tile displays a static value. Examples of static values are percentage rate and target amount. You can use a SuiteScript to update the value for handling complex metrics that may require more than one saved search. For example, a static tile can be created for Target Revenue This Quarter.

Reminder Tile

A reminder tile displays numeric data derived from a saved search. The values displayed in a reminder tile are based on the number of results as specified in the saved search record. For example, a reminder tile can be created for Opportunities to Close, Sales Orders to Fulfill, etc.

Scorecard Tile

A scorecard tile displays the sum of the values in the first available numeric column of a saved search. Numeric columns can contain currencies, integers, floats, or decimals.

For example, you selected Cash Sale by Customer as the saved search to use for a scorecard tile. The saved search contains the following numeric and non-numeric fields: Customer Name, Sum of Amounts, Average of Quantity, and Count of Account Type. In this example, Sum of Amounts is listed as the first numeric column of the saved search. After saving the record, the scorecard tile displays the sum of all rows in the Sum of Amounts column.

**Note:** If the saved search does not contain a numeric column, you cannot save the record.

Comparison Scorecard Tile

A comparison scorecard tile is a scorecard tile that you can use to compare a static value versus a saved search result or to compare two saved search results.

For example, you can use a comparison scorecard tile to compare sales of the current month versus sales from the previous month. The tile displays the comparison results depending on the comparison type selected, along with the current and previous values used in the computation.

You can select the following comparison types based on the result you want to display in the tile:

<table>
<thead>
<tr>
<th>Comparison Type</th>
<th>Computation</th>
</tr>
</thead>
</table>
| Difference              | Difference = Current ÷ Previous  
The Difference is calculated by dividing the current value (from the source saved search) by the previous value (from the compare saved search). |
| Variance Percentage     | Variance Percentage = ((Current – Previous) ÷ Previous) × 100  
The Variance Percentage is calculated as the current value minus the previous value divided by the previous value and multiplied by 100. |
| Absolute Ratio          | Absolute Ratio = Current – Previous  
The Absolute Ratio is calculated as the current value minus the previous value. |

Note the following when using a comparison scorecard tile:

- Columns that contain IDs (such as internal and external IDs) and document numbers are not considered as numeric columns.
Setting Up Dashboard Portlet Content

The system displays N/A in the tile when there is an error in computation. Errors are caused by one of the following scenarios:

- The saved search used contains an invalid expression or formula.
- The denominator used in the computation is 0. For example, the current value is 100 and the previous value is 0.

To avoid errors when saving a record, be sure to select a custom saved search and not a standard saved search.

A maximum of 30 comparison scorecard tiles can be displayed in the portlet. For example, if you created 50 comparison scorecard tiles, only the first 30 are displayed correctly.

Creating Dashboard Tiles

Read the following topics for instructions on how to create dashboard tiles:

- Creating a Static Tile
- Creating a Reminder Tile
- Creating a Scorecard Tile
  - Creating a Comparison Scorecard Tile

**Note:** A maximum of 50 tiles can be displayed in the portlet. If you create more than 50 tiles, the portlet displays only the first 50 tiles depending on the display order value.

Creating a Static Tile

A static tile displays a static value. For more information on the types of dashboard tiles, see Types of Dashboard Tiles.

**To create a static tile:**

1. Go to Setup > Dashboard Tiles > Manage Dashboard Tiles > New.
2. On the Dashboard Tile page, specify values for the following fields:
   a. **Name** – Enter a name that describes the static value to be displayed in the tile. For example, Target Revenue This Quarter.
   b. **Inactive** – Leave this box clear to make the tile available for display on the dashboard.
   c. **Tile Type** – Select Static.
   d. **Display to All Roles** – Check this box to make the tile visible to all roles. When this box is checked, the Roles field becomes read-only.
   e. **Roles** – Select at least one role that can access the tile. To select multiple roles, press and hold down the Ctrl key.

   **Note:** To display the tile in the portlet, you must select at least one role in the Roles field or check the Display to All Roles box.

   f. **Display Order** – Enter a numeric value to define the order that the tile is displayed in the portlet. For example, enter 1 to display the tile as the first tile in the portlet.
3. On the Data subtab, specify values for the following fields:
   a. Display Value – Enter the static value to be displayed in the tile.
   b. Link – (Optional) Specify the URL to use for the tile. For example, you can enter a saved search URL.
      When you click the tile, the system launches URL page.
   c. Prefix – Enter text or characters to append before the tile value.
      For example, you can use a currency symbol as a prefix.
   d. Suffix – Enter text or characters to append after the tile value.
      For static tiles, the Saved Search field is read-only.

4. (Optional) Modify the tile appearance or apply conditional alerts.
   For more information, see Modifying the Appearance of a Dashboard Tile or Applying Conditional Alerts to a Dashboard Tile.

5. Click Save.

After creating the tile, you can customize its appearance. For more information about customizing dashboard tiles, see Customizing Dashboard Tiles.

Creating a Reminder Tile

A reminder tile displays numeric data derived from a saved search. The values displayed in a reminder tile are based on the number of results in a saved search record. For more information on the types of dashboard tiles, see Types of Dashboard Tiles.

To create a reminder tile:

1. Go to Setup > Dashboard Tiles > Manage Dashboard Tiles > New.
2. On the Dashboard Tile page, specify values for the following fields:
   a. Name – Enter a name that describes the metrics to be displayed in the tile.
      For example: Target Revenue This Quarter, Sales Order YTD, POs Pending Receipt, Sales and Marketing Expense.
   b. Inactive – Leave this box clear to make the tile available for display on the dashboard.
   c. Tile Type – Select Reminder.
   d. Display to All Roles – Check this box to make the tile visible to all roles.
      When this box is checked, the Roles field becomes read-only.
   e. Roles – Select at least one role that can access the tile.
      To select multiple roles, press and hold down the Ctrl key.

   Note: To display the tile in the portlet, you must select at least one role in the Roles field or check the Display to All Roles box.

   f. Display Order – Enter a numeric value to define the order that the tile is displayed in the portlet.
For example, enter **1** to display the tile as the first tile in the portlet.

**Note:** If two or more tiles have the same display order value, the system displays the tiles in alphabetical order.

A maximum of 50 tiles can be displayed in the portlet. If you create more than 50 tiles, the portlet displays only the first 50 tiles depending on the display order value.

3. On the **Data** subtab, specify values for the following fields:
   a. **Saved Search** – Select the name of the saved search to use for the tile.
      
      **Important:** Saved searches are not validated by the system. If a saved search is not working properly, the dashboard displays the tile incorrectly or N/A is displayed in the tile.
      
      Ensure that the saved search you select is a SuiteScript supported record. For more information on SuiteScript supported records, see the help topic SuiteScript Supported Records.
   
   b. **Link** – (Optional) Specify the URL to use for the tile. For example, you can enter a saved search URL.
      
      When you click the tile, the system launches URL page.
   
   c. **Prefix** – Enter text or characters to append before the tile value.
      
      For example, you can use a currency symbol as a prefix.
   
   d. **Suffix** – Enter text or characters to append after the tile value.
      
      For reminder tiles, the **Display Value** and **Scorecard Summary Type** fields are read-only.

4. (Optional) Modify the tile appearance or apply conditional alerts.
   
   For more information, see Modifying the Appearance of a Dashboard Tile or Applying Conditional Alerts to a Dashboard Tile.

5. Click **Save**.

After creating the tile, you can customize its appearance. For more information about customizing dashboard tiles, see Customizing Dashboard Tiles.

Creating a Scorecard Tile

A scorecard tile displays the sum of the values in the first available numeric column of the selected saved search. If the selected saved search does not contain a numeric column, you will not be able to save the record. For more information on the types of dashboard tiles, see Types of Dashboard Tiles.

**To create a scorecard tile:**

1. Go to Setup > Dashboard Tiles > Manage Dashboard Tiles > New.
2. On the Dashboard Tile page, specify values for the following fields:
   a. **Name** – Enter a name that describes the scorecard results to be displayed in the tile.
      
      For example, Sum of Company Sales Orders.
   
   b. **Inactive** – Leave this box clear to make the tile available for display on the dashboard.
   
   c. **Tile Type** – Select **Scorecard**.
   
   d. **Display to All Roles** – Check this box to make the tile visible to all roles.
      
      When this box is checked, the **Roles** field becomes read-only.
   
   e. **Roles** – Select at least one role that can access the tile.
To select multiple roles, press and hold down the Ctrl key.

**Note:** To display the tile in the portlet, you must select at least one role in the **Roles** field or check the **Display to All Roles** box.

f. **Display Order** – Enter a numeric value to define the order that the tile is displayed in the portlet.

For example, enter 1 to display the tile as the first tile in the portlet.

**Note:** If two or more tiles have the same display order value, the system displays the tiles in alphabetical order.

A maximum of 50 tiles can be displayed in the portlet. If you create more than 50 tiles, the portlet displays only the first 50 tiles depending on the display order value.

3. In the Data Source section of the **Data** subtab, specify values for the following fields:
   a. **Saved Search** – Select a custom saved search to use for the scorecard tile.

   **Important:** Ensure that the custom saved search you select is a SuiteScript supported record that contains a numeric column. Otherwise, the system will not let you create the scorecard tile. For more information on SuiteScript supported records, see the help topic **SuiteScript Supported Records**.

   b. **Link** – (Optional) Specify the URL to use for the tile. For example, you can enter a saved search URL.

   When you click the tile, the system launches URL page.

   c. **Prefix** – Enter text or characters to append before the tile value.

   For example, you can use a currency symbol as a prefix.

   d. **Suffix** – Enter text or characters to append after the tile value.

   For scorecard tiles, the **Display Value** field is read-only.

   The **Scorecard Summary Type** field automatically displays **Sum**. It is the default summary type for scorecard tiles.

4. (Optional) Modify the tile appearance or apply conditional alerts.

   For more information, see **Modifying the Appearance of a Dashboard Tile or Applying Conditional Alerts to a Dashboard Tile**.

5. Click **Save**.

After creating the tile, you can customize its appearance. For more information about customizing dashboard tiles, see **Customizing Dashboard Tiles**.

**Creating a Comparison Scorecard Tile**

You can use a comparison scorecard tile to compare a static value versus a saved search result or to compare two saved search results. For more information on the types of dashboard tiles, see **Types of Dashboard Tiles**.

**To create a comparison scorecard tile:**

1. Go to Setup > Dashboard Tiles > Manage Dashboard Tiles > New.
2. On the Dashboard Tile page, specify values for the following fields:
   a. **Name** – Enter a name that describes the scorecard results to be displayed in the tile.
For example, Sum of Company Sales Orders.

b. **Inactive** – Leave this box clear to make the tile available for display on the dashboard.

c. **Tile Type** – Select **Scorecard**.

d. **Display to All Roles** – Check this box to make the tile visible to all roles.

When this box is checked, the **Roles** field becomes read-only.

e. **Roles** – Select at least one role that can access the tile.

To select multiple roles, press and hold down the Ctrl key.

---

**Note:** To display the tile in the portlet, you must select at least one role in the **Roles** field or check the **Display to All Roles** box.

f. **Display Order** – Enter a numeric value to define the order that the tile is displayed in the portlet.

For example, enter 1 to display the tile as the first tile in the portlet.

---

**Note:** If two or more tiles have the same display order value, the system displays the tiles in alphabetical order.

A maximum of 50 tiles can be displayed in the portlet. If you create more than 50 tiles, the portlet displays only the first 50 tiles depending on the display order value.

3. In the **Data Source** section of the **Data** subtab, specify values for the following fields:

a. **Saved Search** – Select a custom saved search to use for the scorecard tile.

---

**Important:** Ensure that the custom saved search you select is a SuiteScript supported record that contains a numeric column. Otherwise, the system will not let you create the scorecard tile. For more information on SuiteScript supported records, see the help topic [SuiteScript Supported Records](#).

b. **Link** – (Optional) Specify the URL to use for the tile. For example, you can enter a saved search URL.

When you click the tile, the system launches URL page.

c. **Prefix** – Enter text or characters to append before the tile value.

For example, you can use a currency symbol as a prefix.

d. **Suffix** – Enter text or characters to append after the tile value.

For scorecard tiles, the **Display Value** field is read-only.

The **Scorecard Summary Type** field automatically displays **Sum**. It is the default summary type for scorecard tiles.

4. In the **Comparison** section of the **Data** subtab, specify values for the following fields:

a. **Compare** – Check this box to enable comparison for the scorecard tile.

When this box is checked, the result of the comparison is displayed in the scorecard tile along with the current and previous values used in the computation.

---

**Note:** When the **Compare** box is cleared, all fields in the Comparison section become read-only and the tile becomes an ordinary scorecard tile.

b. **Compare Value** – Specify a static value.

This value is displayed as the previous value on the scorecard tile. If you specify a value in this field, the **Compare Saved Search** field becomes read-only.
c. **Compare Saved Search** – Select a custom saved search to use for the comparison.

If you use a custom saved search for comparison, the **Compare Value** field becomes read-only.

**Important:** Ensure that you select a custom saved search and not a standard saved search. Otherwise, the system will not let you create the scorecard tile.

**Note:** The sum of the values in the first numeric column of the saved search you select in this field is shown as the previous value in the tile. The system then compares the previous value to the sum of the values in the first numeric column of the saved search selected in the Data Source section.

d. **Comparison Type** – Select the comparison type to use for the scorecard tile.

Select from the following comparison types based on the result you want to display in the tile:

<table>
<thead>
<tr>
<th>Comparison Type</th>
<th>Computation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Difference</td>
<td>Difference = Current ÷ Previous</td>
</tr>
<tr>
<td></td>
<td>The Difference is calculated by dividing the current value (from the source saved search) by the previous value (from the compare saved search).</td>
</tr>
<tr>
<td>Variance Percentage</td>
<td>Variance Percentage = ((Current – Previous) ÷ Previous) × 100</td>
</tr>
<tr>
<td></td>
<td>The Variance Percentage is calculated as the current value minus the previous value divided by the previous value and multiplied by 100.</td>
</tr>
<tr>
<td>Absolute Ratio</td>
<td>Absolute Ratio = Current – Previous</td>
</tr>
<tr>
<td></td>
<td>The Absolute Ratio is calculated as the current value minus the previous value.</td>
</tr>
</tbody>
</table>

5. (Optional) Modify the tile appearance or apply conditional alerts.

   For more information, see Modifying the Appearance of a Dashboard Tile or Applying Conditional Alerts to a Dashboard Tile.

6. Click **Save**.

After creating the tile, you can customize its appearance. For more information about customizing dashboard tiles, see Customizing Dashboard Tiles.

### Translating Dashboard Tiles

You can enter translations for the tile name, prefix, display value, and suffix in the languages supported by NetSuite and not just in the languages supported by the Dashboard Tiles SuiteApp. For more information on the system-supported languages, see the help topic Configuring Multiple Languages. For a list of languages supported by the Dashboard Tiles SuiteApp, see Multi-Language Support.

**Entering Dashboard Tile Translations**

**Note:** Only users with an Administrator role or users with edit permissions to dashboard tile records can enter tile translations.

For all dashboard tile types, you can enter translations for the following:

- Name
Setting Up Dashboard Portlet Content

- Prefix
- Display Value
- Suffix

You must first create the tile before you can enter translations for it. For more information, see Creating Dashboard Tiles.

To enter dashboard tile translations:

1. Ensure you have enabled the entry of translation strings for other languages.
   For more information, see Enabling the Entry of Translation Strings for a Specific Language.
   
   **Note:** You can enter tile translations only for languages where you enabled the entry of translations strings. For example, if you enabled the entry of translations strings for French and German, you can only enter tile translations in French and German and not in other languages.

2. Ensure the Multi-Language feature is enabled.
   For more information, see Setting the Language Preference for Dashboard Tiles.

3. Go to Setup > Dashboard Tiles > Manage Dashboard Tiles.

4. On the Dashboard Tile List page, click **Edit** of the tile where you want to enter translations.

5. On the Dashboard Tile page, click the **Translations** subtab.
   The Translations subtab becomes available only after you create the tile.

6. Enter translations for the following fields:
   a. **Name** – Enter a name for the tile in the desired language.
   b. **Prefix** – Enter text or characters to append at the beginning of the tile in the desired language.
   c. **Display Value** – Enter a display value for the tile in the desired language.
   d. **Suffix** – Enter text or characters to append at the end of the tile in the desired language.
   Repeat this step for other languages where you want to add translation entries.

   **Note:** Make sure the **Prefix** or **Suffix** field on the **Data** subtab is not left blank. When left blank, translation entries for the **Prefix** or **Suffix** are not saved.

7. Click **Save**.

Change your language preference to see the translations you entered for the tile. For more information on setting the language preference, see Setting the Language Preference for Dashboard Tiles.

Customizing Dashboard Tiles

After creating a tile, you can customize its appearance. You must have an Administrator role to change the appearance of dashboard tiles. Read the following topics for instructions on how to customize dashboard tiles:

- Modifying the Appearance of a Dashboard Tile
- Applying Conditional Alerts to a Dashboard Tile

Modifying the Appearance of a Dashboard Tile

You can edit the font color, tile color, and icon of a tile.
**Setting Up Dashboard Portlet Content**

**Note:** Only users with an Administrator role or users with edit access can modify a dashboard tile's appearance.

**To modify the dashboard tile appearance:**

1. Place your cursor over the tile that you want to edit and click the **Edit** icon.

   **Note:** The **Edit** icon is only available to users with an Administrator role. If you are not an administrator but have edit permissions, go to Setup > Dashboard Tiles > Manage Dashboard Tiles and select the tile that you want to edit.

2. On the Dashboard Tiles page, under the **Appearance** subtab, specify values for the following fields:
   - **Tile Color** – Select a color for the tile.
   - **Font Color** – Select a font color for the tile.
   - **Icon** – Select an icon to use for the tile or click the + icon to upload a new image.

   **Note:** For better performance, upload images with small file sizes.

3. Click **Save**.

**Applying Conditional Alerts to a Dashboard Tile**

Conditional alerts are only used for reminder and scorecard tiles. When you apply a conditional alert to a reminder or scorecard tile, the tile icon blinks when the metrics meet the conditions you have specified for the tile.

**Note:** Only users with the Administrator role or users with edit access can apply conditional alerts.

**Important:** You must specify an icon for the reminder or scorecard tile before applying conditional alerts. For more information on specifying a tile icon, see Modifying the Appearance of a Dashboard Tile.

**To apply conditional alerts to a tile:**

1. Place your cursor over the tile that you want to edit and click the **Edit** icon.

   **Note:** The **Edit** icon is only available to users with an Administrator role. If you are not an administrator but have edit permissions, go to Setup > Dashboard Tiles > Manage Dashboard Tiles and select the tile that you want to edit.

2. On the Dashboard Tiles page, under the **Alerts** subtab, specify values for the following fields:
   - **Blink When** – Select a condition that will trigger an alert.
     You can select from the following conditions:
     - Greater Than Threshold
     - Less Than Threshold
     - Greater Than Or Equal Threshold
     - Less Than Or Equal Threshold
   - **Threshold** – Enter a threshold value for the tile.
The combination of the **Threshold** and **Blink When** values determine when the icon in the tile blinks.

3. Click **Save**.

### Modifying the Title and Font Sizes of the Dashboard Tiles Portlet

When you log in to NetSuite, the portlet displays the default title and fonts sizes. You can modify the title and font sizes of the Dashboard Tiles portlet depending on your preference.

**To modify the title and font sizes of the Dashboard Tiles portlet:**

1. In the Tiles portlet, click the **Menu** icon and select **Edit**.
2. In the Custom Content dialog, specify the values for the following fields:
   - **Title** – Enter a name for the portlet. If you leave this field blank, the default name Tiles is displayed.
   - **KPI Font Size (PT)** – Enter a font size from 0 to 18.
   - **Label Font Size (PT)** – Enter a font size from 0 to 16.
   - **Blink Delay (MS)** – Enter a value in milliseconds from 300 to 3000. If no value is specified, the default 530 milliseconds is used.
     This field sets the blink delay only for reminder and scorecard tiles.

### Adding Roles That Can View Dashboard Tiles

When a dashboard tile is created, you assigned roles that can view the tile. After tile creation, you can still add roles that can view the dashboard tile. The original role associated with the dashboard tile creation is called the source role. New roles for which you want to grant additional access are called target roles. When you specify a target role, the tiles that the source role can view also become available for viewing to the target roles.

**To add roles that can view dashboard tiles:**

1. Go to Setup > Dashboard Tiles > Roles Update.
2. On the Dashboard Tiles Roles Update page, specify values for the following fields:
   - **Target Role** – Select a target role. To select multiple roles, press and hold down the Ctrl key.
   - **Source Role** – Select a source role.
3. Click **Run Update**.
4. Click **OK**.
5. On the Schedule Script Status page, click **Refresh** to check the status of the update.
   The **Status** column displays Complete after the update.

The tiles that the source role can view also become available for viewing to the target roles after the update is complete.

### Navigation Portlet

Read the following topics to get you started in using the Navigation Portlet SuiteApp:

- Navigation Portlet Overview
- Multi-Language Support for Navigation Portlet
Setting Up Dashboard Portlet Content

- Installing the Navigation Portlet SuiteApp
- Navigation Portlet SuiteApp Permissions
- Creating a Navigation Category
- Creating a Shortcut Group
- Adding Shortcuts to an Existing Shortcut Group
- Modifying the Content of the Navigation Portlet
- Adding Roles That Can View Shortcut Groups

Navigation Portlet Overview

The Navigation Portlet SuiteApp lets you simplify navigation to commonly used menus in NetSuite. Using this SuiteApp, you can create groups and categories for shortcuts or links that you frequently use in NetSuite. The shortcuts and categories are displayed in the custom portlet and can be configured using a custom record.

To begin using this SuiteApp, you must add the navigation portlet custom portlet. For more information on adding custom portlets, see Custom Portlets. You can add multiple navigation portlets in your dashboard.

Navigation Portlet SuiteApp Availability

The Navigation Portlet SuiteApp is a managed SuiteApp that is automatically updated whenever enhancements or new features are added.

For instructions on installing this SuiteApp, see Installing the Navigation Portlet SuiteApp.

Multi-Language Support for Navigation Portlet

The Navigation Portlet SuiteApp is available in the following languages:

- Chinese (Simplified)
- Chinese (Traditional)
- Czech
- Danish
- Dutch
- English
- Finnish
- French
- French (Canada)
- German
- Italian
- Indonesian
- Japanese
- Korean
- Latin American Spanish
- Norwegian
- Portuguese (Brazil)
Setting Up Dashboard Portlet Content

Setting the Language Preference for Navigation Portlet

You can set the language for Navigation Portlet depending on your preference.

To set the language preference for Navigation Portlet:

⚠️ **Important**: Enable the Multi-Language feature before installing this SuiteApp.

1. Enable the Multi-Language feature:
   a. Go to Setup > Company > Enable Features.
   b. Check the Multi-Language box.
   c. Click Save.
2. Set your language preference:
   a. Go to Home > Set Preferences.
   b. In the Language field under the General subtab, select your preferred language.
   c. Click Save.

Installing the Navigation Portlet SuiteApp

Only users with an Administrator role can install this SuiteApp.

To install the Navigation Portlet SuiteApp:

1. Go to Customization > SuiteBundler > Search and Install Bundles.
2. On the Search and Install Bundles page, use the following information to search for the SuiteApp:
   - **Bundle Name**: Navigation Portlet
   - **Bundle ID**: 186103
3. Click Navigation Portlet to display its Bundle Details page.
   For more information, see the help topic Bundle Details.
4. Click Install.
   If asked, indicate your agreement to allow NetSuite to automatically upgrade the SuiteApp in your account when updates become available.
   During the installation, click Refresh to get the latest status.

Navigation Portlet SuiteApp Permissions

After the Navigation Portlet is installed, the following custom records become available:

- Navigation Categories
- Navigation Shortcut
An administrator must add the required permissions to roles that will use the SuiteApp.

The following table lists the permissions required to access the custom records.

<table>
<thead>
<tr>
<th>Custom Record</th>
<th>Minimum Permission Level</th>
<th>Maximum Permission Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation Categories</td>
<td>View</td>
<td>Full</td>
</tr>
<tr>
<td>Navigation Shortcut</td>
<td>View</td>
<td>Full</td>
</tr>
<tr>
<td>Navigation Shortcut Group</td>
<td>View</td>
<td>Full</td>
</tr>
<tr>
<td>Navigation Shortcut Tooltip</td>
<td>View</td>
<td>Full</td>
</tr>
</tbody>
</table>

**Creating a Navigation Category**

In the navigation portlet, links are organized by shortcut groups and navigation categories. A navigation category contains shortcuts within shortcut groups. The shortcuts displayed in the navigation portlet depend on your selected navigation category.

An administrator can provide role access to certain navigation categories.

**To create a navigation category:**

2. In the Assign to Category field, select New from the list or click the + icon.
3. In the Name field, enter a name for the navigation category.
4. Leave the Inactive box clear to display the navigation category on the navigation portlet.
5. Click Save.

**Note:** You can only create 25 categories with a complete set of shortcut groups and links.

**Creating a Shortcut Group**

A shortcut group is a collection of shortcuts or links. When you create a shortcut group, you must assign it to a navigation category.

**To create a shortcut group:**

2. Provide values for the following fields:
   - Name – Enter a name for the shortcut group.

   **Note:** If you create shortcut groups with the same name, the shortcut group that is first created is used. If you create shortcut groups with the same name but assign them to different navigation categories, all of the shortcut groups are displayed in the portlet.

   - Assign to Category – Select a navigation category where you want to assign the shortcut group. To create a new navigation category, select New from the list.

   For information on creating navigation categories, see Creating a Navigation Category.
Setting Up Dashboard Portlet Content

- **Shortcut Group Display Order** – Enter a numeric value to define the display order of the shortcut group.

  For example, if you enter 1, the shortcut group is shown as the first column in the navigation portlet. The display order of the shortcut groups is based on available columns. If two or more shortcut groups have the same display order, the system displays the shortcut groups in alphabetical order.

  **Note:** The navigation portlet can only display up to 8 shortcut groups. If you enter a display order value that is beyond the limit, the shortcut group is created but is not displayed in the navigation portlet.

- **Icon** – Select an icon for the shortcut group.

  Image files must be uploaded to the File Cabinet. If possible, use a square image. The system automatically adjusts the size to 60 × 60 pixels.

- **Inactive** – Leave this box clear to display the shortcut group on the navigation portlet.

- **Display Shortcut Groups to All Roles** – Check this box to make the shortcut group visible to all roles.

  When this box is checked, the **Role** field becomes read-only.

- **Role** – Select at least one role that can access this shortcut group.

  To select multiple roles, press and hold down the Ctrl key.

3. **Add shortcuts to the shortcut group:**

   a. **Navigation Shortcut Name** – Enter the shortcut name.

   b. **Shortcut Display Order** – Enter a numeric value to determine the display order of the shortcut in the shortcut group.

   c. **Link** – Enter the URL of the shortcut.

     **Important:** The system does not validate the URL. Ensure that you have entered the correct URL for the link to open.

   d. **Tooltip** – (Optional) Enter a tooltip for the shortcut or select from the available tooltips in the list.

     The tooltip list is a custom record that supports multiple languages.

   e. Click **Add**.

   f. Repeat steps a through e to add more shortcuts to the shortcut group.

     You can add up to 5 shortcuts per shortcut group.

4. Click **Save**.

**Adding Shortcuts to an Existing Shortcut Group**

You can add shortcuts while creating a shortcut group or you can also add shortcuts to an existing shortcut group.

**To add shortcuts to an existing shortcut group:**


2. Select the shortcut group where you want to add shortcuts and click **Edit**.

3. On the Navigation Shortcut Group page, enter values for the following columns:

   a. **Navigation Shortcut Name** – Enter the shortcut name.
b. **Shortcut Display Order** – Enter a numeric value to determine the display order of the shortcut in the shortcut group.

c. **Link** – Enter the URL of the shortcut.

![](Important: The system does not validate the URL. Ensure that you have entered the correct URL for the link to open.

d. **Tooltip** – (Optional) Enter a tooltip for the shortcut or select from the available tooltips in the list.

   The tooltip list is a custom record that supports multiple languages.

e. Click **Add**.

f. Repeat steps a through e to add more shortcuts to the shortcut group.

You can add up to 5 shortcuts per shortcut group.

4. Click **Save**.

**Modifying the Content of the Navigation Portlet**

When you log in to NetSuite, the navigation portlet displays the default name and column display. You can modify the display depending on your preference.

**To modify the content of the navigation portlet:**

1. On your dashboard, click the menu icon in the Navigation Shortcut Group, and select **Edit**.

2. In the Custom Content dialog, specify values for the following fields:

   - **Title** – Enter a name for the portlet.
     When left blank, the default name Navigation Shortcut Group is displayed as the portlet name.

   - **No. of Category Columns to Display** – Enter the number of columns that you want to display in the portlet. The maximum number is 4.

     ![](Note: When you move the portlet to the side of the dashboard, it will automatically display only one column.

   - **Default Category** – (Optional) Select a category to display as the default.

     When left blank, the portlet displays the shortcut groups according to the display order defined in the navigation category.

3. Click **Save**.

**Adding Roles That Can View Shortcut Groups**

When you created a shortcut group, you assigned roles that can view it. After creating the shortcut group, you can still add roles that can view it. The original role associated with the shortcut group creation is called the source role. New roles for which you want to grant additional access are called target roles.

When you specify a target role, the shortcut groups that the source role can view also become available for viewing to the target roles.

**To add roles that can view shortcut groups:**

1. Go to Setup > Navigation Portlet > Roles Update.

2. On the Navigation Portlet Roles Update page, specify values for the following fields:

   - **Target Role** – Select a target role.
To select multiple roles, press and hold down the Ctrl key.

b. **Source Role** – Select a source role.

3. Click **Run Update**.

| Note: Inactive source roles are not updated. |

4. Click **OK**.

5. On the Schedule Script Status page, click **Refresh** to check the status of the update.

The **Status** column displays Complete after the update.

The shortcut groups that the source role can view also become available for viewing to the target roles after the update is complete.

**Custom Search Portlets**

You can configure custom search portlets to display saved search results on the home page dashboard. Up to six custom search portlets can be used on the home page dashboard.

**To add a Custom Search portlet to your dashboard:**

1. Click **Personalize** in the upper right corner of your dashboard or use **Personalize Dashboard** in the **Settings** portlet.

2. On the **Standard Content** tab of the **Personalize Dashboard** palette, click the **Custom Search** icon or drag it onto the dashboard.

3. To specify which saved search to display, click **Set Up** in the portlet or the portlet menu, select the search from the **Search** list, and click **Save**.

   You can also add a custom title for your portlet and specify other display options. For more details, see the help topic **Displaying Saved Search Results in Dashboard Portlets**.

When placed in the right or left columns of a dashboard, custom search portlets display only the first 4 results columns of the saved search. When placed in the center column, they display the first 9 columns. Custom search portlets also include New, Edit, and View columns with links for each result record. Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon ➤. The full-screen view of the portlet displays more columns and rows in the search results.

**KPI Meter Portlets**

A KPI meter portlet displays data for one of the KPIs included in the Key Performance Indicators portlet.

To be able to add a KPI meter for a key performance indicator, you need to add and configure a Key Performance Indicators portlet first. For more information, see **Setting Up the Key Performance Indicators Portlet**.

**To add a KPI Meter portlet to your dashboard:**

1. Click **Personalize** in the upper right corner of your dashboard or use **Personalize Dashboard** in the **Settings** portlet.
2. On the **Standard Content** tab of the **Personalize Dashboard** palette, click the **KPI Meter** icon or drag it onto the dashboard.

3. In the portlet’s dropdown menu, select the key performance indicator to display it as a meter.

4. For additional display options, click **Set Up** in the portlet menu. You can modify the time period, comparison, and highlighting options for this KPI meter.

To learn more about KPI meter portlets, see [KPI Meters](#).

### KPI Scorecard Portlet

KPI Scorecard portlets can display data comparisons across multiple key performance indicators (KPIs). These comparisons are stored in NetSuite as separate KPI Scorecard records. You need to create a KPI scorecard before you can add it to your dashboard. To learn how to set up a KPI scorecard, see [Creating a KPI Scorecard](#).

**To add a KPI Scorecard portlet to your dashboard:**

1. Click **Personalize** in the upper right corner of your dashboard or use **Personalize Dashboard** in the **Settings** portlet.

2. On the **Standard Content** tab of the **Personalize Dashboard** palette, click the **KPI Scorecard** icon or drag it onto the dashboard.

3. Click **Set Up** in the portlet or the portlet menu to configure the portlet.

4. Select the KPI scorecard to display and click **Save**. You can also set filtering and orientation options, as well as choose to show or hide the date row or the trend graph icon.

For more information on adding KPI Scorecard portlets, see [Adding a KPI Scorecard Portlet to a Dashboard](#).

### Key Performance Indicators Portlet

Key Performance Indicators (KPIs) provide summaries of your forecast, pipeline, orders, cases, and financial data right on your dashboard. Each KPI compares data based on reports over different time ranges. You can use standard KPIs or create custom KPIs based on saved searches.

**To add a Key Performance Indicators portlet to your dashboard:**

1. Click **Personalize** in the upper right corner of your dashboard or use **Personalize Dashboard** in the **Settings** portlet.

2. On the **Standard Content** tab of the **Personalize Dashboard** palette, click the **Key Performance Indicators** icon or drag it onto the dashboard.
3. To configure the KPIs to be displayed, click **Set Up** in the portlet menu.

For more information about KPIs, see [Key Performance Indicators Overview](#). To learn how to set up custom KPIs, see [Custom KPIs](#).

### List Portlets

List portlets can display records of a specific record type. You can choose among standard record types (employees, activities, transactions, and many other) and custom record types created by you or other users. You can also use this portlet to add new records of the selected record type. In addition to viewing records, you can use this portlet to display the results of saved searches related to the record type you selected.

**To add a List portlet to your dashboard:**

1. Click **Personalize** in the upper right corner of your dashboard or use **Personalize Dashboard** in the **Settings** portlet.
2. On the **Standard Content** tab of the **Personalize Dashboard** palette, click the **List** icon or drag it onto the dashboard.
3. To specify the type of records you want to be displayed, click **Set Up** in the portlet or the portlet menu, select the record type from the **List Type** menu, and click **Save**.

To display the results of a saved search related to the record type you selected, use the portlet’s View menu.

To create a new record of the selected record type, you can use a link in the portlet menu.

Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon ↩️. The full-screen view of the portlet displays more columns and rows in the search results.

### Phone Calls Portlet

The Phone Calls portlet enables you to see a list of upcoming phone calls. You can also view and edit individual records if you have the permission.

You can view the upcoming phone calls using the Dashboard view or the Default view. The Default view enables you to filter phone calls by status and organizer.

In both views, you can also sort phone calls by the following status: Phone Call Date, End Date, Recently Created, Recently Modified, or Recently Viewed. Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon ↩️. The full-screen view of the portlet displays more columns and rows in the search results.

The number of phone calls in the portlet is limited to 50. If the Inline Editing feature is enabled and you have permission, you can edit records directly in the portlet list.

For instructions on how to add the Phone Calls portlet to a page, see [Adding a Portlet to a Dashboard](#).
Quick Add Portlet

You can use the Quick Add portlet to quickly add new records of a selected type from the dashboard without shifting to another page. For example, a Sales Rep could create a new customer record from the Home page, or a new task record from a customer page.

You can set up the Quick Add portlet to be used for a number of standard record types or for a custom record type that you have defined as available for Quick Add. You also can edit the fields available in the portlet for data entry.

To add a Quick Add portlet to a dashboard:

1. Click Personalize in the upper right corner of your dashboard or use Personalize Dashboard in the Settings portlet.
2. On the Standard Content tab of the Personalize Dashboard palette, click the Quick Add icon or drag it onto the dashboard.
3. To change the default record type, click Set Up in the portlet menu, select the record type from the Quick Add: Type list, and click Save.

For more information, see Using Quick Add for Standard Records and Using Quick Add for Custom Records.

Using Quick Add for Standard Records

Quick Add is available for the following standard record types:

- Case
- Contact
- Customer
- Event
- Lead
- Opportunity
- Partner
- Phone Call
- Prospect
- Task
- Vendor

The fields in the Quick Add portlet for each standard record type are based on the Quick Add fields defined for the user's preferred form for the record type, as defined on the Role setup page for the role used to log in. Quick Add fields on standard forms are system-defined.
Note: Fields included in the Quick Add portlet are also available for Inline Editing when this feature is enabled. For details, see the help topic Using Inline Editing.

The following table lists the default Quick Add fields for each supported record type. Fields listed in the middle column cannot be removed from the Quick Add portlet. Note that field names may be slightly different in your user interface.

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Fields Required in Quick Add Portlet</th>
<th>Other Default Quick Add Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case</td>
<td>Subject, Company, Incident Date</td>
<td>Message, Contact</td>
</tr>
<tr>
<td>Contact</td>
<td>Contact, Subsidiary (OneWorld only)</td>
<td>Company, Job Title, Email, Phone</td>
</tr>
<tr>
<td>Customer</td>
<td>Company Name, Subsidiary (OneWorld only)</td>
<td>Customer ID, Web Address, Email, Phone</td>
</tr>
<tr>
<td>Event</td>
<td>Title, Date, Start Time, End Time</td>
<td>Location, Message</td>
</tr>
<tr>
<td>Lead</td>
<td>Subsidiary (OneWorld only)</td>
<td>Customer ID, Company Name, Web Address, Email, Phone</td>
</tr>
<tr>
<td>Opportunity</td>
<td>Company, Status, Expected Close, Projected Total</td>
<td>Estimated Budget, Sales Readiness, Buying Time Frame, Buying Reason, Title, Details</td>
</tr>
<tr>
<td>Partner</td>
<td>Partner ID, Partner Code, Subsidiary (OneWorld only)</td>
<td>Company Name, Phone, Email</td>
</tr>
<tr>
<td>Phone Call</td>
<td>Subject, Organizer, Date</td>
<td>Phone Number, Transaction</td>
</tr>
<tr>
<td>Prospect</td>
<td>Company Name, Subsidiary (OneWorld only)</td>
<td>Phone, Email, Web Address</td>
</tr>
<tr>
<td>Task</td>
<td>Title, Priority, Start Date, Due Date</td>
<td>Insert Before</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor ID, Company Name, Subsidiary (OneWorld only)</td>
<td>Email, Phone, Default Expense Account</td>
</tr>
</tbody>
</table>

Using Quick Add for Custom Records

You can set up custom records so that they are available to be added from the Quick Add portlet. You need to enable the Allow Quick Add option for any custom record type for it to be listed in the Quick Add Type dropdown list.

To enable Quick Add for a custom record:

1. Open the custom record type that you would like to use in the Quick Add portlet. Custom record types are available at Customization > Lists, Records, & Fields > Record Types.
2. Select the Allow Quick Add box.
By default, only the **Name** field is provided for custom record Quick Add portlet data entry. To permit data entry for other custom record custom fields, you can enable the per field Allow Quick Add option.

3. To enable Quick Add for a field, click that field on the **Fields** subtab. On the **Display** subtab of the field settings page, select the **Allow Quick Add** option. Click **Save** to apply your settings.

![Image of field settings](image)

**Important:** If the custom record has a preferred form, you must also enable the per field Quick Add option on the form to permit data entry from the Quick Add portlet. For more information about configuring form fields, see the help topic *Configuring Fields or Screens*.

4. Click **Save** to save the custom record type settings.

After you have enabled the Allow Quick Add option for the custom record type, you may need to refresh the page to display the enabled fields in the Quick Add portlet.

### Quick Search Portlet

You can add a Quick Search portlet to be able to search for general records or transaction records right from your dashboard.

**To add a Quick Search portlet:**

1. Click **Personalize** in the upper right corner of your dashboard or use **Personalize Dashboard** in the **Settings** portlet.

2. On the **Standard Content** tab of the **Personalize Dashboard** palette, click the **Quick Search** icon or drag it onto the dashboard.
3. By default, the portlet is configured to search over general records, such as customers, vendors, items, activities, and other records. To make this portlet search over transaction records, such as cash sales, purchase orders, customer refunds, and other transactions, click **Set Up** in the portlet menu and select **Transaction** from the **Search Type** menu.

To learn more about the Quick Search portlet, see the help topic **Quick Search Portlet**.

**Project Tasks Portlets**

If you use Project Management, you can add the Project Tasks portlet to display project tasks on your dashboard. The portlet shows project tasks assigned to all resources and provides quick access to project task information.

**To add a Project Tasks portlet:**

1. Click **Personalize** in the upper right corner of your dashboard or use **Personalize Dashboard** in the **Settings** portlet.
2. On the **Standard Content** tab of the **Personalize Dashboard** palette, click the **List** icon or drag it onto the dashboard.
3. Click **Set Up** in the portlet or the portlet menu and select **Project Task** from the **List Type** list.
4. Click **Save** to update the portlet content.

If you use the Inline Editing feature, you can change a project task’s status in the Project Tasks portlet. Changes made to a task in the portlet are automatically changed on the task record. For more information on inline editing, see the help topic **Using Inline Editing**.

You can also click **Edit** next to a task in the Project Tasks portlet to update the information on a project task record. Use the portlet filter options to select the range of tasks to display in the portlet. Filter selections are sticky changes, meaning your selections are saved until you change them.

**RSS/Atom Feed Portlets**

You can publish information from news sources on your dashboard. By default, NetSuite offers you feeds by CNN, Reuters, Yahoo, CBS Market Watch, and more. In addition to the predefined feeds, you also can choose to display custom RSS feeds from other sites, or to create a custom feed to publish messages to users of your NetSuite account. Generally, you can include a maximum of two RSS/Atom feeds per page.

**Note:** Currently, you can add only two RSS feeds each on the home tab and Issues tab (if available). There is no limitation on the number of RSS feeds on custom tabs. For information, see the help topic **Creating Center Tabs**.

**To add an RSS/Atom feed portlet to a page:**

1. Click **Personalize** in the upper right corner of your dashboard or use **Personalize Dashboard** in the **Settings** portlet.
2. On the Standard Content tab of the Personalize Dashboard palette, click the RSS/Atom Feed icon or drag it onto the dashboard.

![RSS/Atom Feed icon](image)

**To set up an RSS/AtomFeed portlet:**

1. Click **Set Up** in the portlet menu to open the setup popup window.

![Setup popup window](image)

2. Select an RSS feed from the **Source** list.
   - If you select one of the sources that NetSuite provides, the **Feed URL** field automatically contains the correct URL.
   - If you select **Custom**, enter the URL of the feed in the **Feed URL** field. This URL can be from a website or from your own set of HTML pages used as an RSS feed.

   To find the URL for a website's feed:
   1. Go to the website, and look for an RSS/XML link or ![RSS icon](image) icon.
   2. Click the link or icon to open the feed page.
   3. Copy and paste this page's URL into the setup window’s **Feed URL** field.

   To learn how to create your own custom RSS feed, see Creating Custom RSS/Atom Feeds.

3. In **Number of Links**, type the number of links you want to appear in the portlet.

4. If you want to display links only, without additional details, clear the **Show Details** box. The details that are displayed depend on the RSS feed.

5. Click **Save**.

You now can see the feed information in the dashboard portlet.

If the portlet takes up too much space on your dashboard, click Set Up again and reduce the number of links or clear the Show Details box.

### Creating Custom RSS/Atom Feeds

You can create your own custom RSS/Atom feeds to publish information to users in dashboard portlets. In this case, RSS/Atom Feed portlet displays links to HTML pages stored in the File Cabinet with brief descriptions of every page linked.

To create a custom feed, you must first create HTML documents containing the information to which the RSS/Atom Feed portlet will link. Then you should upload these files to the File Cabinet. Finally, you need to create an RSS Feed record in NetSuite that will include the links to your HTML files. This record also
includes a definition of the audience for the file. The audience may include different roles, employees, customers, and other entities.

**To create a custom RSS/Atom feed:**

1. Create a set of HTML documents outside of NetSuite that you will link to from an RSS/Atom Feed portlet.
2. Go to Documents > Files > File Cabinet. Upload your HTML files.
3. For each file, click **Edit** and copy the file’s URL.
4. Go to Lists > Web Site > RSS Feeds. Click **New**. The RSS Feed record stores the links and information to display in your custom RSS/Atom Feed portlet.
5. In the **Title** field, enter a title for your feed. This title is displayed as the portlet title.
6. In the **Alias** field, enter a name to describe this feed in the custom RSS Feeds list.
7. In the **Description** field, enter a message describing this feed.
8. Check or clear the **Available Externally** box to define the audience for your feed:
   - If you clear this box, the RSS feed is available only to users with login access to your account, and you must choose who can access this feed by selecting users on the **Audience** subtab.
   - If you check this box, all users will have access to this feed.
9. On the **Items** subtab, add the titles, descriptions, and URLs for each of your HTML files.
   - The **Title** appears as the link text in the RSS/Atom Feed portlet.
   - The **Description** field contains details about the content of the linked HTML page.
   - The **URL** field should contain the URL for the linked HTML file.
10. When you have added titles, descriptions, and URLs for all your HTML files, click **Save**.

Users in the defined audience now can choose to display the custom feed in an RSS/Atom Feed portlet on their dashboards. For information, see **RSS/Atom Feed Portlets**. If you are an administrator, you can publish your dashboard with this feed to users with other related roles. For information, see **Publishing Dashboards Overview**.

**Note:** Currently, you can add only two RSS feeds each on the **Home** tab and **Issues** tab (if available). You can get around this limitation by creating a custom tab, where there is no limitation on the number of RSS feeds. For information, see the help topic **Creating Center Tabs**.

**Reviewing Recent Records**

The Recent Records portlet displays a list of records that you have recently created, modified, or viewed with links that you can click for quick access to these records. Recent records are also listed on the recent records menu, on the left of the navigation menu.

The Recent Records portlet does not have a Set Up link, so you cannot change its contents.

In this portlet, as in others, the controls are hidden until you move your cursor over the portlet. Each record includes a link to view the record. In addition, if you have edit permission for the record, an **Edit** link appears to the right as shown in this screenshot.
The following screenshot displays the Recent Records menu available from the icon on the navigation menu. Click a link to display an individual record, or click All Recent Records to display a list of all records you have used recently, in reverse chronological order.

Setting Up Reminders

You can set up reminders for important data or tasks in NetSuite. Reminders appear in the Reminders portlet on dashboards. When you click a reminder in the portlet, you go to a page with more details where you can take action as necessary.

For example, Wolfe Electronics has set up a reminder to receive orders. When there are orders to be received, a reminder appears in the Reminders portlet. A user clicks the reminder and goes to the Receive Orders page.

**To add a Reminders portlet:**

1. If you do not see any Reminders portlet on your dashboard, click Personalize in the upper right corner of your dashboard. You can also use Personalize Dashboard in the Settings portlet.
2. On the Standard Content tab of the Personalize Dashboard palette, click the Reminders icon or drag it onto the dashboard.

**To set up the Reminders portlet:**

1. In the Reminders portlet's menu, click Set Up.
2. Click a reminder in the left list or drag it to the Current Selections list on the right.
   
   The reminders are arranged alphabetically. Custom reminders are marked with 🔄.
The available system-defined reminders depend on your role and the features enabled in your account. For a list of the reminders NetSuite offers, see System-Defined Reminders Table. Custom reminders are available when saved searches to which you have access are marked as available for reminders. For information, see Creating Custom Reminders.

3. You can change the order in which reminders appear in the Reminders portlet by dragging them up or down in the list.

4. If you want a reminder to be used as a headline reminder, drag it under the Headline. Headline reminders are displayed in the upper part of the portlet and use a more prominent layout.

5. If you want the reminders to be shown even when there are no results to display, select Show reminders with zero results.

6. When ready, click Save.

A count and a link is displayed for each reminder that has matching results. Click Reminder to display the related task or search results.

**Note:** To see continually updated results for reminders, refresh the portlet periodically.

You can apply highlighting rules to any of your reminders. Each highlighting rule adds a color indicator to the reminder whenever the specified threshold is reached.

**To set up highlighting rules:**

1. In the Reminders portlet, point to a reminder you want to edit and click the edit icon.

2. To add a highlighting rule, click Add Rule, choose the color to use, and specify the threshold. You can specify as many rules as you need.
3. Click **Save** to apply the highlighting rules.

### Reminder alerts

The Reminders portlet indicates if a specific Saved Search (both Standard or Custom Reminders) is interrupted for any reason by a yellow triangle icon.

All other saved searches that finish successfully show a reminder count as expected. If you hover the mouse over the icon, it shows a hint according to your role, permissions, and saved search ownership.

- For Administrators, the message for errors for standard reminders appears as **Unable to load. Please contact Support**.
- For non-Administrators, a message of **Unable to load. Please contact your Administrator** will appear.
- For Administrators who are also owners, the message of **Unable to load. Please modify your search** will appear.
- For Administrators who are not owners, the message of **Unable to load. Please contact the owner or create a new reminder** will appear.
- For non-Administrators who are owners, the message of **Unable to load. Please modify your search** will appear.
- For non-Administrators who are owners and can perform search, the message **View: Unable to load. Please change to a role with sufficient permissions and modify your search** will appear.
- For non-Administrators who are not owners but can perform Search, the message **Full: Unable to load. Please contact the owner or create a new reminder** will appear.
- For non-Administrators who are not owners and cannot perform search, the message **View: Unable to load. Please contact your Administrator** will appear.
System-Defined Reminders Table

The following table describes reminders that may be available, depending on your role and the features enabled in your account.

![Note: Custom reminders may also be available to you. See Creating Custom Reminders.](image)

For more information on setting reminders, see Setting Up Reminders.

<table>
<thead>
<tr>
<th>Reminder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocation Schedules due</td>
<td>Reminds you of allocation schedules that are due.</td>
</tr>
<tr>
<td>Amortization Entries pending</td>
<td>Reminds you of amortization entries that are pending.</td>
</tr>
<tr>
<td></td>
<td>Clicking this reminder takes you to the Amortization Journal Entries page filtered to show only transactions for the current period.</td>
</tr>
<tr>
<td>Assemblies to Build</td>
<td>Reminds you of assembly work orders you need to enter.</td>
</tr>
<tr>
<td>Assemblies to Order</td>
<td>Reminds you of assembly work orders to order.</td>
</tr>
<tr>
<td>Bills to Pay</td>
<td>Reminds you of bills you need to pay. You can customize this reminder by choosing how many days before the due date you would like this reminder to appear. Clicking this reminder takes you to the page.</td>
</tr>
<tr>
<td>Calls that are overdue</td>
<td>Reminds you of phone calls that are overdue.</td>
</tr>
<tr>
<td></td>
<td>Clicking this reminder takes you to a list of phone calls filtered to show only calls that are overdue.</td>
</tr>
<tr>
<td>Calls to complete</td>
<td>Reminds you of phone calls that are not complete.</td>
</tr>
<tr>
<td></td>
<td>Clicking this reminder takes you to a list of phone calls filtered to show only calls you need to complete.</td>
</tr>
<tr>
<td>Campaigns to Email</td>
<td>Reminds you of campaigns you need to email.</td>
</tr>
<tr>
<td></td>
<td>Clicking this reminder takes you to the Campaign Calendar page.</td>
</tr>
<tr>
<td>Campaigns to Print</td>
<td>Reminds you of marketing campaigns you need to print.</td>
</tr>
<tr>
<td>Cases to respond to</td>
<td>Reminds you of cases you need to resolve.</td>
</tr>
<tr>
<td></td>
<td>Clicking this reminder takes you to the Cases page. The number corresponds to the number of open or escalated cases assigned to you and awaiting support reply.</td>
</tr>
<tr>
<td>Checks to Print</td>
<td>Reminds you of checks you need to print.</td>
</tr>
<tr>
<td></td>
<td>Clicking this reminder takes you to the Print Checks and Forms page.</td>
</tr>
<tr>
<td>Commissions Rejected by Accounting</td>
<td>Shows the number of commissions that have been rejected by the your company's accounting department. Clicking this reminder takes you to the Commissions list filtered to show only commissions that have been rejected by accounting.</td>
</tr>
<tr>
<td>Credit Cards to Approve</td>
<td>Reminds you of credit card payments you need to approve.</td>
</tr>
<tr>
<td></td>
<td>Clicking this reminder takes you to the Unapproved Payments Register.</td>
</tr>
<tr>
<td>Credit Memos to Print</td>
<td>Reminds you of credit memos you need to print.</td>
</tr>
<tr>
<td></td>
<td>Clicking this reminder takes you to the Print Credit Memos page.</td>
</tr>
<tr>
<td>Customers to Bill</td>
<td>Reminds you of customers that need to be billed.</td>
</tr>
<tr>
<td></td>
<td>Clicking this reminder takes you to the page you use for billing, which varies according to how you process customer billing.</td>
</tr>
<tr>
<td>Reminder</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customers to Renew</td>
<td>Reminds you of the number of customers you need to renew. Clicking this reminder takes you to the Customers &amp; Projects page.</td>
</tr>
<tr>
<td>Direct Deposits Returned</td>
<td>Reminds you of the number of returned Direct Deposits. Clicking this reminder takes you to the View Direct Deposit Status page filtered to list all payments returned with an Unreachable or Unknown Error status.</td>
</tr>
<tr>
<td>Direct Deposits to Approve</td>
<td>Reminds you of direct deposits you need to approve. Clicking this reminder takes you to the Approve Direct Deposit Payments page filtered to list all payments pending approval.</td>
</tr>
<tr>
<td>Direct Deposits to Print</td>
<td>Reminds you of direct deposit vouchers you need to print. Clicking this reminder takes you to the Print Checks and Forms page.</td>
</tr>
<tr>
<td>Electronic Funds Transfers Returned</td>
<td>Reminds you of the number of returned electronic funds transfers. Clicking this reminder takes you to the View Electronics Funds Transfer Status page filtered to list all payments returned with a Failed, Unreachable or Unknown Error status.</td>
</tr>
<tr>
<td>Electronic Funds Transfers to Approve</td>
<td>Reminds you of electronic funds transfer you need to approve. Clicking this reminder takes you to the Approve Electronic Funds Transfers page filtered to list all transfers pending approval.</td>
</tr>
<tr>
<td>Employees to Pay</td>
<td>Reminds you of the number of employees awaiting a payroll run. You can customize this reminder by choosing how many days before the next pay period you would like this reminder to appear. Clicking this reminder takes you to the Payroll Run page.</td>
</tr>
<tr>
<td>Employees to Review</td>
<td>Reminds you of the number of employees you need to review. Clicking this reminder takes you to your Employees list.</td>
</tr>
<tr>
<td>Employees with an Expiring Authorization</td>
<td>Reminds you of employees who have authorizations expiring.</td>
</tr>
<tr>
<td>Employees with an Expiring Visa</td>
<td>Reminds you of employees who have visas expiring.</td>
</tr>
<tr>
<td>Employees with an Upcoming Anniversary</td>
<td>Reminds you of employees who have upcoming anniversaries.</td>
</tr>
<tr>
<td>Employees with an Upcoming Birthday</td>
<td>Reminds you of employees who have upcoming birthdays.</td>
</tr>
<tr>
<td>Estimates to Print</td>
<td>Reminds you of estimates you need to print. Clicking this reminder takes you to the Print Estimates page.</td>
</tr>
<tr>
<td>Event Invitations to respond to</td>
<td>Reminds you of invitations you need to respond to. Clicking this reminder takes you to the Events List page.</td>
</tr>
<tr>
<td>Expense Reports to Approve</td>
<td>Reminds you of expense reports you need to approve. Clicking this reminder takes you to the Approve Expense Reports page.</td>
</tr>
<tr>
<td>Invoices Overdue</td>
<td>Reminds you of overdue invoices. You can customize this reminder by choosing how many days after the due date you would like this reminder to appear. Clicking this reminder takes you to the Open Invoices report filtered to show only invoices that are overdue.</td>
</tr>
<tr>
<td>Invoices Rejected</td>
<td>Reminds you of invoices that were rejected.</td>
</tr>
<tr>
<td>Invoices to Approve Due to Credit Hold</td>
<td>Reminds you of invoices that you must approve due to credit hold.</td>
</tr>
<tr>
<td>Invoices to Approve Due to Inconsistent ...</td>
<td>Reminds you of invoices that you must approve due to inconsistent payment terms.</td>
</tr>
<tr>
<td>Reminder</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Invoices to Approve Due to Unknown Tax Amount</td>
<td>Reminds you of invoices that you must approve due to unknown tax amount.</td>
</tr>
<tr>
<td>Invoices to Approve</td>
<td>Reminds you of invoices that you must approve.</td>
</tr>
<tr>
<td>Invoices to Print</td>
<td>Reminds you of invoices you need to print. Clicking this reminder takes you to the Print Invoices page.</td>
</tr>
<tr>
<td>Items to Order</td>
<td>Reminds you of items you need to order. Clicking this reminder takes you to the Inventory Stock Status By Item list filtered to show only items you need to order or build.</td>
</tr>
<tr>
<td>Journals to Approve</td>
<td>Reminds you of journal entries to approve.</td>
</tr>
<tr>
<td>Memorized Transactions due</td>
<td>Reminds you of memorized transactions that are due. You can customize this reminder by choosing how many days before the due date you would like this reminder to appear. Clicking this reminder takes you to the Memorized Transactions page.</td>
</tr>
<tr>
<td>NetSuite System Alerts to Acknowledge</td>
<td>Reminds you of problems encountered in processing transactions and provides suggestions on how to resolve the problem.</td>
</tr>
<tr>
<td>Opportunities to Close</td>
<td>Reminds you of the number of open opportunities. You can customize this reminder by entering the number of days before the expected close date you would like this reminder to appear. Clicking this reminder takes you to a list of your open opportunities.</td>
</tr>
<tr>
<td>Orders to Fulfill</td>
<td>Reminds you of sales orders you need to fulfill. Clicking this reminder takes you to the Fulfill Sales Order page.</td>
</tr>
<tr>
<td>Orders to Pack</td>
<td>Reminds you of sales orders you need to pack. Clicking this reminder takes you to the Pack Orders page.</td>
</tr>
<tr>
<td>Orders to Receive</td>
<td>Reminds you of the number of purchase orders you need to receive. Clicking this reminder takes you to the Receive Purchase Orders page.</td>
</tr>
<tr>
<td>Orders to Ship</td>
<td>Reminds you of sales orders you need to ship. Clicking this reminder takes you to the Mark Orders Shipped page.</td>
</tr>
<tr>
<td>Overdue Projects</td>
<td>Reminds you of projects that are overdue. You can customize this reminder by choosing how many days before the estimated end date you would like this reminder to appear. Clicking this reminder takes you to the Customer &amp; Projects page filtered to show only the overdue projects.</td>
</tr>
<tr>
<td>Paychecks to Print</td>
<td>Reminds you of paychecks you need to print. Clicking this reminder takes you to the Print Checks and Forms page.</td>
</tr>
<tr>
<td>Payments to Deposit</td>
<td>Reminds you of payments you need to deposit. Clicking this reminder takes you to the Deposit page filtered to show deposits you need to make.</td>
</tr>
<tr>
<td>Payroll Batches to Commit</td>
<td>Reminds you of payroll batches you need to commit. Clicking this reminder takes you to the Payroll batch list where you can view or edit each uncommitted payroll before committing.</td>
</tr>
<tr>
<td>Periods to Close</td>
<td>Reminds you of accounting periods you need to close. You can customize this reminder to remind you to close a period in a specific number of days after the period ends. Clicking this reminder takes you to the Manage Accounting Periods page.</td>
</tr>
<tr>
<td>Purchase Orders to Bill</td>
<td>Reminds you of the number of purchase orders you need to bill. Clicking this reminder takes you to the Bill Purchase Orders page.</td>
</tr>
<tr>
<td>Reminder</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Purchase Orders to Print</td>
<td>Reminds you of purchase orders you need to print. Clicking this reminder takes you to the Print Purchase Orders page.</td>
</tr>
<tr>
<td>Purchase Requests to Approve</td>
<td>Reminds you of purchase requests entered by employees that you need to approve. Clicking this reminder takes you to the Approve Purchase Requests page.</td>
</tr>
<tr>
<td>Receipts to Print</td>
<td>Reminds you of receipts to print.</td>
</tr>
<tr>
<td>Rejected Intercompany Purchase Orders</td>
<td>Reminds you of the rejected intercompany purchase orders.</td>
</tr>
<tr>
<td>Rejected Intercompany Vendor Returns</td>
<td>Reminds you of the rejected intercompany vendor returns.</td>
</tr>
<tr>
<td>Resource Allocations to Approve</td>
<td>Reminds you of resource allocations that you need to approve.</td>
</tr>
<tr>
<td>Return Authorization Requiring Revenue Commitment Reversals</td>
<td>Reminds you of the number of sales orders that need revenue commitments. Drills down to the Generate Revenue Commitment page.</td>
</tr>
<tr>
<td>Return Authorizations to Approve</td>
<td>Reminds you of returns you need to approve. Clicking this reminder takes you to the Approve Return Authorizations page filtered to show only returns you need to approve.</td>
</tr>
<tr>
<td>Return Authorizations to Print</td>
<td>Reminds you of return authorizations you need to print. Clicking this reminder takes you to the Return Authorizations page where you can select the authorization that needs to be printed.</td>
</tr>
<tr>
<td>Return Authorizations to Receive</td>
<td>Reminds you of returns you need to receive. Clicking this reminder takes you to the Receive Returns page.</td>
</tr>
<tr>
<td>Return Authorizations to Refund</td>
<td>Reminds you of returns you need to refund. Clicking this reminder takes you to the Credit Returns page.</td>
</tr>
<tr>
<td>Revenue Recognition Entries pending</td>
<td>Reminds you of revenue recognition entries that are pending. Clicking this reminder takes you to the Revenue Recognition Journal Entries page filtered to show only transactions for the current period.</td>
</tr>
<tr>
<td>Sales Orders Requiring Revenue Commitments</td>
<td>Reminds you of the number of sales orders that need revenue commitments. Drills down to the Generate Revenue Commitment page.</td>
</tr>
<tr>
<td>Sales Orders to Approve</td>
<td>Reminds you of sales orders you need to approve. Clicking this reminder takes you to the Approve Sales Orders page filtered to show only sales orders you need to approve.</td>
</tr>
<tr>
<td>Sales Orders to Bill</td>
<td>Reminds you of sales orders you need to bill. Clicking this reminder takes you to the Bill Sales Order page.</td>
</tr>
<tr>
<td>Sales Orders to Print</td>
<td>Reminds you of sales orders you need to print. Clicking this reminder takes you to the Print Sales Order page.</td>
</tr>
<tr>
<td>Solutions to Approve</td>
<td>Reminds you of knowledge base solutions you need to approve.</td>
</tr>
<tr>
<td>SuiteBundles to Update</td>
<td>Reminds you that one or more installed bundles have an updated version available. Clicking this reminder takes you to the Installed Bundles page, where you can click links to update bundles.</td>
</tr>
<tr>
<td></td>
<td>This reminder is added by default for an account's administrators and users with SuiteApp Marketplace permission when the first bundle is installed in the account.</td>
</tr>
<tr>
<td>Tasks due today</td>
<td>Reminds you of tasks assigned to you that are due today.</td>
</tr>
</tbody>
</table>
## Setting Up Dashboard Portlet Content

<table>
<thead>
<tr>
<th>Reminder</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Tasks that are overdue** | Clicking this reminder takes you to a tasks list filtered to show only tasks due today. 
Reminds you of tasks assigned to you that are overdue. 
Clicking this reminder takes you to a tasks list filtered to show only your overdue tasks. |
| **Tasks to complete** | Reminds you of tasks assigned to you that are not complete. 
Clicking this reminder takes you to a tasks list filtered to show only tasks you need to complete. |
| **Time Records to Approve** | Reminds you if you need to approve the time of subordinates. Clicking this reminder takes you to the Approve Time task. |
| **Transfer Orders to Approve** | Reminds you of transfer orders due to be processed. All transfer orders that are pending approval or pending fulfillment are included in this count. Clicking this reminder takes you to the Approve Transfer Orders page. |
| **Vendor Return Authorizations to Approve** | Reminds you of vendor returns you need to approve. Clicking this reminder takes you to the Approve Return Authorizations page filtered to show only returns you need to approve. |
| **Vendor Return Authorizations to Refund** | Reminds you of vendor returns you need to refund. Clicking this reminder takes you to the Refund Vendor Return Authorization page. |
| **Vendor Return Authorizations to Return** | Reminds you of vendor returns you need to send. Clicking this reminder takes you to the Ship Vendor Return Authorization page. |
| **Work Orders to Build** | Reminds you of assembly work orders you need to build. |
| **Work Orders to Close** | Reminds you of assembly work orders to close. |

### Creating Custom Reminders

If the reminders provided by NetSuite do not meet all of your needs, you can create your own reminders and add them to the Reminders portlet on your dashboard. Each reminder is based on a count of the results of a saved search.

To create a custom reminder, enable the Available for Reminders option on the saved search definition page. After this option is enabled, the saved search is listed as a reminder on the Set Up Reminders page, and you can choose to show it in the Reminders portlet.

**To create a custom reminder:**

1. Create a new saved search or edit an existing saved search. See the help topic [Defining a Saved Search](#).
2. On the saved search definition page, check the Available for Reminders box.
3. Make sure that the search name is suited for display in the Reminders portlet.
   The search name is displayed in the Reminders portlet, with the format: `<number_of_results> <saved_search_name>`

4. On the Results subtab of the saved search, check whether any summary types that group search results are included.
   - Custom reminders work best for saved searches that do not have any grouped results because reminders are based on a count of the number of results and only display when this count is a non-zero integer.
   - If you set up a reminder for a saved search that groups results by a summary type other than a count, the reminder does not display.
   - You can define a count for a grouped field to make the reminder display, but the reminder result is affected by the grouping and may not include the total count of saved search results.
   - It may be best to remove summary types or recreate the search without summary types for use as a reminder.
   - For information about grouping search results with summary types, see the help topic Summary Types for Search Results.

5. Click Save to save the search.

To add a custom reminder to the Reminders portlet:

1. Go to your home page. If this page does not include a Reminders portlet, click Personalize Dashboard and add it. See Setting Up Reminders.
2. In the Reminders portlet menu, click Set Up.
3. In the Type menu, select Custom.
   The custom reminders available in your account are displayed. Each custom reminder is marked with a icon.
   Note that all saved searches to which you have access are listed if the Available for Reminders box is checked. The list is not limited to searches you have created. See the help topic Accessing a Saved Search.
4. Click a reminder in the left list or drag it to the Current Selections list on the right.
5. You can change the order in which reminders appear in the Reminders portlet by dragging them up or down in the list.
6. If you want a reminder to be used as a headline reminder, drag it under the Headline. Headline reminders are displayed in the upper part of the portlet and use a more prominent layout.
7. If you want the reminders to be shown even when there are no results to display, select Show reminders with zero results.

8. When ready, click Save.

The Reminders portlet displays a count of search results. Click a custom reminder to see detailed search results and complete related tasks.

**Note:** If a custom reminder causes an error that prevents the Reminders portlet from displaying reminder links properly, click Set Up in the Reminders portlet's menu, remove the reminder from the Current Selections list, and click Save.

**Example Custom Reminder**

Custom reminders are based on saved search results, which enables you to include more fine-tuned reminders in your dashboard. This can be especially helpful when you need reminders for custom record types, because system-defined reminders are not provided for custom records.

For example, if your account has an equipment custom record type that includes Last Service field, and you are in charge of keeping Equipment services on a regular basis, you can set up a saved search and custom reminder to determine if the Last Service of Equipment is within the last Fiscal Year.

**To set a custom reminder for servicing Equipment:**

1. Go to Reports > Saved Searches > All Saved Searches > New, and choose Equipment.
2. A saved search definition page opens.
3. Enter a meaningful name for the search.
4. Check the Available for Reminders box.
5. On the Criteria subtab, define a filter for the Last Service field to include equipment records with a Last Service is within last fiscal year.
6. On the Results subtab, choose the columns to be displayed in search results.
7. Save the search.
8. Go to your Home page. If this page does not include a Reminders portlet, click Personalize Dashboard and add it. See Setting Up Reminders.


10. Click the new reminder on the left to move it to the right, and then click Save.

11. Review the Reminders portlet on your Home page.

12. Click Reminder to see the list of expiring warranties and the information you need to renew them.

Report Snapshot Portlets

Report Snapshot portlets can show summaries of some reports that are available to you. You can choose among standard report snapshots or create custom report snapshots.

To add a Report Snapshot to your dashboard:

1. Click Personalize in the upper right corner of your dashboard or use Personalize Dashboard in the Settings portlet.

2. On the Report Snapshots tab of the Personalize Dashboard palette, click the Report Snapshots icon or drag it onto the dashboard.

3. Click Set Up in the portlet menu and select the report snapshot you want to display from the Snapshot list.

4. Click Save to update the portlet content.

You can expand the portlet to full-screen view by clicking the double arrow icon ⬤.

For a list of standard report snapshots, see Standard Report Snapshots Table.

To learn how to create custom report snapshots, see Creating Custom Report Snapshots.

For more information about report snapshots, see Report Snapshots Overview.

Search Form Portlet

If you have a saved search that is used as your preferred search form, you can add this search as a portlet to your dashboard. To learn how to define a saved search as a preferred search form, see the help topic Defining a Saved Search as a Preferred Search Form.

To add a Search Form portlet to your dashboard:

1. Click Personalize in the upper right corner of your dashboard or use Personalize Dashboard in the Settings portlet.

2. On the Standard Content tab of the Personalize Dashboard palette, click the Search Form icon or drag it onto the dashboard.
3. Click **Set Up** in the portlet or the portlet menu and use the **Search** list to select the search form you want to display in the portlet.

You can also display personalized search forms on your dashboard. For details, see the help topics *Personalizing a Search Form* and *Adding Personalized Search Forms to NetSuite Pages*.

## Settings Portlet

The Settings portlet shows links to user-level setup tasks. The links that appear in the portlet are system-defined and cannot be edited, and the portlet itself cannot be removed from the dashboard.

The links that appear in the portlet vary by role and may include the following:

- **Personalize Dashboard** — Opens the Standard Content tab of the Personalize Dashboard palette, which lets you add portlets to the dashboard. For more information, see *Dashboard Personalization*.
- **Set Preferences** — Opens the Set Preferences page, which lets you edit your preferences for different areas of NetSuite. For more information, see the help topic *Setting Personal Preferences*.
- **Change Email** — Opens the Change Email page, which lets you change the email address associated to your NetSuite account. For more information, see the help topic *Change Email Link*.
- **Change Password** — Opens the Change Password page, which lets you change the password you use to access NetSuite. For more information, see the help topic *Change Password Link*.
- **Update Security Questions** — Opens the Update Security Questions screen, which lets you change the security questions associated to your NetSuite account. For more information, see the help topic *Update Security Questions Link*.

Other links that may appear in the portlet depending on your permissions and the features that have been enabled in your NetSuite account include:

- **Publish Dashboard** — Opens the Publish Dashboard page, which lets you publish a dashboard for other users who log in to the same center you are currently in. For more information, see *Publishing Dashboards Overview*.
- **Set Up NetSuite for Outlook** — Opens the Set Up NetSuite for Outlook page, which lets you access the NetSuite for Outlook installer. After it is installed, NetSuite for Outlook enables you to synchronize your Microsoft Outlook™ email, events, contacts, and tasks with your NetSuite account. For more information, see *NetSuite for Outlook*.
- **Set Up SuiteAnalytics Connect** — Opens the SuiteAnalytics Connect Driver Download page, which lets you download a SuiteAnalytics Connect Driver. After it is downloaded and installed, the driver enables you to connect to the Connect Service which, in turn, lets you archive, analyze, and report on NetSuite data using third-party tools such as Microsoft™ Excel, BIRST and Adaptive. For more information, see the help topic *SuiteAnalytics Connect*.

**Note:** If you do not see a link in the Settings portlet that you think you should have access to, contact your system administrator.

## Shortcuts Portlet

The Shortcuts portlet contains links that you can click for easy access to your most frequently used records, transactions, lists, and/or reports. These same links also appear as options on the shortcuts menu, the star icon on the navigation menu.

---

**Dashboards**
You can add, remove, and change the order of shortcut links in the Shortcuts portlet and shortcuts menu. You can also set up shortcuts to open linked pages in new windows. Any changes you make are applied to both the Shortcuts portlet and the shortcuts menu options.

For instructions on how to add the Shortcuts portlet to a page, see Adding a Portlet to a Dashboard.

**Important:** If you have added the Shortcuts portlet to more than one page, the portlet always maintains the same links on every page. Any changes you make to the Shortcuts portlet displayed on one page are applied automatically to the Shortcuts portlet displayed on any other page and to the menu options listed on the shortcuts menu.

### Adding Shortcut Links

You can use either of the following methods to add a link to the Shortcuts portlet and shortcuts menu. Go to the page where you want the shortcut link to go, and then from the More list, select Add to Shortcuts. Or go to the Shortcuts portlet itself, and click **New Shortcut**.

**To add a shortcut from the page where you want the shortcut to go:**

1. Click the star icon on the navigation menu and select **Add to Shortcuts**.
2. Edit name for the shortcut link. By default it is the name of the page.
3. If you want the linked page to open in a new window, check the **Open in New Window** box.
4. Click **Save**.

**To add a shortcut from the Shortcuts portlet:**

1. On the Shortcuts portlet, click **New Shortcut** on the portlet menu.
2. Enter a name for the shortcut link.
3. Enter the **URL** for the page. (If you do not know the page’s URL, go to the page and use **Add To Shortcuts** on the page instead.)
4. If you want the linked page to open in a new window, check the **Open in New Window** box.

5. Click **Save**.

### Setting Up Shortcut Links

In the Set Up Shortcuts popup window, you can remove, reorder, and rename shortcuts. You can also indicate that they should open in new windows.

#### To remove a shortcut:

1. Click **Set Up** in the Shortcuts portlet menu or the **Set Up Shortcuts** option on the shortcuts menu to open the Set Up Shortcuts popup window.

2. Clear the **Enable** box next to each shortcut that you want to remove.

   **Note:** Shortcuts that were created when a dashboard was published for you appear with asterisks. The publisher may have restricted these shortcuts so that you cannot remove them.

3. Click **Save**.

#### To reorder shortcut links:

1. Click **Set Up** in the Shortcuts portlet menu or the **Set Up Shortcuts** option on the shortcuts menu to open the Set Up Shortcuts popup window.

2. Click the shortcut row to select it. The selected row is highlighted and has a drag gripper, outlined in red below.

3. Drag the shortcut row where you want it or use the **Move to Top** or **Move to Bottom** buttons.
4. Click **Save**.

**To indicate that a shortcut’s linked page should open in a new window:**

1. Click **Set Up** in the Shortcuts portlet menu or the **Set Up Shortcuts** option on the shortcuts menu to open the Set Up Shortcuts popup window.
2. Check the **Open in New Window** box next to the shortcut name, and click **Save**.

**To rename a shortcut link:**

1. Click **Set Up** in the Shortcuts portlet menu or the **Set Up Shortcuts** option on the shortcuts menu to open the Set Up Shortcuts popup window.
2. Change the name in the **Label** field, and click **Save**.

**Note:** The Shortcuts portlet may contain duplicate links if your administrator has published a dashboard with links that match the custom links you have added. To eliminate duplicates, remove your own custom links.

---

**SMT Links Portlet**

The Site Management Tools Links portlet lets you see all your available websites and domains from your administrator account in NetSuite. When you choose a website from the dropdown menu, all available domains are displayed.

You have two options with each domain, **Preview**, denoted by the eye icon, or **Edit**, denoted by the edit icon.

When you click either icon, a new browser tab is opened and you are automatically logged into Site Management Tools for that domain.

**Note:** The Site Management Tools feature must be enabled in your NetSuite account.

---

**Site Management Tools Links**

<table>
<thead>
<tr>
<th>WEBSITE</th>
<th>ACTIONS</th>
<th>DOMAIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCASuite</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Preview" /></td>
<td>aconcagua.local/hostloopback.com</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Edit" /></td>
<td>kilimanjaro.local/hostloopback.com</td>
</tr>
</tbody>
</table>

---

**SuiteApp Portlets**

If you have a dashboard-compatible SuiteApp installed in your account, you can display this SuiteApp on your dashboard as a portlet.

To be available as a dashboard portlet, a SuiteApp must meet the following requirements:

- It must be installed in your account.
- It must include a dashboard component.
Note: SuiteApp portlets cannot be added to custom dashboards.

To add a SuiteApp portlet:

1. Click Personalize in the upper right corner of your dashboard or use Personalize Dashboard in the Settings portlet.
2. On the SuiteApps tab of the Personalize Dashboard palette, click the SuiteApp you want to add or drag it onto the dashboard.

You can add up to six SuiteApp portlets to your dashboard.

For more information about SuiteApp portlets, see the help topic Displaying SuiteApps on Your Dashboard.

Tasks Portlet

If you want to show a list of Tasks on your dashboard, you can add a Tasks portlet from the Personalize Dashboard palette.

You can view tasks using the Dashboard view or the Basic view. Basic view enables you to filter tasks by status and priority as well as view tasks assigned to other users by choosing the assignee from the Assigned To list.

You can also sort tasks by: In Order, Due Date, Recently Created, Recently Modified, or Recently Viewed.

Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon \( \Rightarrow \). The full-screen view of the portlet displays more columns and rows in the search results.

Trend Graph Portlets

Trend graphs show the differences in Key Performance Indicators (KPIs) data over time. You can add up to five Trend Graph portlets to your dashboard.

To add a Trend Graph portlet to your dashboard:

1. Click Personalize in the upper right corner of your dashboard or use Personalize Dashboard in the Settings portlet.
2. On the Standard Content tab of the Personalize Dashboard palette, click the Trend Graph icon or drag it onto the dashboard.
3. Click Set Up in the portlet or in the portlet menu and use the KPI list to select the KPI to be used for this trend graph. You can select up to three.
You can expand the portlet to full-screen view by clicking the double arrow icon.

To learn more about trend graphs and displaying them on your dashboard, see Trend Graphs.

Printing and Exporting Dashboard Content

You can print or export content from some dashboard portlets. These options are usually in the same menu as the Set Up option in the portlets where they are available. The following table lists the portlets that support these options.

<table>
<thead>
<tr>
<th>Portlet Type</th>
<th>Supported Print/Export Options</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>KPI Meter</td>
<td>■ Print the chart</td>
<td>Available from portlet menu.</td>
</tr>
<tr>
<td></td>
<td>■ Download PNG image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download JPG image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download PDF document</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download SVG vector image</td>
<td></td>
</tr>
<tr>
<td>KPI Scorecard</td>
<td>■ Export (data to CSV file)</td>
<td>Available from portlet menu.</td>
</tr>
<tr>
<td>Report Snapshot</td>
<td>■ Print the chart</td>
<td>Available from portlet menu.</td>
</tr>
<tr>
<td></td>
<td>■ Download PNG image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download JPG image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download PDF document</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download SVG vector image</td>
<td></td>
</tr>
<tr>
<td>Trend Graph Portlet</td>
<td>■ Export (data to CSV file)</td>
<td>Available from portlet menu.</td>
</tr>
<tr>
<td></td>
<td>■ Print the chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download PNG image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download JPG image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download PDF document</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download SVG vector image</td>
<td></td>
</tr>
<tr>
<td>Trend Graph Pop-Up Window</td>
<td>■ Export (data to CSV file)</td>
<td>The Trend Graph pop-up window is available on some portlets, including KPI Scorecard and Key Performance Indicators portlets.</td>
</tr>
<tr>
<td></td>
<td>■ Print the chart</td>
<td>Export link is available from the Trend Graph window.</td>
</tr>
<tr>
<td></td>
<td>■ Download PNG image</td>
<td>Print and download options are available from the Trend Graph window menu.</td>
</tr>
<tr>
<td></td>
<td>■ Download JPG image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download PDF document</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Download SVG vector image</td>
<td></td>
</tr>
</tbody>
</table>

Customer Dashboards

NetSuite includes a specialized dashboard that is available for every customer (including leads and prospects) in your system. The customer dashboard provides at-a-glance access to key customer’s data,
so you do not need to search through multiple screens to gather and piece together the information you need.

To open a dashboard for a customer, you can:

- Click the View Dashboard icon on a Customer record or on a row in a customer list:

![Customer Dashboard Icon](image)

- Enter `dash:customer_name` in the Global Search field at the top of the NetSuite page.

### Setting the Customer Dashboard as Default View

If you prefer to look at all customer records using the dashboard view, you can set the preference to make this the default view whenever you open a customer record. To do this, go to Home > Set Preferences > Appearance > Set Customer Dashboard as Default View on Customer Record.

By default, a customer dashboard includes a Key Performance Indicators portlet displaying important summary data for the customer, a Dashboard Links portlet with links to reports related to the customer, and a list portlet displaying the customer's transactions, as well as other portlets. You can personalize customer dashboard portlets' content and setup.

- Choose Set Up from the portlet menu to modify the portlet's configuration. For more information, see Setting Up Dashboard Portlet Content and Setting Up the Key Performance Indicators Portlet.

- To add portlets, see Adding a Portlet to a Dashboard.

  You can add a custom portlet that displays results from a SuiteScript, such as custom lists, data entry forms, or free-form HTML. To ensure that the custom portlet provides data for the selected customer, pass the customer's entity ID to the SuiteScript function. See the help topics Portlet Scripts, Portlet Script Execution, and Displaying Portlet Scripts on the Dashboard.

A customer dashboard includes information about all transactions and activities for the customer's related projects and subcustomers. The customer dashboard’s Transactions portlet data is consistent with the customer record’s Transactions subtab data, and the customer dashboard’s Key Performance Indicators portlet data is consistent with the customer record’s Financial subtab data. The Tasks portlet shows a list of CRM tasks related to the customer record. You can also use the Tasks portlet to create
tasks for the customer. Tasks that are displayed here are only those that are created using the New Task menu of this portlet. You can find other tasks related to the customer record in the Activities portlet of the customer dashboard. For more information, see Tasks Portlet.

Note that the setting for the Accept Payments Through Top-Level Customer preference affects the rollup of data for some customer dashboard KPIs, in the same manner that it affects the customer record’s Financial tab data. For more information about this preference, see the help topic Consolidated Payments.
Key Performance Indicators Overview

Key Performance Indicators, or KPIs, synthesize your raw data into critical business metrics that you can see right on your dashboard in the formats you choose. KPIs enable you to spend more time learning from and acting on important data and less time gathering it. NetSuite includes over 75 prepackaged KPIs based on NetSuite standard reports, including summaries of forecast, pipeline, orders, cases, and financial data. You also can create custom KPIs, based on custom saved searches.

NetSuite provides the following types of dashboard portlets where you can display key performance indicators:

- **Key Performance Indicators portlet.** This portlet displays a summary line for each selected KPI, with clickable links that drill down into each KPI's underlying data source. The KPI portlet also enables you to see the KPIs you consider more relevant as headlines.
  - For information about adding a Key Performance Indicators portlet to a dashboard, and choosing KPIs and layout options for the portlet, see Setting Up the Key Performance Indicators Portlet.
  - For a list of the standard KPIs available from NetSuite, see Standard Key Performance Indicators Table.
  - For a summary of what you can see in the Key Performance Indicators portlet, see Viewing Key Performance Indicator Data.
  - For tips on displaying your own KPIs, see Custom KPIs.

- **KPI Meter portlet.** This portlet displays a visual representation of KPI data, a semi-circular meter providing comparison, date range, and threshold values at a glance. For more information, see KPI Meters.

- **Trend Graph portlet.** This portlet displays the differences in data over selected time intervals for multiple KPIs in a single chart. You can display up to three KPIs in a chart. This chart type can be Area, Line, Bar, or Column. Comparisons can be shown in continuous or side-by-side manner. Popup trend graphs also are available from clickable icons in the Key Performance Indicators portlet and the KPI Scorecard portlet. For information, see Trend Graphs.

- **KPI Scorecard portlet.** This portlet displays a performance scorecard that can include complex comparisons among multiple KPIs over multiple date ranges or accounting periods. Scorecards also can include Excel-like formulas with KPIs and functions in their expressions. For information, see KPI Scorecards Overview.

KPIs are role-based and feature-based, meaning the KPIs that you can choose to display depend upon the role you used to log in to NetSuite and the features that are enabled.

Setting Up the Key Performance Indicators Portlet

If you want to display KPI data on a dashboard, the first step is to add the Key Performance Indicators portlet to the page if it is not already there.

When the Key Performance Indicators portlet appears on a page, you can click **Set Up** and define its content and layout in the Set Up Key Performance Indicators popup window. You can add up to eight KPIs as headlines.
Setting Up the Key Performance Indicators Portlet

The KPIs that are available to you in the Set Up Key Performance Indicators popup window depend upon the role you used to log in to NetSuite and the features that are enabled.

For more information, see the following:

- Adding the Key Performance Indicators Portlet
- Making Changes to the Key Performance Indicators Portlet
- Choosing KPIs and Setting Layout Options

Adding the Key Performance Indicators Portlet

To add the Key Performance Indicators portlet:

1. Click Personalize Dashboard.
2. Click or drag and drop the Key Performance Indicators item.

The portlet appears on the page, displaying default or previously selected KPI data.

Making Changes to the Key Performance Indicators Portlet

You can make the following changes to the Key Performance Indicators portlet:

- You can select the standard and/or custom KPIs that appear in the portlet.
- You can select the period of time for which you want KPI data to be synthesized.
- You can choose to display comparisons of KPI data across different time periods, with percentage changes calculated automatically.
- You can choose to highlight displayed KPI data that exceeds or falls short of a threshold that you define.
- You can set some KPI data to appear in the portlet header.
- You can determine the order in which KPIs appear in the portlet.
- For KPIs that provide time-based comparisons of data, you can define layout options for the popup trend graphs that are available from Trend Graph icons or by clicking the KPIs in the header.
- You may be able to choose whether to display data for all employees or employees in your team.

Choosing KPIs and Setting Layout Options

To define KPIs and layout options for the Key Performance Indicators portlet:

1. In the Key Performance Indicators portlet, click Set Up to open the Set Up Key Performance Indicators popup.
2. To select standard KPIs for display in the portlet, click Add Standard KPIs to open the Choose Standard Key Performance Indicators dialog.
Click a KPI in the left list to move it to the right list, which indicates that it should be displayed.

Click **Done** after you have finished selecting KPIs to display.

Selected standard KPIs are listed with question mark icons. Click these icons for KPI descriptions. For a complete list of standard KPIs and their descriptions, see **Standard Key Performance Indicators Table**.

3. To select saved searches to display as custom KPIs, click **Add Custom KPIs** to open the Choose Custom Key Performance Indicators dialog.
   - Click a saved search in the left list to move it to the right list, which indicates that it should be displayed as a custom KPI.
   - You can choose up to 10 custom KPIs.
   - Click **Done** when you have finished selecting KPIs for display.
   - Selected custom KPIs are listed with “c” icons. Click an icon for a brief general description of custom KPIs. For more details, see **Custom KPIs**.

4. For each selected KPI, in the **Range** list, select the date or period range for which data should be included.

5. For each selected KPI, if an **Employees** list is available, select one of the following:
   - **All** – Includes KPI data for all employees in your organization.
   - **Only Mine** – Includes data only from employees in your group in a selected KPI.
   - **My Team’s** – Includes only KPI data that is relevant to employees in your team.

6. For each selected KPI, in the **Highlight If** list, select **greater than** or **less than** if you want to highlight data that exceeds or falls short of a defined threshold. If you do not want highlighting for this KPI, leave the list blank.
   - If you have made a selection from the **Highlight If** list, specify the threshold number in the **Threshold** column.
   - If you want the selected KPI data to be highlighted in the portlet's header, select the check box in the **Headline** column.

7. For each selected KPI, in the **Compare** column, check the box if you want to compare results from the time period defined in the **Range** list with results from another period defined in the **Compare Range** list.

8. For each selected KPI, in the **Compare Range** list, if you checked the **Compare** box, select the date or period range for which data should be compared with data from the first range. If you did not check the **Compare** box, you do not need to make a selection here.

9. You can remove a selected KPI from the Key Performance Indicators portlet by clicking its **x** button at far right. Click **Remove All** button to remove all selected KPIs.

10. You can change the order in which KPIs appear in the Key Performance Indicators portlet by using the **Move To Top** and **Move To Bottom** buttons or by dragging and dropping individual KPIs.
    - To drag and drop a KPI, click it and hold down the mouse button until you see the crossed arrows and the KPI is highlighted gray. Continue holding down the mouse button, moving the pointer to the location where you want the KPI to appear. Then release the mouse button.
    - To use one of the **Move** buttons, select a KPI by clicking on it and holding down the mouse button until you see the crossed arrows and the KPI is highlighted gray. Then click either of the **Move** buttons.

11. To change display options for KPIs' popup trend graphs, click the **Popup Trend Graphs** subtab. Check or clear the **Show Moving Average**, **Show Last Data Point on Pop-Up Trend Graphs**, or **Include Zero on Y-Axis** boxes. You also can set the chart theme and background for all popup trend graphs, as well as default chart type and time increment. For information about these options, see **Setting Up Popup Trend Graphs**.
12. If you do not want the portlet content to be refreshed automatically when you log in to NetSuite, select the **Cached Data** option.

   This option also adds a time indicator that appears when you point to the portlet title, so you can see when the portlet was last updated.

13. Click **Save**.

You can now review the data displayed in the Key Performance Indicators portlet. To make further changes, click **Set Up** and redo the steps above as needed. For tips about what you can do in the portlet, see **Viewing Key Performance Indicator Data**.

**Viewing Key Performance Indicator Data**

After you have added a Key Performance Indicators portlet to a dashboard and set up the KPIs on the Set Up Key Performance Indicators page, you can perform the following functions from within the portlet or on the dashboard.

**View comparisons of data from different periods:**

If you have defined time ranges for comparisons in the Set Up Key Performance Indicators page, you can view percentage changes for KPIs. An arrow indicates the direction of each change, and positive changes appear in green, whereas negative changes appear in red. For instructions for setting up comparisons, see **Setting Up KPI Comparisons**.

**View highlighted data:**

If you have defined goal amounts as thresholds for KPIs in the Set Up Key Performance Indicators page, you may notice that some KPIs appear in bold text with red flags because they have either exceeded or fallen short of goals. For more information, see **Highlighting KPIs**.

**Drill down to underlying data:**

Each standard KPI’s data is based on a snapshot of a NetSuite report. Each custom KPI’s data is based on a saved search. The Key Performance Indicators portlet provides multiple links for each KPI that you can click to open its underlying report or saved search. You can find one of these links by moving your cursor over a KPI and clicking when you see a pointing hand and underlined text.
Note: For KPIs based on financial and sales reports, totals are always rounded to the nearest whole number currency amount. You can drill down to the report to view the exact totals for that report.

View trend graphs:

For any KPI that includes a time-based comparison, you can click its Trend Graph icon to open a popup trend graph for that KPI. You can change the time period graphed by clicking options in the graph’s popup window or change the graph’s layout options in the Set Up Key Performance Indicators popup. For more information, see Trend Graphs.

Move the Key Performance Indicators portlet:

You can drag and drop the Key Performance Indicators portlet to move it to a different place on the dashboard.

If you place the KPI portlet in a narrow column, the individual Refresh icons are not available due to the compact format of the narrow column. However, you can collapse and expand the list of KPIs as needed, and you can also see the KPIs displayed as headlines. Note that trend graphs are not displayed for KPI headlines. To view the popup trend graph, click the Trend Graph icon next to a KPI in the list of KPIs, if available. This option is enabled by default. For a fuller display with these options, move the portlet to the wide column.

Minimize the Key Performance Indicators portlet:

You can minimize the Key Performance Indicators portlet so that its data is not loaded immediately when a page opens, avoiding a lot of waiting for slow-loading KPI data. To minimize the portlet, click its title bar. When the page is loaded, you can click the portlet’s title bar again to display KPI data as needed.

Change KPI data setup:

You can click Set Up in the portlet menu at any time to open the Set Up Key Performance Indicators popup and change the contents and layout of the portlet.

Setting Up KPI Comparisons

A variety of date ranges is available for KPI comparisons. Many additional date ranges and period ranges are available for comparisons in KPI scorecards. See Date Ranges for KPI Scorecards and Period Ranges for KPI Scorecards.

To set up KPI comparisons:

1. Click Set Up in your Key Performance Indicators portlet’s menu.
2. In the Set Up Key Performance Indicators popup, if the KPI is not displayed, click Add Standard KPIs or Add Custom KPIs, select the KPI, and click Done.
3. In the Range column for the KPI, choose the first period of time for which data should be included in the KPI.
4. Check the box in the Compare column.
5. In the Compare Range column, choose the second time period for which data should be included in the KPI (and compared with the first period's data).
6. Repeat steps 2 through 5 for each indicator that you want to include a comparison.
7. Click Save.

After these setup steps, the KPI in your Key Performance Indicators Portlet now displays columns for the current period's metric, the previous period's metric, and the percentage change.

If you have set up a comparison for custom KPI and results are not displaying properly, the saved search on which the custom KPI is based may not satisfy related requirements. The saved search definition must:

- Not include any date fields defined as filters on the Criteria subtab
- Have only one field with a summary type (such as group, sum, or count) defined on the Results subtab.
- Have a date field defined as an available filter on the Available Filters subtab.

For more information, see Custom KPIs.

Highlighting KPIs

You can call out specific KPIs when they are above or below your goals, to more quickly notice and manage business issues.

For example, Alexa Wolfe's goal this month is to have sales over $40,000. If her company reaches this goal, she wants to reward her team with dinner. To see this information in her KPI portlet, Wolfe chooses to highlight her Sales indicator when it is over $40,000.

To call out KPIs, you can define goal amounts as thresholds in the Set Up Key Performance Indicators popup. Then, if the KPI amount is greater than or less than the defined threshold amount, the KPI is highlighted in the Key Performance Indicators portlet, by appearing in bold text with a red flag. You also can indicate that a highlighted KPI can be displayed as a headline for the Key Performance Indicators portlet, meaning it is displayed at the top of the portlet in large, bold text.

To highlight KPIs:

1. Click Set Up in your Key Performance Indicators portlet.
2. In the Set Up Key Performance Indicators popup, if the KPI is not displayed, click Add Standard KPIs or Add Custom KPIs, select the KPI, and click Done.
3. In the Range column for the KPI, select the date or period range you want to report on for this metric.
4. In the Highlight If column, choose to call out this indicator if it is greater than or less than a threshold you set.
5. In the Threshold column, enter the threshold this indicator must exceed or fall below to be highlighted.
6. In the Headline column, check the box if you want this KPI to be displayed as a headline at the top of the Key Performance Indicators portlet in large, bold text.
7. Repeat the preceding steps for each indicator you want to highlight.
8. Click Save.
After these setup steps, a KPI that either exceeds or falls short of its defined threshold value displays in bold text. If the Headline box is checked, the KPI is also displayed as a headline for the Key Performance Indicators portlet.

**Note:** Up to eight KPIs can be displayed as headlines.

### Standard Key Performance Indicators Table

Depending on your role and your account’s enabled features, some or all of the following table’s KPIs are available for display in the Key Performance Indicators portlet. If you see a KPI in the table that is not available to you in NetSuite and that you would like to display, check with your administrator to see if the related feature can be enabled, or if you can use another role to log in to NetSuite.

The table lists KPIs in alphabetical order.

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorized Commission</td>
<td>This indicator shows the total outstanding commission amount that has been authorized but not paid, as of the selected date range. Click this KPI's period or total to open the Authorized Commission Summary Report.</td>
</tr>
<tr>
<td>Authorized Partner Commission</td>
<td>This indicator shows the total outstanding commission amount that has been authorized but not paid to partners, as of the selected date range. Click this KPI's period or total to open the Authorized Partner Commission Summary Report.</td>
</tr>
<tr>
<td>Average Days to Pay</td>
<td>(Available on the Customer Dashboard only) This indicator shows the customer’s average number of days between invoice date and the payment date for the selected period(s). Click this KPI’s periods or totals to open the A/R Aging Detail Report.</td>
</tr>
<tr>
<td>Average Days Overdue</td>
<td>(Available on the Customer Dashboard only) This indicator shows the average number of days that the customer had an overdue balance for the selected period(s). The formula for this KPI is the average number of days that invoices are overdue, weighted by the amount of the invoices. For example, if the time now is 3:00:10pm: an invoice for $100 open for 5 days and a second invoice for $200 open for 10 days, the KPI shows ((5<em>54010/86400) + (10</em>54010/86400)*200/300 = 8.9584490740740740740740740740741). The 54010 is the number of seconds since midnight.</td>
</tr>
<tr>
<td>KPI</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Balance</td>
<td>(Available on the Customer Dashboard only) This indicator shows the current dollar amount owed by the customer.</td>
</tr>
<tr>
<td></td>
<td>Click this KPI’s periods or totals to open the <em>A/R Aging Detail Report</em>.</td>
</tr>
<tr>
<td>Bank Balance</td>
<td>This indicator shows the total impact on bank accounts, as of the selected period(s).</td>
</tr>
<tr>
<td></td>
<td>(May display as Total Bank Balance) Click this KPI’s periods or totals to open either the Balance Sheet Report or the Bank Register Report. (Your account setup determines which report is the basis for this KPI. Click the Support by Phone button to understand your account settings.)</td>
</tr>
<tr>
<td>Cart Abandonment</td>
<td>This indicator shows the percentage difference between the number of Web store shopping carts filled and the number of orders actually placed during the selected date range.</td>
</tr>
<tr>
<td></td>
<td>Click this KPI’s periods or totals to open the Shopping Cart Abandonment Report.</td>
</tr>
<tr>
<td>Cases Closed</td>
<td>This indicator shows the number of cases closed during the selected date range(s).</td>
</tr>
<tr>
<td></td>
<td>Click this KPI’s periods or totals to open the Closed Cases Snapshot report.</td>
</tr>
<tr>
<td>Cases Escalated</td>
<td>This indicator shows the number of cases that have been escalated within the selected date range(s).</td>
</tr>
<tr>
<td></td>
<td>Click this KPI’s periods or totals to open the Open Case Escalation Summary Report report.</td>
</tr>
<tr>
<td>Checkout Abandonment</td>
<td>This indicator shows the percentage of web store checkouts that were started but not completed during the selected date range(s). This calculation divides the total number of times the checkout process was started by the number of successfully completed checkouts.</td>
</tr>
<tr>
<td></td>
<td>Click this KPI’s periods or percentage totals to open the Shopping Cart Abandonment Report.</td>
</tr>
<tr>
<td>Closed Issues</td>
<td>This indicator shows the number of issues that have been closed within the selected date range(s).</td>
</tr>
<tr>
<td></td>
<td>Click this KPI’s periods or totals to open the Closed Issues Summary Report report.</td>
</tr>
<tr>
<td>COGS</td>
<td>This indicator shows the dollar value of the cost of goods sold in transactions during the selected period(s).</td>
</tr>
<tr>
<td></td>
<td>Click this KPI’s periods or totals to open the Income Statement Report.</td>
</tr>
<tr>
<td>Consolidated Average Days Overdue</td>
<td>(Available on the Customer Dashboard only, when the Consolidated Payments feature is enabled.) This indicator shows the average number of days that the customer and its subcustomers had an overdue balance for the selected period(s).</td>
</tr>
<tr>
<td></td>
<td>Click this KPI’s periods or totals to open the A/R Aging Detail Report.</td>
</tr>
<tr>
<td>Consolidated Balance</td>
<td>(Available on the Customer Dashboard only, when the Consolidated Payments feature is enabled.) This indicator shows the current dollar amount owed by the customer and its subcustomers.</td>
</tr>
<tr>
<td></td>
<td>Click this KPI’s periods or totals to open the A/R Aging Detail Report.</td>
</tr>
<tr>
<td>Consolidated Days Overdue</td>
<td>(Available on the Customer Dashboard only, when the Consolidated Payments feature is enabled.) This indicator shows the current number of days that the customer and its subcustomers have had an overdue balance.</td>
</tr>
<tr>
<td></td>
<td>Click this KPI’s period or total to open the A/R Aging Detail Report.</td>
</tr>
</tbody>
</table>

**Dashboards**
## KPI Description

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consolidated Overdue Balance</td>
<td>(Available on the Customer Dashboard only, when the Consolidated Payments feature is enabled.) This indicator shows the amount of the current overdue balance for the customer and its subcustomers. Click <strong>Current</strong> or total to open the A/R Aging Detail Report.</td>
</tr>
<tr>
<td>Consolidated Unbilled Orders</td>
<td>(Available on the Customer Dashboard only, when the Consolidated Payments feature is enabled.) This indicator shows the total amount of orders for the customer and its subcustomers that have been placed but not billed for the selected period(s). Click this KPI's periods or totals to open the Open Sales Orders Report.</td>
</tr>
<tr>
<td>Credit Card Balance</td>
<td>This indicator shows the total impact on credit card accounts during the selected period(s). Click this KPI's periods or totals to open the Trial Balance Report.</td>
</tr>
<tr>
<td>Custom KPIs</td>
<td>Each of these indicators shows a total or count based on the results of a saved search. You add a custom KPI by selecting the saved search for which you want to display results. You can define up to 10 custom KPIs to display in the portlet. Click a custom KPI's periods or totals to open its underlying saved search results.</td>
</tr>
<tr>
<td>Days Overdue</td>
<td>(Available on the Customer Dashboard only) This indicator shows the current number of days that the customer has had an overdue balance. Click this KPI's period or total to open the A/R Aging Detail Report.</td>
</tr>
<tr>
<td>Deferred Revenue</td>
<td>This indicator shows the total credits and debits to deferred revenue accounts during the selected period. Click this KPI's periods or totals to open the Balance Sheet Report.</td>
</tr>
<tr>
<td>Employees</td>
<td>This indicator shows the number of active employees included in payroll with a hire date in the past and no release date, as of the selected date range(s). Click this KPI's periods or totals to open search results of employees that meet the above conditions. Note: This KPI is intended to list employees from a payroll point of view, so its results may differ from the complete list of employees shown at Lists &gt; Employees &gt; Employees.</td>
</tr>
<tr>
<td>Equity</td>
<td>This indicator shows the dollar value of assets less liabilities for the selected period(s). Click this KPI's periods or totals to open the Balance Sheet Report.</td>
</tr>
<tr>
<td>Estimated Commission</td>
<td>This indicator shows the total value of estimated commissions for all transactions in the selected date range(s). Only commissions earned by you and your subordinates appear in this indicator. Click this KPI's periods or totals to view the Estimated Commission Summary Report. See also Commission Overview Report.</td>
</tr>
<tr>
<td>Estimated Partner Commission</td>
<td>This indicator shows the total estimated value of commissions earned by partners for transactions during the selected date range(s). Click this KPI's periods or totals to open the Estimated Partner Commission Summary Report. See also Commission Overview Report.</td>
</tr>
<tr>
<td>Expenses</td>
<td>This indicator shows the total debits to income and expense accounts during the selected period(s).</td>
</tr>
<tr>
<td>KPI</td>
<td>Description</td>
</tr>
<tr>
<td>-----</td>
<td>-------------</td>
</tr>
<tr>
<td>Click this KPI's periods or totals to open the <strong>Income Statement Report</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Fixed Assets</strong></td>
<td>This indicator shows the total dollar value of fixed assets, meaning durable property or equipment that will not be used up or converted to cash within a year, for the selected period(s). Click this KPI's periods or totals to open the <strong>Trial Balance Report</strong>.</td>
</tr>
</tbody>
</table>
| **Forecast**  
(This KPI is labeled Forecast (Billings) on the Customer Dashboard.) | This indicator shows total sales within the selected date range(s), including the following transactions:  
- Total income and reimbursed expenses from customers  
- Total value of open estimates that are set to be included in the forecast and are expected to close in the selected date range(s)  
- Total value of open opportunities that are expected to close in the selected date range(s) and do not include an estimate that is set to appear in the forecast.  

**Note:** The values of estimates and opportunities included in forecasts depend on the preferences defined at Setup > Sales > Preferences > Sales Preferences, Forecasts subtab.  
This KPI can display a comparison of two different date ranges if you have enabled the Historical Metrics feature. The check box for this feature is available under Setup > Company > Setup Tasks > Enable Features, in the Sales section of the CRM subtab. Click this KPI's periods or totals to open the **Billings Forecast vs. Quota Report**. |
| **Forecast (Alt. Sales)** | This indicator shows the total sales forecast, based on alternate sales amounts (ASA), for the selected date range(s). Click this KPI's periods or totals to open the **Alt. Sales Forecast vs. Quota Report**.  

**Note:** When The ASA feature is enabled, sales reps can track two different forecasts, one based on billings, and one based on ASA. |
<p>| <strong>Forecast Override</strong> | This indicator shows the total amount of sales your reps expect to bring in during the selected date range(s). The forecast amount shown is the sum of the forecast overrides for reps whose supervisors have not entered forecast overrides. Click this KPI's periods or totals to open the <strong>Billings Forecast vs. Quota Report</strong>. |
| <strong>Forecast Override (Alt. Sales)</strong> | This indicator shows the total sales forecast for the selected date range(s), based on the ASA override forecast amounts (ASA). The override forecast reflects the ASA amount that sales reps predict they will earn for the period. Sales managers can enter forecast override amounts to account for deals that have not yet been entered as transactions, adjusting the forecast amounts of sales reps based on reps’ previous success at predicting their sales. Click this KPI's periods or totals to open the <strong>Alt. Sales Forecast vs. Quota Report</strong>. |
| <strong>Gross New Leads</strong> | This indicator shows the total number of lead records created during the selected date range(s). Click this KPI's periods or totals to open the <strong>Gross Lead Source Analysis Detail Report</strong>. This report differs from the Lead Source Analysis Detail Report because it includes all leads, rather |</p>
<table>
<thead>
<tr>
<th><strong>KPI</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hosted Page Hits</strong></td>
<td>This indicator shows the number of pages your hosted website has displayed during the selected date range(s). Click this KPI's periods or totals to open the Hosted Page Hits Report.</td>
</tr>
<tr>
<td><strong>Income</strong></td>
<td>This indicator shows the total credits to income, other income, and expense accounts during the selected period(s). Click this KPI's periods or totals to open the Income Statement Report.</td>
</tr>
<tr>
<td><strong>Inventory</strong></td>
<td>This indicator shows the balance of the Inventory asset account and any Other Current Asset account for which you checked the Inventory box on the account record, for the selected date range(s). Click this KPI's periods or totals to open the Inventory Valuation Report.</td>
</tr>
<tr>
<td><strong>Long Term Liabilities</strong></td>
<td>This indicator shows the total dollar value of long term liabilities, meaning debts payable over more than one year, for the selected period(s). Click this KPI's periods or totals to open the Trial Balance Report.</td>
</tr>
<tr>
<td><strong>My Utilization</strong></td>
<td>This indicator displays a user's utilization.</td>
</tr>
<tr>
<td><strong>Net Cash Flow</strong></td>
<td>This indicator shows the overall change in cash position during the selected period(s). Click this KPI's periods or totals to open the Cash Flow Statement Report. <strong>Important:</strong> If your Cash Flow Statement has been customized, the KPI amount may differ from the amount shown on the report.</td>
</tr>
<tr>
<td><strong>New Business</strong></td>
<td>This indicator shows the total of all sales transactions during the selected period(s) for customers with first sales occurring in the period(s). For this period-based analysis, orders must be actual. Click this KPI's periods or totals to open the New Customer Sales Summary Report.</td>
</tr>
<tr>
<td><strong>New Business (Orders Alt. Sales)</strong></td>
<td>This indicator shows the dollar value of sales generated through sales orders by new customers, based on alternate sales amounts (ASA), during the selected period(s). Click this KPI's periods or totals to open the New Customer Sales Orders Summary Report.</td>
</tr>
<tr>
<td><strong>New Business (Sales Orders)</strong></td>
<td>This indicator shows the amount of sales generated through sales orders by new customers during the selected period(s). Click this KPI's periods or totals to open the New Customer Sales Orders Summary Report.</td>
</tr>
<tr>
<td><strong>New Cases</strong></td>
<td>This indicator shows the number of new cases created during the selected date range(s). Click this KPI's periods or totals to open the New Cases Snapshot report.</td>
</tr>
<tr>
<td><strong>New Customers</strong></td>
<td>This indicator shows the number of customers whose first sales transactions closed in the selected period(s). For this period-based analysis, transactions must be actual. Click this KPI's periods or totals to open the New Customer Sales Summary Report.</td>
</tr>
<tr>
<td><strong>New Customers (Sales Orders)</strong></td>
<td>This indicator shows the number of sales orders generated by customers with first sales transactions closing in the selected period(s). Click this KPI's periods or totals to open the New Customer Sales Orders Summary Report.</td>
</tr>
<tr>
<td><strong>New Issues</strong></td>
<td>This indicator shows the total number of issues created within the selected date range(s).</td>
</tr>
</tbody>
</table>
## Setting Up the Key Performance Indicators Portlet

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Leads</td>
<td>Click this KPI’s periods or totals to open the New Issues Report. This indicator shows the total number of lead records created during the selected date range(s). Click this KPI’s periods or totals to open the Lead Source Analysis Summary Report.</td>
</tr>
<tr>
<td>New Opportunities</td>
<td>Click this KPI’s periods or totals to open results of an opportunity search filtered for the selected date range. This indicator shows the total number of new opportunities created during the selected date range(s).</td>
</tr>
<tr>
<td>New Visitors</td>
<td>Click this KPI’s periods or totals to open the New Visitor Report. This indicator shows the total number of first-time visitors your website has received during the selected date range(s).</td>
</tr>
<tr>
<td>Open Cases</td>
<td>Click this KPI’s periods or totals to open the Open Cases Snapshot report. This indicator shows the number of open cases as of the selected date(s).</td>
</tr>
<tr>
<td>Open Estimates</td>
<td>Click this KPI’s periods or totals to open the Estimates to Close Report. This indicator shows the number of estimates that were open during the selected date range(s). Open estimates have a probability between 0% and 100%, and have not expired, been voided or have not been closed by an order or actual.</td>
</tr>
<tr>
<td>Open Issues</td>
<td>Click this KPI’s periods or totals to open the Open Issues Summary Report report. This indicator shows the number of issues with a base status other than Closed as of the selected date(s).</td>
</tr>
<tr>
<td>Open Opportunities</td>
<td>Click this KPI’s periods or totals to open the Opportunities to Close Detail Report. This indicator shows the number of open opportunities expected to close within the selected date range(s). Open opportunities have probabilities between 0 and 100%, and have not been converted to sales.</td>
</tr>
<tr>
<td>Open Projects</td>
<td>Click Current or total to open the Projects list filtered to show only open projects. This indicator shows the current number of open projects.</td>
</tr>
<tr>
<td>Open Prospects</td>
<td>Click this KPI’s periods or totals to open the Open Prospects Snapshot report. This indicator shows the number of open prospects as of the selected date(s).</td>
</tr>
<tr>
<td>Open Quotes</td>
<td>Click this KPI to see the Quotes to Close report. For more information about quotes, see the help topic Quotes. This indicator shows the number of open quotes for the selected period.</td>
</tr>
<tr>
<td>Operating Cash Flow</td>
<td>Click this KPI’s periods or totals to open the Cash Flow Statement Report. This indicator shows the change in cash position, excluding financing and investment activities, during the selected period(s).</td>
</tr>
<tr>
<td>Operating Expenses</td>
<td>Click this KPI’s periods or totals to open the Income Statement Report. This indicator shows the dollar value of operating expenses during the selected period(s).</td>
</tr>
</tbody>
</table>

**Important:** If your Cash Flow Statement has been customized, the KPI amount may differ from the amount shown on the report.

---

Dashboards
<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opportunities Lost</td>
<td>This indicator shows the number of opportunities marked lost in the selected date range(s). Lost opportunities have probabilities of 0%. Click this KPI's periods or totals to open the Opportunities Lost Report.</td>
</tr>
<tr>
<td>Opportunities Won</td>
<td>This indicator shows the number of opportunities that were won in the selected date range(s). This number includes opportunities converted to sales transactions and those with probabilities set to 100%. Click this KPI's periods or totals to open the Opportunities Won Report.</td>
</tr>
<tr>
<td>Orders</td>
<td>This indicator shows the number of approved sales orders placed in the selected date range. Click this KPI's periods or totals to open the Sales Orders by Customer Summary Report.</td>
</tr>
<tr>
<td>Other Assets</td>
<td>This indicator shows the total dollar value of assets other than current assets and fixed assets, for the selected period(s). Click this KPI's periods or totals to open the Trial Balance Report.</td>
</tr>
<tr>
<td>Other Current Assets</td>
<td>This indicator shows the total dollar value of other current assets, meaning owned assets that are expected to be converted to cash within one year, for the selected period(s). Click this KPI's periods or totals to open the Trial Balance Report.</td>
</tr>
<tr>
<td>Other Current Liabilities</td>
<td>This indicator shows the total dollar value of other current liabilities, meaning debts payable within one year, for the selected period(s). Click this KPI's periods or totals to open the Trial Balance Report.</td>
</tr>
<tr>
<td>Overdue Balance</td>
<td>(Available on the Customer Dashboard only) This indicator shows the amount of the customer's current overdue balance. Click Current or total to open the A/R Aging Detail Report.</td>
</tr>
<tr>
<td>Paid Commission</td>
<td>This indicator shows the total amount of commissions paid to employees during the selected period(s). Click this KPI's periods or totals to open the Paid Employee Commission Summary Report.</td>
</tr>
<tr>
<td>Paid Partner Commission</td>
<td>This indicator shows the total amount of commissions paid to partners during the selected period(s). Click this KPI's periods or totals to open the Paid Partner Commission Summary Report.</td>
</tr>
<tr>
<td>Payables</td>
<td>This indicator shows the total impact on A/P accounts during the selected period(s). Click this KPI's periods or totals to open the A/P Aging Summary Report.</td>
</tr>
</tbody>
</table>

**Note:** This KPI assumes that vendor payments use the same class and department. If linked transactions use different classes and departments, the KPI may display incorrect balances.

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll</td>
<td>This indicator shows the total earnings amount from paychecks or year-to-date adjustments within the selected period(s). Click this KPI's periods or totals to open the Payroll Summary Report.</td>
</tr>
<tr>
<td>Pipeline (Alt. Sales Projected)</td>
<td>This indicator shows the projected dollar value of open opportunities and open estimates, based on alternate sales amounts (ASA), expected to close within the selected date range(s). This summed value excludes the value of opportunities with estimates set to be included in the forecast.</td>
</tr>
</tbody>
</table>
## KPI Description

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pipeline (Alt. Sales Weighted)</strong></td>
<td>This indicator shows the weighted dollar value of open opportunities and open estimates, based on alternate sales amounts (ASA), expected to close within the selected date range(s). The weighted value is calculated by multiplying probability by projected total. This value excludes the value of opportunities with estimates set to be included in the forecast. This KPI can display a comparison of two different date ranges if you have enabled the Historical Metrics feature. The check box for this feature is available under Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, in the Sales section of the CRM subtab. Click this KPI's periods or totals to open the Alt. Sales Pipeline by Sales Rep Summary Report.</td>
</tr>
<tr>
<td><strong>Pipeline (Projected)</strong></td>
<td>This indicator shows the total value of open opportunities and open estimates expected to close within the selected date range(s). This value excludes the total of opportunities with estimates set to be included in the forecast. This KPI can display a comparison of two different date ranges if you have enabled the Historical Metrics feature. The check box for this feature is available under Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, in the Sales section of the CRM subtab. Click this KPI's periods or totals to open the Pipeline by Sales Rep Summary Report.</td>
</tr>
<tr>
<td><strong>Pipeline (Weighted)</strong></td>
<td>This indicator shows the weighted value of open opportunities and open estimates expected to close within the selected date range(s). This value excludes the total of opportunities with estimates set to be included in the forecast. The weighted value is calculated by multiplying probability times projected total. This KPI can display a comparison of two different date ranges if you have enabled the Historical Metrics feature. The check box for this feature is available under Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, in the Sales section of the CRM subtab. Click this KPI's periods or totals to open the Pipeline by Sales Rep Summary Report.</td>
</tr>
<tr>
<td><strong>Pipeline Deals</strong></td>
<td>This indicator shows the number of open opportunities and open estimates expected to close within the selected date range(s). This number excludes the number of opportunities with estimates set to be included in the forecast. This KPI can display a comparison of two different date ranges if you have enabled the Historical Metrics feature. The check box for this feature is available under Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, in the Sales section of the CRM subtab. Click this KPI's periods or totals to open the Pipeline by Sales Rep Summary Report.</td>
</tr>
<tr>
<td><strong>Profit</strong></td>
<td>This indicator shows the difference between your income and expenses during the selected period(s). Click this KPI's periods or totals to open the Income Statement Report.</td>
</tr>
<tr>
<td><strong>Quota</strong></td>
<td>This indicator shows the sum of all top-level quotas to which you have access, for the selected date range(s). If an employee is assigned a personal quota and a team quota, only the team quota is included in the sum. Click this KPI's periods or totals to open the Billings Forecast vs. Quota Report.</td>
</tr>
<tr>
<td><strong>Quota (Alt. Sales)</strong></td>
<td>This indicator shows the sum of all top-level quotas to which you have access, based on alternate sales amounts (ASA), for the selected date range(s). If an employee is assigned both a personal quota and a team quota, only the team quota is included in the sum. Click this KPI's periods or totals to open the Alt. Sales Forecast vs. Quota Report.</td>
</tr>
<tr>
<td><strong>KPI</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
</tr>
<tr>
<td>Quota Reps</td>
<td>This indicator shows the number of sales reps that have been assigned quotas as of the selected date(s). Click this KPI’s periods or totals to open the Quota Reps report.</td>
</tr>
<tr>
<td>Receivables</td>
<td>This indicator shows the total impact on A/R accounts during the selected period(s). Click this KPI’s periods or totals to open the A/R Aging Summary Report.</td>
</tr>
<tr>
<td>Revenue</td>
<td>This indicator shows the total credits to income and expense accounts during the selected period(s). Click this KPI’s periods or totals to open the Income Statement Report.</td>
</tr>
<tr>
<td>Sales (This KPI is labeled Sales (Billings) on the Customer Dashboard.)</td>
<td>This indicator shows total paid or billed income and reimbursed expenses for customers during the selected period(s). It excludes the following transaction types: Journal, Deposit, Credit Card, Credit Card Refund, and Check. Click this KPI’s periods or totals to open the Sales by Customer Summary Report.</td>
</tr>
<tr>
<td>Sales (Cash Basis)</td>
<td>This indicator shows total paid income and reimbursed expenses for customers during the selected period(s). It excludes the following transaction types: Journal, Deposit, Credit Card, Credit Card Refund, and Check. Income is only counted in this KPI if it has been paid. Sales are included based on the date of the payment. Click this KPI’s periods or totals to open the Sales by Customer Summary – Cash Basis report. See also Setting Up Cash Basis Reporting.</td>
</tr>
<tr>
<td>Sales (Orders)</td>
<td>This indicator shows the dollar value of sales generated through approved sales orders during the selected date range(s). Click this KPI’s periods or totals to open the Sales Orders by Customer Summary Report.</td>
</tr>
<tr>
<td>Sales (Orders Alt. Sales)</td>
<td>This indicator shows the dollar value of sales generated through approved sales orders, based on alternate sales amounts (ASA), during the selected date range(s). Click this KPI’s periods or totals to open the Sales Orders by Customer Summary Report.</td>
</tr>
<tr>
<td>Total Backlog (Projects)</td>
<td>This indicator shows the total number of budgeted hours left to complete all open projects. Click Current or total to open the Current Backlog By Resource Report report.</td>
</tr>
<tr>
<td>Total Open Estimates</td>
<td>This indicator shows the number of estimates that were open as of the selected date(s). Open estimates have a probability between 0% and 100%, and have not been closed by an order or actual. Click this KPI’s periods or totals to open the Total Open Estimates Report.</td>
</tr>
<tr>
<td>Total Open Opportunities</td>
<td>This indicator shows the number of opportunities that were open as of the selected date(s). Open opportunities have a probability between 0% and 100%, and have not been closed by an order or actual. Click this KPI’s periods or totals to open the Total Open Opportunities Detail Report.</td>
</tr>
<tr>
<td>Total Open Quotes</td>
<td>This indicator shows the total number of open quotes for the selected period. Click this KPI to see the Total Quotes report. For more information about quotes, see the help topic Quotes.</td>
</tr>
<tr>
<td>Total Orders (Count)</td>
<td>This indicator shows the number of sales orders placed during the selected date range(s). Click this KPI’s periods or totals to open the Sales Order Register Report.</td>
</tr>
<tr>
<td>KPI</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total Pipeline (Alt. Sales Projected)</td>
<td>This indicator shows the total projected dollar value of open opportunities and open estimates based on alternate sales amounts (ASA), that are open as of today, or as of the other dates selected. This KPI can display a comparison for two different dates if you have enabled the Historical Metrics feature. The check box for this feature is available under Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, in the Sales section of the CRM subtab. Click this KPI's periods or totals to open the Alt. Sales Total Pipeline by Sales Rep Summary Report.</td>
</tr>
<tr>
<td>Total Pipeline (Alt. Sales Weighted)</td>
<td>This indicator shows the total weighted dollar value of open opportunities and open estimates, based on alternate sales amounts (ASA), that are open as of today, or as of the other dates selected. The weighted value is calculated by multiplying probability by projected total. This KPI can display a comparison for two different dates if you have enabled the Historical Metrics feature. The check box for this feature is available under Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, in the Sales section of the CRM subtab. Click this KPI's periods or totals to open the Alt. Sales Total Pipeline by Sales Rep Summary Report.</td>
</tr>
<tr>
<td>Total Pipeline (Projected)</td>
<td>This indicator shows the projected value of open opportunities and estimates, as of today, or as of the other dates selected. This value excludes the total of opportunities with estimates set to be included in the forecast. This KPI can display a comparison for two different dates if you have enabled the Historical Metrics feature. The check box for this feature is available under Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, in the Sales section of the CRM subtab. Click this KPI's periods or totals to open the Total Pipeline by Sales Rep Summary Report.</td>
</tr>
<tr>
<td>Total Pipeline (Weighted)</td>
<td>This indicator shows the weighted value of open opportunities and estimates, as of today, or as of the other dates selected. This value excludes the total of opportunities with estimates set to be included in the forecast. The weighted value is calculated by multiplying probability times projected total. This KPI can display a comparison for two different dates if you have enabled the Historical Metrics feature. The check box for this feature is available under Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, in the Sales section of the CRM subtab. Click this KPI's periods or totals to open the Total Pipeline by Sales Rep Summary Report.</td>
</tr>
<tr>
<td>Total Pipeline Deals</td>
<td>This indicator shows the total number of opportunities and estimates that are presently open, as of today, or as of the other dates selected. This KPI can display a comparison for two different dates if you have enabled the Historical Metrics feature. The check box for this feature is available under Setup &gt; Company &gt; Setup Tasks &gt; Enable Features, in the Sales section of the CRM subtab. Click this KPI's periods or totals to open the Total Pipeline by Sales Rep Summary Report.</td>
</tr>
<tr>
<td>Total Sales (Orders)</td>
<td>This indicator shows the total dollar value of sales, through both approved and unapproved sales orders, during the selected date range(s). Click this KPI's periods or totals to open the Sales Order Register Report.</td>
</tr>
<tr>
<td>Unbilled Orders</td>
<td>(Available on the Customer Dashboard only) This indicator shows the total amount of the customer's orders that have been placed but not billed for the selected period(s). Click this KPI's periods or totals to open the Open Sales Orders Report.</td>
</tr>
<tr>
<td>Unique Visitors</td>
<td>This indicator shows the number of visitors your website has received during the selected date range(s).</td>
</tr>
</tbody>
</table>
### KPI Meters

You can add up to three KPI Meter portlets to a dashboard. Each meter visually represents data for one KPI that is displayed in the dashboard's Key Performance Indicators portlet. You can also see the currency symbol of the data for values represented by currencies.

![KPI Meter](image)

Choices of KPIs for a meter are limited to the KPIs displayed in the dashboard's Key Performance Indicators portlet, plus the following: Actual vs. Forecast, Actual vs. Quota, Forecast vs. Quota, and Forecast vs. Quota (Alt. Sales).

Each KPI meter can show KPI data for one date range, a comparison of KPI data for two different date ranges, or a flagged threshold value. By default, the meter shows comparisons or thresholds if they are set up for the KPI in the Key Performance Indicators portlet. Whenever you change these options in either the KPI meter or the Key Performance Indicators portlet, they are also changed in the other portlet so that the two portlets remain in sync. You can, however, set up different options for the KPI meter, for instance not showing a comparison in the KPI meter portlet but showing one in the Key Performance Indicators portlet.

#### To set up a KPI Meter portlet:

1. Ensure that the KPI you want to display in the KPI meter is listed in the Key Performance Indicators portlet. If it is not listed, click **Set Up** in the portlet menu. In the Set Up Key Performance Indicators popup, click **Add Standard KPIs** or **Add Custom KPIs**, select the KPI, and click **Done**. Click **Save** to add the selected KPI to the portlet.

2. To add a KPI Meter portlet to a page, click **Personalize Dashboard**. In the Add Content Panel, click the KPI Meter icon or drag it onto the dashboard.
3. By default, the KPI Meter portlet displays a graph for the KPI that is listed first in the Key Performance Indicators portlet. To change the KPI that the meter represents, select another KPI from the portlet’s dropdown list.

If you select Actual vs. Forecast, Actual vs. Quota, Forecast vs. Quota, or Forecast vs. Quota (Alt. Sales), the following message may appear: “No data available for this portlet.”

This message indicates that you need to add one or both of the underlying KPIs to the Key Performance Indicators portlet to display the KPI meter.

**To display this meter...**  
Add these KPIs to Key Performance Indicators Portlet:

<table>
<thead>
<tr>
<th>KPI Type</th>
<th>Add KPIs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual vs. Forecast</td>
<td>Sales, Forecast (Alt. Sales)</td>
</tr>
<tr>
<td>Actual vs. Quota</td>
<td>Sales, Quota</td>
</tr>
<tr>
<td>Forecast vs. Quota</td>
<td>Forecast (Alt. Sales), Quota</td>
</tr>
<tr>
<td>Forecast vs. Quota (Alt. Sales)</td>
<td>Forecast (Alt. Sales), Quota (Alt. Sales)</td>
</tr>
</tbody>
</table>

To add these KPIs to the Key Performance Indicators portlet, click Set Up in the portlet menu, click the Add Standard KPIs button, select each KPI from the box, click Done, and click Save. For more information, see Setting Up the Key Performance Indicators Portlet.

4. To change the meter’s settings for showing comparison or threshold highlighting, click Set Up in the portlet menu, make changes in the Set Up KPI Meter popup, and click Save.

**Note:** For visual purposes only, the KPI Meter displays a different number than the threshold. For positive numbers, the maximum number displayed is higher than the threshold. For negative numbers, the maximum number displayed is lower than the threshold.

You can also print the KPI Meter or download it to a file, using the options in the portlet menu.
You can change the position of the KPI Meter portlet on your dashboard by dragging it to a different location. For more information, see Arranging Dashboard Portlets.

**Important**: If you have selected a custom KPI to display in a KPI meter and its results do not look correct, the saved search on which the custom KPI is based may not satisfy related requirements. The saved search definition must:

- Not include any date fields defined as filters on the Criteria subtab
- Have only one field with a summary type (such as group, sum, or count) defined on the Results subtab.
- Have a date field defined as an available filter on the Available Filters subtab.

For more information, see Custom KPIs.

**Trend Graphs**

The dashboard trend graphs can be used to illustrate the differences in data over time for up to three KPIs.

Trend graphs offer choices to display data in Area, Line, Bar, or Column charts, and to use continuous or side-by-side comparisons. You can click thumbnails to shift among these choices.

You can also use the dropdown list to set the time period for trend graph data.
When you roll over a point in a trend graph, its value displays:

Trend graphs are available in two display modes: popup trend graphs and trend graph portlets. You can set layout options for both types of trend graphs. Both also offer options to print charts, to download charts to PNG, JPG, PDF, and SVG files, and to export chart data to CSV files.

**Important:** Microsoft Edge and Internet Explorer browsers do not support direct PDF export. Instead, you can download charts in other supported formats, such as PNG, JPG, and SVG, and use the Print dialog box or another PDF creation tool to convert these files to PDFs.

For more information, see the following topics:

- Displaying Popup Trend Graphs
- Displaying Trend Graph Portlets
- Displaying Custom KPI Results in Trend Graphs

**Displaying Popup Trend Graphs**

Popup trend graphs are available from clickable Trend Graph icons in the Key Performance Indicators portlet and the KPI Scorecard portlet.
To enable this icon for a KPI in the Key Performance Indicators portlet, you need to set up a time-based comparison for it in the Set Up Key Performance Indicators popup. For information, see Setting Up KPI Comparisons.

In KPI Scorecard portlets, trend graph icons are usually enabled when the portlet is set to display KPIs on the left. However, when the portlet is set to display date ranges on the left, you may need to click Set Up in the KPI Scorecard portlet to open the KPI Scorecard Setup popup and select the Show Trend Graph Icon check box. For information, see Adding a KPI Scorecard Portlet to a Dashboard.

When you click a Trend Graph icon, a popup trend graph displays data.

You can set display options for all popup trend graphs in the Popup Trend Graphs subtab of the Set Up window of the Key Performance Indicators portlet. For more information, see Setting Up Popup Trend Graphs.

Each popup trend graph includes buttons you can click to print the trend graph chart, or to download it to a PNG, JPG, PDF, or SVG file, and Export you can click to export chart data to a CSV file.

Displaying Trend Graph Portlets

You can add up to five trend graph portlets to any standard or custom dashboard, by clicking Trend Graphs icons in the Personalize Dashboard panel or dragging them onto the dashboard. Each trend graph portlet includes a Set Up link that you can click to set display options for that trend graph only. For more information, see Setting Up Trend Graph Portlets. Additional menu options enable you to print the trend graph chart, to download it to a PNG, JPG, PDF, or SVG file, and to export chart data to a CSV file.
Displaying Custom KPI Results in Trend Graphs

- A custom KPI can be displayed in a trend graph portlet if the saved search on which this custom KPI is based:
  - Does not include any date fields defined as filters on the Criteria subtab
  - Has exactly one field with a summary type (such as group, sum, or count) defined on the Results subtab. The rest of the fields on the Results subtab should not use any summary types.
  - Has a date field defined as an available filter on the Available Filters subtab.
- Custom KPIs can only be displayed in trend graph portlets on pages that include a Key Performance Indicators portlet.
- When a KPI is set to Custom KPI #1-#10, the Default Trend Type dropdown list displays saved searches, which meet criteria used in trend graphs.

For more information, see Custom KPIs.

Setting Up Popup Trend Graphs

You set display options for popup trend graphs on the Popup Trend Graphs subtab of the Set Up Key Performance Indicators popup. These options apply to all popup trend graphs for both the Key Performance Indicators portlet and the KPI Scorecard portlet.

You also can reset the time interval for each graph's x-axis directly in each trend graph popup.

For more information, see the following topics:
- Making Popup Trend Graphs Available
- Setting Up Popup Trend Graph Display Options

Making Popup Trend Graphs Available

- To make popup trend graphs available from the Key Performance Indicators portlet, ensure that the portlet displays the KPI for which you want to view a popup trend graph, and that you have set up a date range comparison for the KPI. For information, see Setting Up the Key Performance Indicators Portlet.
- Popup trend graphs are available for KPIs in a KPI Scorecard portlet that is set to display KPIs on the left. If your KPI Scorecard portlet is set to display date ranges on the left, you need to click Set Up in the portlet's menu and select the Show Trend Graph Icon box. For information, see Adding a KPI Scorecard Portlet to a Dashboard.
Setting Up Popup Trend Graph Display Options

You can define display options for popup trend graphs on the Popup Trend Graphs tab of the Set Up Key Performance Indicators window that is displayed when you click Set Up in the Key Performance Indicators portlet.

To set up a popup trend graph:

1. Click Set Up in the Key Performance Indicators portlet to open the Set Up Key Performance Indicators popup.
2. Click the Popup Trend Graphs subtab. You can set the following options.
   1. Select from the Default Chart Type list to set the default chart used for all popup trend graphs.
      - Chart type options are Area, Line, Bar, and Column.
      - You can click thumbnails in an individual trend graph to change its chart type from the default set here.
In addition to the set of four chart type thumbnails on the left, each popup trend graph includes two thumbnails that you can click to choose either a continuous or side-by-side comparison of data in the trend graph.

2. Select from the **Default Time Increment** list to set the default time interval used for all popup trend graph comparisons.
   - Choices usually include **Daily, Weekly, Monthly, Quarterly**, and **Yearly**.
   - You can change this default in an individual trend graph by selecting from its time interval dropdown list.

3. Review the following options, and check or clear boxes as desired.
   - If the **Show Moving Average** option is enabled, all popup trend graphs display a dotted line representing the rolling average of KPI data values. This option is enabled by default.
   - If the **Show Last Data Point on Pop-Up Trend Graphs** option is enabled, all popup trend graphs display the most recent KPI data point. Because the last point may not provide complete data, you may want to exclude this point from the graph to avoid a misleading display. This option is enabled by default.
   - If the **Include Zero on Y-Axis** option is enabled, the first y-axis value for all popup trend graphs is set to zero, rather than to the initial KPI data point. This option is disabled by default, to avoid showing misleadingly dramatic increases in initial trend graph data.

4. Enter a number in the **Period to Calculate Moving Average** field.
   - This number indicates the number of data points to use in calculating the slope of the moving average line in popup trend graphs.
   - Note that the lower the number here, the greater the slope of the line.
   - You can enter the number that represents the window of data you want to average based on the time increment selected. For example, if you select Monthly and enter 3 as your window, each data point on your Y-axis represents a 3 month average.

5. Select from the **Chart Themes** list to set a look and feel for popup trend graph data:
   - **Global Theme** – uses the chart theme selected at Home > Set Preferences.
   - **Basic** – provides limited color contrast.
   - **Colorful** – provides more color contrast.
   - **Match Color Theme - Bold** – harmonizes with your choices in the Colors section of the Set Preferences page using bolder shades.
   - **Match Color Theme - Light** – harmonizes with your choices in the Colors section of the Set Preferences page using lighter shades.

6. Select from the **Chart Background** list to set the display behind popup trend graph data:
   - **Global Background** – uses the chart background set at Home > Set Preferences.
   - **Lines** – provides lines that demarcate different levels along the Y-axis.
   - **Bands** – provides bands that demarcate different levels along the Y-axis.
   - **Grid** – provides a grid all throughout the Y-axis.

7. You can also specify a custom color for the trend graph line by typing its hexadecimal code in the **Custom Series Color** field or by clicking the palette button that appears when you hover over this field.

3. Click **Save**.
Setting Up Trend Graph Portlets

You can add up to five trend graph portlets to any standard or custom page. Each trend graph portlet includes a Set Up link that you can click to set display options for up to three KPIs.

To set up a trend graph portlet:

1. Click Personalize in the upper right corner of a page or in the Settings portlet.

Note: A custom KPI will not display properly in a popup trend graph if the saved search on which it is based does not meet related requirements. For information, see Displaying Custom KPI Results in Trend Graphs.
2. On the **Standard Content** tab of the **Personalize Dashboard** palette, click a Trend Graph icon or drag it onto the dashboard. You can see the number of available trend graph portlets by hovering over the icon.

3. Click **Set Up** in the trend graph portlet’s menu.

4. Select standard or custom KPIs from the **KPI** dropdown list. You can select a maximum of three KPIs.

   ![Important: Custom KPIs are only available in trend graph portlets on pages that include a Key Performance Indicators portlet.](image)

5. You can also edit the following settings:
   1. In the **Custom Portlet Title** field, enter a title for the portlet.
   2. Select from the **Default Chart Type** list to set the default chart type displayed in this portlet.
      - Chart type options are **Area**, **Line**, **Bar**, and **Column**.
      - You can click thumbnails in the portlet itself to dynamically change its chart type from the default set here.

   ![In addition to the set of four chart type thumbnails on the left, each trend graph portlet includes two thumbnails that you can click to choose either a continuous or side-by-side comparison of data in the trend graph.](image)

   3. If you selected a custom KPI, select a saved search from the **Default Trend Type** dropdown list. If a saved search is not available, or returns an error when you select it, its definition may not meet requirements for trend graph display. For information, see [Displaying Custom KPI Results in Trend Graphs](#).

   4. Select from the **Trend Type** list to indicate whether the graph’s x-axis time scale should be **daily**, **weekly**, **monthly**, **quarterly**, or **yearly**. You also can set this option by selecting from a dropdown list in the portlet.

   5. Check the **Show Moving Average** box to display a dotted line in the trend graph, representing the rolling average of KPI data values. This option is enabled by default.

   6. In the **Period to calculate moving average** field, enter the number that represents the window of data you want to average based on the date range selected in the **Trend Type** field. For example, if you select monthly and enter 3 as your window, each data point on your y-axis will represent a 3 month average.

   7. Check the **Show Last Data Point** box to display the most recent KPI data point in the trend graph. Because the last point may not provide complete data, you may want to exclude this point from the graph to avoid a misleading display. This option is enabled by default.

   8. Check the **Include Zero on Y-Axis** box to set the first y-axis value for the trend graph to zero, rather than to the initial KPI data point. This option is disabled by default, to avoid showing misleadingly dramatic increases in initial trend graph data.

   9. Select from the **Chart Theme** dropdown list to set a look and feel for chart data:
      - **Global Theme** – uses the chart theme set at Home > Set Preferences (the default). See the help topic [Personal Preferences for Appearance](#).
      - **Basic** – provides limited color contrast.
      - **Colorful** – provides more color contrast.
Trend Graphs

- **Match Color Theme - Bold** – harmonizes with your choices in the Colors section of the Set Preferences page using bolder shades.
- **Match Color Theme - Light** – harmonizes with your choices in the Colors section of the Set Preferences page using lighter shades.

10. In the **Custom Series Color** field, enter a hexadecimal value for a custom color you want to use for the chart. (Note that this option is provided for backwards compatibility with custom chart colors defined prior to the introduction of chart themes in Version 2012 Release 2.)

11. Select from the **Background Type** dropdown list to set the display behind chart data:
   - **Global Background** – uses the background type set at Home > Set Preferences (the default).
   - **Lines** – provides lines that demarcate different levels along the Y-axis.
   - **Bands** – provides bands that demarcate different levels along the Y-axis.
   - **Grid** – provides a grid all throughout the Y-axis.

6. When you are done, click **Save**. The portlet refreshes itself.

Note that each trend graph portlet includes menu options to print the chart, to download it to a PNG, JPG, PDF, or SVG file, and to export its data to a CSV file.

To expand the portlet to full-screen view, click the double arrow icon '▶'.

**Custom KPIs**

NetSuite provides over 75 standard KPIs that you can display in a dashboard’s Key Performance Indicators portlet, or use for calculations in a KPI scorecard. These standard KPIs provide quick summaries of standard NetSuite report data and enable you to drill down into the full reports for more detail.

You may have other important data that you would like to display as a KPI on your dashboard, that is not available from standard reports. In this case, you can find a preexisting saved search that compiles this data or create a new saved search for this purpose.

For information, see:

- **Selecting an Existing Search to be a Custom KPI**
- **Creating a New Search to be a Custom KPI**

After you have identified an appropriate saved search, you can define it as a data source for a custom KPI.

- You can display up to ten custom KPIs in each Key Performance Indicators portlet. When a custom KPI is displayed in the portlet, you can click it to drill down to detailed results from its saved search, and click a Trend Graph icon to display its data in a popup trend graph. For information, see **Adding a Custom KPI to the Key Performance Indicators Portlet**.
- You can define up to ten custom KPIs to be used in each KPI scorecard portlet’s calculations. For information, see **Using a Custom KPI in a KPI Scorecard**.
- Custom KPIs displayed in the Key Performance Indicators portlet are also available for display in KPI Meter portlets. You can display up to three KPI meters on a dashboard. For information, see **KPI Meters**.
- Custom KPI data can also be displayed in Trend Graph portlets. You can add up to five Trend Graph portlets. For information, see **Setting Up Trend Graph Portlets**.

Dashboards
Custom KPI definitions for individual KPI scorecards, the Key Performance Indicators portlet, and Trend Graph portlets are all independent of each other.

For a saved search to be used as a custom KPI that displays results for multiple date ranges in the Key Performance Indicators portlet, a KPI scorecard, a trend graph, or a KPI meter, the search definition must meet the following requirements:

- Not include any date fields defined as filters on the Criteria subtab. See the help topic Defining Standard Search Filters.
- Have exactly one field with a summary type (such as count, group, or sum) defined on the Results subtab. The rest of the fields on the Results subtab should not use any summary types. See the help topic Defining Summary Types to Roll Up Search Results.
- Have a date field defined as an available filter on the Available Filters subtab. See the help topic Selecting Available Filters for Saved Searches.

Selecting an Existing Search to be a Custom KPI

To better understand the requirements that your saved search must meet to be used as a custom KPI, see Custom KPIs.

You can edit an existing saved search to be used as a custom KPI by completing the following steps:

**To select an existing saved search to be used as a custom KPI:**

1. Choose Reports > Saved Searches > All Saved Searches.
2. In the Saved Searches list, click Edit next to the search you want to use as a custom KPI. You need to ensure that the search has been defined correctly to display KPI data in the manner you want.
3. On the Criteria subtab, make sure that no date filters are used as search criteria.

   **Note:** KPIs cannot enforce summary criteria filters because KPI calculations do not include groupings. If a saved search used as a custom KPI includes any summary criteria filters, the result for the KPI may differ from results when the search is run.

4. On the Results subtab, make sure you have only one field that uses a summary type.
   - If you want to display a count of the number of search results for a KPI, select a number or ID field (such as Number) and set a Count summary type for this field.
   - If you want to display summary data such as sum (total), average, minimum, or maximum, select a field and set the appropriate summary type for it.

5. On the Available Filters subtab, add a date field to be able to compare saved search results over different date ranges in a Key Performance Indicators portlet, a trend graph, a KPI meter, or a KPI scorecard.
   - If the type of search you have selected does not offer a date column as a filter, you may be able to use a different type of search, for example, a transaction search.
   - If you want to use a saved search as a custom KPI in a scorecard and you have enabled the Use Periods option for a scorecard, only saved searches with a Period filter defined as an Available Filter can be defined as custom KPIs for the scorecard.

6. Edit the search to meet your requirements and resave it.
   - If you do not have the ability to edit and resave this search, you can ask the owner to edit it, or you can create another, similar search yourself.
   - Choose Save & Run to verify the search results are what you expect.
7. Note the title of the search. It will appear in the custom KPI lists in the Set Up Key Performance Indicators popup and the KPI scorecard.

8. Now you can use the search as a custom KPI and add it to the Key Performance Indicators portlet, add it to a KPI scorecard, or display it in a trend graph portlet. See Adding a Custom KPI to the Key Performance Indicators Portlet, or Using a Custom KPI in a KPI Scorecard.

For more information about editing saved searches, see the help topic Saved Searches.

Creating a New Search to be a Custom KPI

To better understand the requirements that your saved search must meet to be used as a custom KPI, see Custom KPIs.

You can create an existing saved search to be used as a custom KPI by completing the following steps:

To create a new saved search to be used as a custom KPI:

1. Choose Reports > Saved Searches > All Saved Searches > New.
2. In the New Saved Search list, click a search type.
3. On the Saved Search form, enter a title for the search. (This title will appear in the custom KPI dropdown lists in the Set Up Key Performance Indicators popup and the KPI scorecard.)
4. On the Criteria subtab, define the filters that will limit the search data, making sure you don’t include date filters as search criteria.

Note: KPIs cannot enforce summary criteria filters because KPI calculations do not include groupings. If a saved search used as a custom KPI includes any summary criteria filters, the result for the KPI may differ from results when the search is run.

5. On the Results subtab, define which fields you want to be returned in the saved search results. Make sure you have exactly one field that uses a summary type.
   - If you want to display a count of the number of search results for a KPI, select a number or ID field (such as Number) and set a Count summary type for this field.
   - If you want to display summary data such as sum (total), average, minimum, or maximum, select a field and set the appropriate summary type for it.
6. On the Available Filters subtab, add a date field to be able to compare saved search results over different date ranges in a Key Performance Indicators portlet, a trend graph, a KPI meter, or a KPI scorecard.
   - If the type of search you have selected does not offer a date column as a filter, you may be able to use a different type of search, for example, a transaction search.
   - If you want to use a saved search as a custom KPI in a scorecard and you have enabled the Use Periods option for a scorecard, only saved searches with a Period filter defined as an Available Filter can be defined as custom KPIs for the scorecard.
7. When you are done defining the search, click Save. (You can choose Save & Run to verify the search results are what you expect.)

Now you can use the search as a custom KPI and add it to the Key Performance Indicators portlet, add it to a KPI scorecard, or display it in a trend graph portlet. See Adding a Custom KPI to the Key Performance Indicators Portlet, or Using a Custom KPI in a KPI Scorecard.

For more information about creating saved searches, see the help topic Saved Searches.
Adding a Custom KPI to the Key Performance Indicators Portlet

Custom KPIs are based on saved searches, so you need to create or select an appropriate search before you add a custom KPI to the portlet. For information, see Creating a New Search to be a Custom KPI or Selecting an Existing Search to be a Custom KPI.

**To add a custom KPI to the Key Performance Indicators Portlet:**

1. Click **Set Up** in your Key Performance Indicators portlet.
2. In the Set Up Key Performance Indicators popup, click **Add Custom KPIs** to open the Choose Custom Key Performance Indicators popup window.
   - Click a saved search in the right list to move it to the left list, which indicates that it should be displayed as a custom KPI.
   - Click **Done** after you have finished selecting KPIs for display.
   - You can choose up to 10 custom KPIs.
   - Custom KPIs are listed with “c” icons. Click an icon for a brief general description of custom KPIs.
3. For each selected KPI, in the **Range** list, select the date or period range for which data should be included.
4. For each selected KPI, in the **Compare** column, check the box if you want to compare results from the time period defined in the **Range** list with results from another period defined in the **Compare Range** list.
5. For each selected KPI, in the **Compare Range** list, if you checked the **Compare** box, select the date or period range for which data should be compared with data from the first range. If you did not check the **Compare** box, you do not need to make a selection here.
6. For each selected KPI, in the **Highlight If** list, select **greater than** or **less than** if you want to highlight data that exceeds or falls short of a defined threshold. If you do not want highlighting for this KPI, leave this column blank.
7. If you selected an option in the **Highlight If** column, enter the threshold value in the **Threshold** column.
   - If you want the change to be highlighted in the portlet's headline when the specified threshold value is reached, select the check box in the **Headline** column.
8. Click **Save**.

Using a Custom KPI in a KPI Scorecard

You can use custom KPIs for comparisons in KPI scorecards as well as include them in KPI scorecard formulas.

To learn how to create and configure KPI scorecards, see KPI Scorecards Overview.

**Note:** Custom KPIs are based on saved searches, so you need to create or select an appropriate search before you add a custom KPI to a scorecard. For information, see Creating a New Search to be a Custom KPI or Selecting an Existing Search to be a Custom KPI.

**To add a custom KPI to a KPI scorecard:**

1. Open the KPI scorecard where you want to add a custom KPI.
To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click Edit next to the KPI scorecard you want to edit.

To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.

2. On the Content tab, select one of the custom KPIs (Custom KPI #1–Custom KPI #10) from the KPIs list.

3. On the Custom subtab, find the custom KPI number you added to the KPIs list (Custom KPI #1 through Custom KPI #10) and specify the saved search to be used as this custom KPI.

4. If you want to add a custom KPI ID to a formula expression, select a formula from the KPIs list, click the Set Formula icon in the Formula column, and select one of the custom KPIs you defined on the Custom subtab.

   To learn how to define other formula settings, see Defining KPI Scorecard Formulas.

5. Define other settings for the KPI comparison. For information, see Defining KPI Scorecard Comparisons.
KPI Scorecards Overview

The KPI Scorecard portlet displays your choice of a performance scorecard. KPI scorecards can provide complex comparisons among multiple KPIs over multiple date ranges or accounting periods. Scorecards also can include Excel-like formulas with KPIs and functions in their expressions. Scorecards offer many choices for calculation and display of KPI data. To get an understanding of what you can do with KPI scorecards, see the following:

- Scorecard Data Calculation and Comparison Options
- Scorecard Data Display Options

To get started using KPI scorecards, see the following:

- Enabling the KPI Scorecards Feature
- Adding a KPI Scorecard Portlet to a Dashboard
- Creating a KPI Scorecard

Scorecard Data Calculation and Comparison Options

- Comparison of KPI results for a greater variety of date range types
- Comparison of KPI results for a progression of date ranges
- Comparison of multiple KPIs’ results
- Different types of comparative calculations including:
  - Sums: A+B
  - Variances in absolute or percent terms: A-B or 100(B-A)/A
  - Ratios in absolute or percentage terms: (B/A) or 100*B/A
- Inversion of date ranges in comparisons
- Excel-like formulas with the following features:
  - Formula results that can be expressed as:
    - Dollar amounts
    - Percentages
    - Numeric amounts
  - Formula expressions that can include:
    - Multiple KPIs
    - Common functions
  - Ability to define hidden formulas with results to be used by other formulas

Scorecard Data Display Options

- Ability to orient KPIs horizontally or vertically
- Ability to define custom labels in place of KPI names
- Optional popup trend graphs
- Ability to limit displayed data to your own or your team's results.
Enabling the KPI Scorecards Feature

The KPI Scorecards feature must be enabled before you can create a KPI scorecard or add a KPI Scorecard portlet to a dashboard.

To enable the KPI Scorecards feature:

1. Go to Setup > Company > Enable Features.
2. On the Analytics subtab, check the KPI Scorecards box, and click Save.

Note: If you do not see the Enable Features option in your Setup tab's menu, you do not have this permission. You need to ask an administrator or someone with the Enable Features permission to enable the KPI Scorecards feature.

When the KPI Scorecards feature is enabled, you can:

- Create your own KPI scorecard (if you have the KPI Scorecards permission). See Creating a KPI Scorecard.
- Add a KPI scorecard portlet to display an existing KPI scorecard. See Adding a KPI Scorecard Portlet to a Dashboard.

Adding a KPI Scorecard Portlet to a Dashboard

You can add a KPI Scorecard portlet to a dashboard in the same manner that you add other portlets, but this portlet is not available unless the KPI Scorecards feature has been enabled.

After you have added a KPI Scorecard portlet, you can click Set Up in the portlet, then select a KPI scorecard and define display options.

To add a KPI Scorecard portlet to a dashboard:

1. Click Personalize in the upper right corner of your dashboard. You can also use Personalize Dashboard in the Settings portlet.
2. On the Standard Content tab of the Personalize Dashboard palette, click the KPI Scorecard item or drag it onto the dashboard.
   - If the list does not include KPI Scorecard, the KPI Scorecards feature has not been enabled. See Enabling the KPI Scorecards Feature.
3. In the KPI Scorecard portlet, click Set Up to open a KPI Scorecard Setup popup.
   1. In the KPI Scorecard list, select the scorecard that you want to display.
      - If you do not see a suitable scorecard, you may need to create a new KPI scorecard. See Creating a KPI Scorecard.
   2. By default, the Restrict To list is set to All to indicate that scorecard results are not filtered. If you want to filter results, select My Team or Only Mine.
   3. By default, the Orientation list is set to KPIs on Left, meaning that the scorecard lists KPI labels on the left and date ranges across the top. To change this layout, select Date Ranges on Left.
Adding a KPI Scorecard Portlet to a Dashboard

4. Check or clear the **Show Trend Graph Icon** box to indicate whether you want the KPI Scorecard portlet to include icons that can be clicked to open popup trend graphs of KPI data. For more information, see Setting Up Popup Trend Graphs.

5. Check or clear the **Show Date Row** box to indicate whether to include explicit date ranges as the first row (or first column if you selected Date Ranges on Left for Orientation). This data is useful to display if the scorecard uses relative date ranges, such as 1 year ago.

6. Click **Save**.

4. Review the portlet's contents and links. The portlet title matches the name of the selected KPI scorecard.
   1. Click **Refresh** to refresh portlet data.
   2. Click **Set Up** to change portlet settings.
   3. Click **Edit** or **Customize** to open the KPI scorecard and make changes to its definitions. For information, see Editing a KPI Scorecard.
   4. Click **Export** to save scorecard results in an external CSV file.

Creating a KPI Scorecard

NetSuite enables you to create custom scorecards that can be displayed in the KPI Scorecard dashboard portlet.

**To create a new KPI scorecard:**

1. Go to Customization > Centers and Tabs > KPI Scorecards > New.

   If this menu option is not available, the KPI Scorecards feature may not be enabled. See Enabling the KPI Scorecards Feature. Or you may not have permission to create scorecards. Check with your account administrator to ensure you have the KPI Scorecards permission.

2. At the top of the page, you can enter basic scorecard information. See Entering Basic Scorecard Information.

3. On the **KPIs** subtab of the **Content** subtab, you can add KPIs and define their comparisons, and add formulas and define formula expressions.
Scorecards can intermingle KPIs and formulas and compare them to each other, so you define KPIs and formulas in the same place using some slightly different fields on the subtab.

- For KPI steps, see Defining KPI Scorecard Comparisons.
- For formula steps, see Defining KPI Scorecard Formulas.

If you define custom KPIs to be used in scorecards, you need to define their underlying saved searches on the Custom subtab of the Content subtab.

Only saved searches with a date field defined under Available Filters are available for use as custom KPIs in scorecards. The exception is if you enable the Use Periods option for a scorecard. Then only saved searches with a Period filter defined under Available Filters are available.

- After you have entered KPIs and formulas, you can reorder them by dragging and dropping or using the Move buttons.

4. On the Date Ranges (or Periods) subtab of the Content subtab, you can define multiple date ranges (or periods). These date ranges apply to all scorecard data. See Defining KPI Scorecard Date Ranges or Periods.

After you have entered date ranges, you can reorder them by dragging and dropping or using the Move buttons.

5. On the Highlighting subtab of the content subtab, you can set highlighting options to make results more visible in KPI Scorecard portlets. See Highlighting KPI Scorecard Results.

6. On the Audience subtab, you can define who has access to your scorecard, meaning who can put it in their KPI Scorecard portlet. You can base this definition on roles, departments, subsidiaries, groups, employees, or partners. See Sharing a Custom KPI Scorecard.

7. When you have completed all steps to define the scorecard, click Save.

You can use SuiteCloud Development Framework (SDF) to manage KPI scorecards as part of file-based customization projects. For information about SDF, see the help topic SuiteCloud Development Framework Overview. You can use the Copy to Account feature to copy an individual KPI scorecard to another of your accounts. Each KPI Scorecard page has a clickable Copy to Account option in the upper right corner. For information about Copy to Account, see the help topic Copy to Account Overview.

**Entering Basic Scorecard Information**

To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For more information, see Creating a KPI Scorecard. Then you can enter basic scorecard information at the top of the page.

**To enter basic KPI scorecard information:**

1. Enter a Name for the KPI scorecard. This name will appear as the title of portlets displaying this scorecard.

   By default, your name appears in the Owner dropdown list. If you are an administrator, you can define a different owner by selecting a different name.

2. If you want the KPI data to be calculated according to accounting periods rather than date ranges, check the Use Periods box.

   When Use Periods is selected:
   - The name of the Date Ranges subtab changes to Periods.
   - Only saved searches with a Period filter defined under Available Filters are available for use as custom KPIs in this scorecard.
■ You may encounter issues with KPI scorecard data if you have not set up accounting periods, or if you have not set the Report by Period preference to All Reports on the Analytics tab of the Set Preferences page.

3. (Optional) Enter a Description for the scorecard.

Defining KPI Scorecard Comparisons

You can define KPI scorecard comparisons when you are creating a new scorecard or editing an existing scorecard.

■ To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.

■ To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click Edit next to the KPI scorecard you want to edit.

**To define KPI scorecard comparisons:**

1. Click Customize from the KPI scorecard portlet dropdown list.
2. On the KPIs subtab of the Content subtab, select a KPI from the KPI list.
3. In the Compare Value to list, select a KPI to compare to the first KPI you selected.
4. If you selected a custom KPI from either dropdown list, go to the Custom subtab, and in the corresponding custom KPI list there, select the saved search to be used as the basis for the custom KPI.
   
   Only saved searches with a date field defined under Available Filters are available for use as custom KPIs in scorecards. The exception is if you enable the Use Periods option for a scorecard. Then only saved searches with a Period filter defined under Available Filters are available.

   Note that KPI scorecard custom KPI definitions are different from Key Performance Indicators portlet custom KPI definitions. For more information, see Custom KPIs.

5. Check Compare with Previous if you want to compare the results of this comparison to the comparison defined in the row above this one on the KPIs subtab.

6. Select one of the following comparison types:
   
   ■ Variance (Percent) : 100*(B-A)/A
   ■ Variance (Absolute) : B-A
   ■ Ratio (Percent) : 100*B/A
   ■ Ratio (Absolute) : B/A
   ■ Sum : A + B

7. Check Invert Comparison if you want to invert the operation used to calculate the comparison type.

8. Enter a Label for the KPI if you want something other than the KPI name to display as a row or column header in the portlet.

9. Click Add, if you are adding a new KPI to the scorecard, or OK, if you are editing an existing KPI entry.)
Creating a KPI Scorecard

Warning: KPI scorecards do not support results that are unions of two comparisons. If you enter a KPI comparison as a row on the KPIs subtab and also enter a date range comparison on the Date Ranges subtab, that KPI comparison displays a result of N/A in the KPI Scorecard portlet. To work around this limitation, try defining the comparison as a formula instead. For example, instead of entering Quota for KPI, Sales for Compare Value To, and Variance (Percent) for Comparison Type, enter Formula (Percent) for KPI and (SALES)/(QUOTA) for Formula. See Defining KPI Scorecard Formulas.

Defining KPI Scorecard Formulas

You can define formulas to calculate KPI comparisons when you are creating a new scorecard or editing an existing scorecard. These formulas are similar to those used in Excel, and can include functions and KPI IDs. A Formula popup page, available from the KPI scorecard record, provides dropdown menus that you can use to build formula expressions.

■ To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.
■ To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click Edit next to the KPI scorecard you want to edit.

Warning: KPI scorecards do not support results that are unions of two comparisons. If you enter a KPI comparison as a row on the KPIs subtab and also enter a date range comparison on the Date Ranges subtab, that KPI comparison displays a result of N/A in the KPI Scorecard portlet. To work around this limitation, try defining the comparison as a formula instead. For example, instead of entering Quota for KPI, Sales for Compare Value To, and Variance (Percent) for Comparison Type, enter Formula (Percent) for KPI and (SALES)/(QUOTA) for Formula. See Defining KPI Scorecard Comparisons.

To define KPI scorecard formulas:

1. Click Customize from the KPI scorecard portlet dropdown list.
2. On the KPIs subtab of the Content subtab, select a formula from the KPI list. The following choices are available:
   ■ Formula (Currency)
   ■ Formula (Numeric)
   ■ Formula (Percent)
3. Enter the formula’s expression in the Formula column. Click the Set Formula icon to open the Formula popup. In this popup, you can:
   ■ Select from the Function list to add functions to the formula.
   ■ Select from the KPIs dropdown list to add KPI IDs to the formula. For a list of IDs and their corresponding KPI names, see KPI IDs Available for Scorecard Formulas.
   ■ Edit the formula directly in the Formula field.
   When you have finished entering the expression, click Set.
4. If you included a custom KPI in a formula, go to the Custom subtab, and in the corresponding custom KPI list, select the saved search to be used as the basis for the custom KPI.
   Only saved searches with a date field defined under Available Filters are available for use as custom KPIs in scorecards. The exception is if you enable the Use Periods option for a scorecard. Then only saved searches with a Period filter defined under Available Filters are available.
   KPI scorecard custom KPI definitions are independent of the custom KPIs selected for display in the Key Performance Indicators portlet. For more information, see Custom KPIs.
5. If lower values are preferable for this formula's results, check the box in the **Less is More** column. When this option is enabled, downward arrows are green and upward arrows are red in the KPI scorecard portlet. (The default is the reverse.)

6. If you do not want this formula's results to display in the scorecard, check the **Hidden** box. This option is available so you can use a formula as the basis for another displayed comparison.

7. Enter a **Label** for the formula. This label appears as a row or column header in the portlet.

8. Click **Add**, if you are adding a new KPI to the scorecard, or **OK**, if you are editing an existing KPI entry.

### KPI IDs Available for Scorecard Formulas

The following table lists the KPI IDs that are available for use in KPI scorecard formulas. For a description of each KPI, see Standard Key Performance Indicators Table.

<table>
<thead>
<tr>
<th>KPI Name</th>
<th>KPI ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorized Commission</td>
<td>COMMISSIONS</td>
</tr>
<tr>
<td>Authorized Partner Commission</td>
<td>COMMISSIONSPARTNER</td>
</tr>
<tr>
<td>Bank Balance</td>
<td>BANKBAL</td>
</tr>
<tr>
<td>Cart Abandonment</td>
<td>CARTABANDON</td>
</tr>
<tr>
<td>Cases Closed</td>
<td>CLOSEDCASES</td>
</tr>
<tr>
<td>Cases Escalated</td>
<td>ESCALATEDCASES</td>
</tr>
<tr>
<td>Checkout Abandonment</td>
<td>CHECKOUTABANDON</td>
</tr>
<tr>
<td>Closed Issues</td>
<td>CLOSEDISSUES</td>
</tr>
<tr>
<td>COGS</td>
<td>COGS</td>
</tr>
<tr>
<td>Credit Card Balance</td>
<td>CREDITCARDBAL</td>
</tr>
<tr>
<td>Custom KPI #1</td>
<td>CUSTOM</td>
</tr>
<tr>
<td>Custom KPI #2</td>
<td>CUSTOM2</td>
</tr>
<tr>
<td>Custom KPI #3</td>
<td>CUSTOM3</td>
</tr>
<tr>
<td>Custom KPI #4</td>
<td>CUSTOM4</td>
</tr>
<tr>
<td>Custom KPI #5</td>
<td>CUSTOM5</td>
</tr>
<tr>
<td>Custom KPI #6</td>
<td>CUSTOM6</td>
</tr>
<tr>
<td>Custom KPI #7</td>
<td>CUSTOM7</td>
</tr>
<tr>
<td>Custom KPI #8</td>
<td>CUSTOM8</td>
</tr>
<tr>
<td>Custom KPI #9</td>
<td>CUSTOM9</td>
</tr>
<tr>
<td>Custom KPI #10</td>
<td>CUSTOM10</td>
</tr>
<tr>
<td>Deferred Revenue</td>
<td>DEFERREDREVENUE</td>
</tr>
<tr>
<td>Employees</td>
<td>EMPLOYEES</td>
</tr>
<tr>
<td>Equity</td>
<td>EQUITY</td>
</tr>
<tr>
<td>KPI Name</td>
<td>KPI ID</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Estimated Commission</td>
<td>ECOMMISSIONS</td>
</tr>
<tr>
<td>Estimated Partner Commission</td>
<td>ECOMMISSIONSPARTNER</td>
</tr>
<tr>
<td>Expenses</td>
<td>EXPENSES</td>
</tr>
<tr>
<td>Fixed Assets</td>
<td>FIXEDASSET</td>
</tr>
<tr>
<td>Forecast</td>
<td>FORECAST</td>
</tr>
<tr>
<td>Forecast (Alt. Sales)</td>
<td>FORECASTASA</td>
</tr>
<tr>
<td>Forecast Override</td>
<td>FORECASTOVERRIDE</td>
</tr>
<tr>
<td>Forecast Override (Alt. Sales)</td>
<td>FORECASTOVERRIDEASA</td>
</tr>
<tr>
<td>Gross New Leads</td>
<td>NEWLEADSGROSS</td>
</tr>
<tr>
<td>Hosted Page Hits</td>
<td>HOSTEDSITETRAFFIC</td>
</tr>
<tr>
<td>Income</td>
<td>INCOME</td>
</tr>
<tr>
<td>Inventory</td>
<td>INVENTORY</td>
</tr>
<tr>
<td>Long Term Liabilities</td>
<td>LONGTERMLIAB</td>
</tr>
<tr>
<td>My Utilization</td>
<td>UTILIZATION</td>
</tr>
<tr>
<td>Net Cash Flow</td>
<td>NETCASHFLOW</td>
</tr>
<tr>
<td>New Business</td>
<td>NEWBUSINESS</td>
</tr>
<tr>
<td>New Business (Orders Alt. Sales)</td>
<td>NEWBUSINESSORDALT</td>
</tr>
<tr>
<td>New Business (Sales Orders)</td>
<td>NEWBUSINESSORD</td>
</tr>
<tr>
<td>New Cases</td>
<td>NEWCASES</td>
</tr>
<tr>
<td>New Customers</td>
<td>NEWCUSTOMERS</td>
</tr>
<tr>
<td>New Customers (Sales Orders)</td>
<td>NEWCUSTOMERSORD</td>
</tr>
<tr>
<td>New Issues</td>
<td>NEWISSUES</td>
</tr>
<tr>
<td>New Leads</td>
<td>NEWLEADS</td>
</tr>
<tr>
<td>New Opportunities</td>
<td>NEWOPPORTUNITIES</td>
</tr>
<tr>
<td>New Visitors</td>
<td>NEWVISITORS</td>
</tr>
<tr>
<td>Open Cases</td>
<td>OPENCASES</td>
</tr>
<tr>
<td>Open Estimates</td>
<td>ESTIMATESRANGE</td>
</tr>
<tr>
<td>Open Issues</td>
<td>OPENISSUES</td>
</tr>
<tr>
<td>Open Opportunities</td>
<td>OPPORTUNITIESRANGE</td>
</tr>
<tr>
<td>Open Prospects</td>
<td>PROSPECTS</td>
</tr>
<tr>
<td>Open Quotes</td>
<td>ESTIMATESRANGE</td>
</tr>
<tr>
<td>Operating Cash Flow</td>
<td>OPERCASHFLOW</td>
</tr>
<tr>
<td>KPI Name</td>
<td>KPI ID</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Operating Expenses</td>
<td>OPERATINGEXPENSES</td>
</tr>
<tr>
<td>Opportunities Lost</td>
<td>OPPORTUNITIESLOST</td>
</tr>
<tr>
<td>Opportunities Won</td>
<td>OPPORTUNITIESWON</td>
</tr>
<tr>
<td>Orders</td>
<td>ORDERS</td>
</tr>
<tr>
<td>Other Assets</td>
<td>OTHERASSET</td>
</tr>
<tr>
<td>Other Current Assets</td>
<td>OTHERCURRENTASSET</td>
</tr>
<tr>
<td>Other Current Liabilities</td>
<td>OTHERCURRENTLIAB</td>
</tr>
<tr>
<td>Paid Commission</td>
<td>PCOMMISSIONS</td>
</tr>
<tr>
<td>Paid Partner Commission</td>
<td>PCOMMISSIONSPARTNER</td>
</tr>
<tr>
<td>Payables</td>
<td>PAYABLES</td>
</tr>
<tr>
<td>Payroll</td>
<td>PAYROLL</td>
</tr>
<tr>
<td>Pipeline (Alt. Sales Projected)</td>
<td>PIPELINEASA</td>
</tr>
<tr>
<td>Pipeline (Alt. Sales Weighted)</td>
<td>PIPELINEWEIGHTEDASA</td>
</tr>
<tr>
<td>Pipeline (Projected)</td>
<td>PIPELINE</td>
</tr>
<tr>
<td>Pipeline (Weighted)</td>
<td>PIPELINEWEIGHTED</td>
</tr>
<tr>
<td>Pipeline Deals</td>
<td>PIPELINEDEALS</td>
</tr>
<tr>
<td>Profit</td>
<td>PROFIT</td>
</tr>
<tr>
<td>Quota</td>
<td>QUOTA</td>
</tr>
<tr>
<td>Quota (Alt. Sales)</td>
<td>QUOTAASA</td>
</tr>
<tr>
<td>Quota Reps</td>
<td>QUOTAREPS</td>
</tr>
<tr>
<td>Receivables</td>
<td>RECEIVABLES</td>
</tr>
<tr>
<td>Revenue</td>
<td>REVENUE</td>
</tr>
<tr>
<td>Sales</td>
<td>SALES</td>
</tr>
<tr>
<td>Sales (Cash Basis)</td>
<td>SALESCASHBASIS</td>
</tr>
<tr>
<td>Sales (Orders)</td>
<td>BOOKINGS</td>
</tr>
<tr>
<td>Sales (Orders Alt. Sales)</td>
<td>BOOKINGSALT</td>
</tr>
<tr>
<td>Total Open Opportunities</td>
<td>OPPORTUNITIES</td>
</tr>
<tr>
<td>Total Open Quotes</td>
<td>ESTIMATES</td>
</tr>
<tr>
<td>Total Orders (Count)</td>
<td>TOTALORDERS</td>
</tr>
<tr>
<td>Total Pipeline (Alt. Sales Projected)</td>
<td>TOTALPIPELINEASA</td>
</tr>
<tr>
<td>Total Pipeline (Alt. Sales Weighted)</td>
<td>TOTALPIPEWEIGHTEDASA</td>
</tr>
<tr>
<td>Total Pipeline (Projected)</td>
<td>TOTALPIPELINE</td>
</tr>
</tbody>
</table>
Creating a KPI Scorecard

<table>
<thead>
<tr>
<th>KPI Name</th>
<th>KPI ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Pipeline (Weighted)</td>
<td>TOTALPIPEWEIGHTED</td>
</tr>
<tr>
<td>Total Pipeline Deals</td>
<td>TOTALPIPEDEALS</td>
</tr>
<tr>
<td>Total Sales (Orders)</td>
<td>TOTALBOOKINGS</td>
</tr>
<tr>
<td>Unique Visitors</td>
<td>VISITORTRAFFIC</td>
</tr>
<tr>
<td>Web Orders</td>
<td>WEBORDERS</td>
</tr>
<tr>
<td>Web Revenue</td>
<td>WEBREVENUE</td>
</tr>
<tr>
<td>Web Site Hits</td>
<td>SITETRAFFIC</td>
</tr>
</tbody>
</table>

You can enter KPI IDs in a scorecard formula by selecting a KPI name from the KPI dropdown list in the scorecard's Formula popup window. Open this popup by clicking on the Set Formula icon that is available when you add a formula to the scorecard's KPIs subtab. For more information, see Defining KPI Scorecard Formulas.

If you include a custom KPI's ID in a scorecard's formula, you need to go to the scorecard's Custom subtab, and select a saved search in the corresponding custom KPI dropdown list there.

For an example of how to use formulas in KPI scorecards, check out NetSuite's prebuilt Financial Ratios scorecard that is available to users with permission to see the Trial Balance report. You can review the formulas in this scorecard as examples. See Financial Ratios Scorecard Formulas.

Defining KPI Scorecard Date Ranges or Periods

You can define the date ranges to use in KPI data calculations when you are creating a new scorecard or editing an existing scorecard.

- To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.
- To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click Edit next to the KPI scorecard you want to edit.

For lists of date and period ranges available for KPI scorecard comparisons, see Date Ranges for KPI Scorecards and Period Ranges for KPI Scorecards.

**Note:** If you have checked the Use Periods box on a KPI scorecard, you need to define periods rather than date ranges, and the name of the Date Ranges subtab is changed to Periods. Please note that you cannot clear the Use Periods box after the KPI scorecard has been saved.

To define date ranges for a KPI scorecard:

1. On the Date Ranges subtab of the Content subtab, in the Range column, specify date ranges to be applied to all KPI scorecard data.
2. In the Compare Value to field, select a date range to compare to the first range you selected.
3. Check Compare with Previous if you want to compare the results for this comparison to the date ranges listed above this one.
4. Select one of the following comparison types:
   - Variance (Percent) : 100\*(B-A)/A
   - Variance (Absolute) : B-A
Creating a KPI Scorecard

- **Ratio (Percent)**: \(100 \times \frac{B}{A}\)
- **Ratio (Absolute)**: \(\frac{B}{A}\)
- **Sum**: \(A + B\)

5. Check the box in the **Invert Comparison** column if you want to invert the operation used to calculate the comparison type.

6. Enter a **Label** for this date range. This label appears as a column or row header in the portlet.

7. Click **Add**, if you are adding a new KPI to the scorecard, or **OK**, if you are editing an existing KPI entry).

If you select multiple relative date ranges, such as 2 months ago, you can display the explicit dates in the KPI Scorecard portlet, by checking the Show Date Row box in the KPI Scorecard Setup dialog. See [Adding a KPI Scorecard Portlet to a Dashboard](#).

**Warning:** KPI scorecards do not support results that are unions of two comparisons. If you enter a KPI comparison as a row on the **KPIs** subtab and also enter a date range comparison on the **Date Ranges** subtab, that KPI comparison displays a result of N/A in the KPI Scorecard portlet. To work around this limitation, try defining the comparison as a formula instead. For example, instead of entering **Quota** for **KPI**, **Sales** for **Compare Value To**, and **Variance (Percent)** for **Comparison Type**, enter **Formula (Percent)** for **KPI** and \((\text{SALES})/(\text{QUOTA})\) for **Formula**. See [Defining KPI Scorecard Formulas](#).

**Date Ranges for KPI Scorecards**

Below, in alphabetical order, are the date ranges that you can select for comparisons on the Date Ranges subtab of a KPI Scorecard page.

**Note:** If you check the Use Periods box on this page, period ranges are listed on a Periods subtab instead. See [Period Ranges for KPI Scorecards](#).

- April last year
- April last year to date
- April this year
- August last year
- August last year to date
- August this year
- August this year to date
- December last year
- December last year to date
- December this year
- December this year to date
- February last year
- February last year to date
- February this year
- February this year to date
- January last year
- January last year to date

Dashboards
■ January this year
■ January this year to date
■ January through April last year
■ January through April this year
■ January through August last year
■ January through August this year
■ January through February last year
■ January through February this year
■ January through July last year
■ January through July this year
■ January through June last year
■ January through June this year
■ January through March last year
■ January through March this year
■ January through May last year
■ January through May this year
■ January through November last year
■ January through November this year
■ January through October last year
■ January through October this year
■ January through September last year
■ January through September this year
■ July last year
■ July last year to date
■ July this year
■ July this year to date
■ June last year
■ June last year to date
■ June this year
■ June this year to date
■ March last year
■ March last year to date
■ March this year
■ March this year to date
■ May last year
■ May last year to date
■ May this year
■ May this year to date
■ November last year
■ November last year to date

Dashboards
■ November this year
■ November this year to date
■ October last year
■ October last year to date
■ October this year
■ October this year to date
■ September last year
■ September last year to date
■ September this year
■ September this year to date
■ calendar week 2 last month
■ calendar week 2 same month last fiscal quarter
■ calendar week 2 same month last fiscal year
■ calendar week 2 this month
■ calendar week 3 last month
■ calendar week 3 same month last fiscal quarter
■ calendar week 3 same month last fiscal year
■ calendar week 3 this month
■ calendar week 4 last month
■ calendar week 4 same month last fiscal quarter
■ calendar week 4 same month last fiscal year
■ calendar week 4 this month
■ first 2 weeks last month (first 14 days)
■ first 2 weeks same month last fiscal quarter (first 14 days)
■ first 2 weeks same month last fiscal year (first 14 days)
■ first 2 weeks this month (first 14 days)
■ first 3 weeks last month (first 21 days)
■ first 3 weeks same month last fiscal quarter (first 21 days)
■ first 3 weeks same month last fiscal year (first 21 days)
■ first 3 weeks this month (first 21 days)
■ first 4 weeks last month (first 28 days)
■ first 4 weeks same month last fiscal quarter (first 28 days)
■ first 4 weeks same month last fiscal year (first 28 days)
■ first 4 weeks this month (first 28 days)
■ first fiscal half fiscal year before last
■ first fiscal half fiscal year before last to date
■ first fiscal half last fiscal year
■ first fiscal half last fiscal year to date
■ first fiscal half this fiscal year
■ first fiscal half this fiscal year to date

Dashboards
Creating a KPI Scorecard

- first fiscal quarter fiscal year before last
- first fiscal quarter fiscal year before last to date
- first fiscal quarter last fiscal year
- first fiscal quarter last fiscal year to date
- first fiscal quarter this fiscal year
- first fiscal quarter this fiscal year to date
- first month fiscal quarter before last
- first month fiscal quarter before last to date
- first month last fiscal quarter
- first month last fiscal quarter to date
- first month same fiscal quarter fiscal year before last
- first month same fiscal quarter fiscal year before last to date
- first month same fiscal quarter last fiscal year
- first month same fiscal quarter last fiscal year to date
- first month this fiscal quarter
- first month this fiscal quarter to date
- first three fiscal quarters fiscal year before last
- first three fiscal quarters last fiscal year
- first three fiscal quarters this fiscal year
- first two fiscal quarters of fiscal year before last
- first two fiscal quarters of last fiscal year
- first two fiscal quarters of this fiscal year
- first two months fiscal quarter before last
- first two months last fiscal quarter
- first two months same fiscal quarter fiscal year before last
- first two months same fiscal quarter last fiscal year
- first two months this fiscal quarter
- fiscal half before last
- fiscal half before last to date
- fiscal quarter before last
- fiscal quarter before last to date
- fiscal year before last
- fiscal year before last to date
- five days ago
- five days from now
- four days ago
- four days from now
- four weeks starting this week
- fourth fiscal quarter fiscal year before last
- fourth fiscal quarter fiscal year before last to date
Creating a KPI Scorecard

- fourth fiscal quarter last fiscal year
- fourth fiscal quarter last fiscal year to date
- fourth fiscal quarter this fiscal year
- fourth fiscal quarter this fiscal year to date
- last business week
- last fiscal half
- last fiscal half one fiscal year ago
- last fiscal half to date
- last fiscal quarter
- last fiscal quarter one fiscal year ago
- last fiscal quarter to date
- last fiscal quarter two fiscal years ago
- last fiscal year
- last fiscal year to date
- last month
- last month one fiscal quarter ago
- last month one fiscal year ago
- last month to date
- last month two fiscal quarters ago
- last month two fiscal years ago
- last rolling half
- last rolling quarter
- last rolling year
- last week
- last week to date
- last year
- last year to date
- month after next
- month after next to date
- month before last
- month before last to date
- next business week
- next fiscal half
- next fiscal quarter
- next fiscal year
- next four weeks
- next month
- next one half
- next one month
- next one quarter
Creating a KPI Scorecard

- next one week (7 rolling days)
- next one year
- next week
- ninety days ago
- ninety days from now
- one year before last
- previous fiscal quarters last fiscal year
- previous fiscal quarters this fiscal year
- previous months last fiscal half
- previous months last fiscal quarter
- previous months last fiscal year
- previous months same fiscal half last fiscal year
- previous months same fiscal quarter last fiscal year
- previous months this fiscal half
- previous months this fiscal quarter
- previous months this fiscal year
- previous one day
- previous one half
- previous one month
- previous one quarter
- previous one week
- previous one year
- previous rolling half
- previous rolling quarter
- previous rolling year
- same day fiscal quarter before last
- same day fiscal year before last
- same day last fiscal quarter
- same day last fiscal year
- same half last fiscal year
- same day last month
- same day last week
- same day month before last
- same day week before last
- same fiscal half last fiscal year
- same fiscal half last fiscal year to date
- same fiscal quarter fiscal year before last
- same fiscal quarter last fiscal year
- same fiscal quarter last fiscal year to date
- same month fiscal quarter before last
■ same month fiscal year before last
■ same month last fiscal quarter
■ same months last fiscal quarter to date
■ same month last fiscal year
■ same month last fiscal year to date
■ same week fiscal year before last
■ same week last fiscal year
■ second fiscal half fiscal year before last
■ second fiscal half fiscal year before last to date
■ second fiscal half last fiscal year
■ second fiscal half last fiscal year to date
■ second fiscal half this fiscal year
■ second fiscal half this fiscal year to date
■ second fiscal quarter fiscal year before last
■ second fiscal quarter fiscal year before last to date
■ second fiscal quarter last fiscal year
■ second fiscal quarter last fiscal year to date
■ second fiscal quarter this fiscal year
■ second fiscal quarter this fiscal year to date
■ second month fiscal quarter before last
■ second month fiscal quarter before last to date
■ second month last fiscal quarter
■ second month last fiscal quarter to date
■ second month same fiscal quarter fiscal year before last
■ second month same fiscal quarter fiscal year before last to date
■ second month same fiscal quarter last fiscal year
■ second month same fiscal quarter last fiscal year to date
■ second month this fiscal quarter
■ second month this fiscal quarter to date
■ sixty days ago
■ sixty days from now
■ start of last month to end of its first week
■ start of last month to end of its fourth week
■ start of last month to end of its second week
■ start of last month to end of its third week
■ start of same month last fiscal quarter to end of its first week
■ start of same month last fiscal quarter to end of its fourth week
■ start of same month last fiscal quarter to end of its second week
■ start of same month last fiscal quarter to end of its third week
■ start of same month last fiscal year to end of its first week
- start of same month last fiscal year to end of its fourth week
- start of same month last fiscal year to end of its second week
- start of same month last fiscal year to end of its third week
- start of this month to end of its first week
- start of this month to end of its fourth week
- start of this month to end of its second week
- start of this month to end of its third week
- start of week 5 last month to end of last month
- start of week 5 same month last fiscal quarter to end of that month
- start of week 5 same month last fiscal year to end of that month
- start of week 5 this month to end of this month
- ten days ago
- ten days from now
- third fiscal quarter fiscal year before last
- third fiscal quarter fiscal year before last to date
- third fiscal quarter last fiscal year
- third fiscal quarter last fiscal year to date
- third fiscal quarter this fiscal year
- third fiscal quarter this fiscal year to date
- third month fiscal quarter before last
- third month fiscal quarter before last to date
- third month last fiscal quarter
- third month last fiscal quarter to date
- third month same fiscal quarter fiscal year before last
- third month same fiscal quarter fiscal year before last to date
- third month same fiscal quarter last fiscal year
- third month same fiscal quarter last fiscal year to date
- third month this fiscal quarter
- third month this fiscal quarter to date
- thirty days ago
- thirty days from now
- this business week
- this fiscal half
- this fiscal half to date
- this fiscal quarter
- this fiscal quarter to date
- this fiscal year
- this fiscal year to date
- this month
- this month to date
Creating a KPI Scorecard

- this rolling half
- this rolling quarter
- this rolling year
- this week
- this week to date
- this year
- this year to date
- three days ago
- three fiscal quarters ago
- three fiscal quarters ago to date
- three fiscal years ago
- three fiscal years ago to date
- three months ago
- three months ago to date
- today
- today to end of this month
- tomorrow
- two days ago
- two days from now
- week 1 last month (days 1–7)
- week 1 same month last fiscal quarter (days 1–7)
- week 1 same month last fiscal year (days 1–7)
- week 1 this month (days 1–7)
- week 2 last month (days 8–14)
- week 2 same month last fiscal quarter (days 8–14)
- week 2 same month last fiscal year (days 8–14)
- week 2 this month (days 8–14)
- week 3 last month (days 15–21)
- week 3 same month last fiscal quarter (days 15–21)
- week 3 same month last fiscal year (days 15–21)
- week 3 this month (days 15–21)
- week 4 last month (days 22–28)
- week 4 same month last fiscal quarter (days 22–28)
- week 4 same month last fiscal year (days 22–28)
- week 4 this month (days 22–28)
- week 5 last month (day 29–month's end)
- week 5 same month last fiscal quarter (day 29–month's end)
- week 5 same month last fiscal year (day 29–month's end)
- week 5 this month (day 29–month's end)
- week after next
- week after next to date
- week before last
- week before last to date
- yesterday
- 1 day ago
- 2 days ago
- 3 days ago
- 4 days ago
- 5 days ago
- 6 days ago
- 7 days ago
- 1 week ago
- 2 weeks ago
- 3 weeks ago
- 4 weeks ago
- 5 weeks ago
- 6 weeks ago
- 7 weeks ago
- 8 weeks ago
- 1 month ago
- 2 months ago
- 3 months ago
- 4 months ago
- 5 months ago
- 6 months ago
- 7 months ago
- 8 months ago
- 9 months ago
- 10 months ago
- 11 months ago
- 12 months ago
- 1 fiscal quarter ago
- 2 fiscal quarters ago
- 3 fiscal quarters ago
- 4 fiscal quarters ago
- 5 fiscal quarters ago
- 6 fiscal quarters ago
- 7 fiscal quarters ago
- 8 fiscal quarters ago
- 1 fiscal half ago
Period Ranges for KPI Scorecards

If you check the Use Periods box on a KPI Scorecard page, you can select the following period ranges, on the Periods subtab, for scorecard comparisons.

**Note:** If you do not check the Use Periods box, date ranges are listed on a Date Ranges subtab instead. See Date Ranges for KPI Scorecards.

The following period ranges are listed alphabetically:

- First Fiscal Quarter Last FY
- First Fiscal Quarter This FY
- Fiscal Quarter Before Last
- Fiscal Year Before Last
- Fourth Fiscal Quarter Last FY
- Fourth Fiscal Quarter This FY
- Last Fiscal Quarter
- Last Fiscal Quarter One Fiscal Year Ago
- Last Fiscal Quarter to Period
- Last Fiscal Year
- Last Fiscal Year to Period
- Last Period
- Last Period One Fiscal Quarter Ago
- Last Period One Fiscal Year Ago
- Last Rolling 18 Periods
- Last Rolling 6 Fiscal Quarters
- Period Before Last
- Same Fiscal Quarter Last FY
- Same Fiscal Quarter Last FY to Period
- Same Period Last FY
- Same Period Last Fiscal Quarter
- Second Fiscal Quarter Last FY
- Second Fiscal Quarter This FY
- Third Fiscal Quarter Last FY
- Third Fiscal Quarter This FY
- This Fiscal Quarter
- This Fiscal Quarter to Period
- This Fiscal Year
- This Fiscal Year to Period
- This Period

After the alphabetical list, the following periods are listed chronologically: each fiscal year, quarter, and month for the periods set up in your system. For more information about accounting periods, see the help topic Accounting Period Setup.

Highlighting KPI Scorecard Results

You can set up highlighting of KPI scorecard results when you are creating a new scorecard or editing an existing scorecard. Highlighting makes results more visible in the KPI Scorecard portlet.

To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.

To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click Edit next to the KPI scorecard you want to edit.

To set highlighting options for a result in a KPI scorecard:

1. Select a KPI from the dropdown list.
2. Select an option in the Highlight If... column, to indicate how the result should be compared to the Threshold value. The following options are available:
   - Always
   - Less Than
   - Greater Than
   - Magnitude Greater Than
   - Magnitude Less Than
3. Enter a Threshold value.
4. Select the **Date Range** or **Period** to determine whether highlighting should be applied when the comparison with the threshold is performed. The available options include All and the date ranges or periods set on the **Date Ranges** or **Periods** subtab.

5. You can use any of the following options to specify the highlighting to be applied to the results that exceed or fall short of the specified **Threshold** value.
   - Use the **Image** column to select an image to be displayed with the highlighted result in the KPI scorecard portlet.
   - Use the **Text Color** column to select a text color other than the default for the highlighted result.
   - Use the **Background Color** column to select a background color other than the default for the highlighted result.
   - Check the box in the **Bold** column to display the highlighted result in bold text.
   - Check the box in the **Headline** column to display the highlighted result as a headline, in large bold text at the top of the KPI Scorecard portlet.

   **Note:** Up to four scorecard results can be displayed as headlines.

You can see the results in your KPI Scorecard portlet:

Sharing a Custom KPI Scorecard

You can define an audience for your KPI scorecard when you are creating a new scorecard or editing an existing scorecard. Members of that audience can display your custom scorecard in their KPI Scorecard portlets. You can base the audience definition on roles, departments, subsidiaries, groups, employees, or partners.

- To create a new KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards > New. For more information, see Creating a KPI Scorecard, and Entering Basic Scorecard Information.
- To edit an existing KPI scorecard, go to Customization > Centers and Tabs > KPI Scorecards and click Edit next to the KPI scorecard you want to edit.
To define an audience for a KPI scorecard:

1. On the KPI Scorecard record, click the Audience subtab.
2. Use the list boxes provided to define the audience with whom you want to share the portlet. You can check a Select All box to include everyone or select individual list items, holding down the Ctrl key.
3. Click Save.

Editing a KPI Scorecard

If you own a KPI scorecard, you can make changes to it. To open a custom KPI scorecard, you can:

- In the KPI Scorecard portlet, click Edit, or
- Go to Customization > Centers and Tabs > KPI Scorecards and click Edit next to the scorecard.

If you want to customize a prebuilt KPI scorecard, you can open it and make changes, then save it with a different name. To open a prebuilt KPI scorecard, you can:

- In the KPI Scorecard portlet, click Customize, or
- Go to Setup > Customization > KPI Scorecards and click Customize next to the scorecard.

You can perform the following tasks:

- Entering Basic Scorecard Information
- Defining KPI Scorecard Comparisons
- Defining KPI Scorecard Formulas
- Defining KPI Scorecard Date Ranges or Periods
- Highlighting KPI Scorecard Results
- Sharing a Custom KPI Scorecard

Financial Ratios Scorecard

NetSuite provides a prebuilt Financial Ratios scorecard to help you analyze your business's financial position and operating efficiency. This scorecard includes metrics built with embedded formulas that incorporate standard NetSuite key performance indicators (KPIs).

The scorecard displays metrics for the current accounting period and the previous accounting period, and shows the percentage change between periods for each metric. Metrics include:

- Current Ratio
- Receivables Turnover
- Days Sale Outstanding
- Inventory Turnover
- Days Inventory on Hand
- Asset Turnover
- Profit Margin on Sales
- Return on Assets
- Return on Equity
Financial Ratios Scorecard

- Debt to Total Assets
- Debt to Equity

To view the formulas used to calculate these metrics, see Financial Ratios Scorecard Formulas.

The Financial Ratios scorecard’s data is based on a set of NetSuite standard reports, and you can click on the scorecard’s metrics to drill down into each of the detailed reports. By default, the scorecard is available to you only if you have permission to view the Trial Balance report. If you have this permission, you can display this scorecard in your KPI Scorecard portlet.

Administrators can review this scorecard’s definitions and modify them to create a custom Financial Ratios scorecard, including giving permission to additional users to display the scorecard on their dashboard by changing the audience for the scorecard. For information, see Editing a KPI Scorecard.

Note: You may encounter issues viewing Financial Ratios scorecard data if you have not set up accounting periods or if you have not set the Report by Period preference to All Reports at Home > Set Preferences, the Analytics tab.

To display the Financial Ratios scorecard on your dashboard:

1. Add a KPI Scorecard portlet to your dashboard.
   1. On the page where you want to see the scorecard, click Personalize.
   2. In the Personalize Dashboard panel, click the KPI Scorecard icon or drag it onto the dashboard.
2. In the KPI Scorecard portlet’s menu, click Set Up.
3. Select Financial Ratios from the KPI Scorecard list, and click Save.

To review the Financial Ratios scorecard formulas:

- Go to Customization > Centers and Tabs > KPI Scorecards, and in the KPI Scorecards list, click Financial Ratios.

To customize the Financial Ratios scorecard:

1. In the Financial Ratios KPI Scorecard portlet, click Customize in the portlet’s menu, or go to Customization > Centers and Tabs > KPI Scorecards, and click Customize next to Financial Ratios.
2. Notice that the name of the scorecard is changed automatically. You can make additional changes and click Save. For information, see Editing a KPI Scorecard.

Financial Ratios Scorecard Formulas

The following table lists the formulas used to calculate data for the prebuilt Financial Ratios scorecard. This scorecard is available if you have permission to see the Trial Balance report. Formula components are standard NetSuite KPI IDs.

<table>
<thead>
<tr>
<th>Scorecard Ratio</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Ratio</td>
<td>((BANKBAL) + (RECEIVABLES) + (OTHERCURRENTASSET)) / ((PAYABLES) + (CREDITCARDBAL) + (OTHERCURRENTLIAB))</td>
</tr>
<tr>
<td>Receivables</td>
<td>(SALES) / (RECEIVABLES)</td>
</tr>
<tr>
<td>Days Sales Outstanding</td>
<td>(DAYS) / ((SALES) / (RECEIVABLES))</td>
</tr>
<tr>
<td>Scorecard Ratio</td>
<td>Formula</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Inventory Turnover</td>
<td>( \frac{\text{COGS}}{\text{INVENTORY}} )</td>
</tr>
<tr>
<td>Days Inventory On Hand</td>
<td>( \frac{\text{DAYS}}{\left( \frac{\text{COGS}}{\text{INVENTORY}} \right)} )</td>
</tr>
<tr>
<td>Asset Turnover</td>
<td>( \frac{\text{SALES}}{\left( \frac{\text{BANKBAL}+\text{RECEIVABLES}+\text{OTHERCURRENTASSET}+\text{FIXEDASSET}+\text{OTHERASSET}}{} \right)} )</td>
</tr>
<tr>
<td>Profit Margin on Sales</td>
<td>( \frac{\text{PROFIT}}{\text{INCOME}} )</td>
</tr>
<tr>
<td>Return on Assets</td>
<td>( \frac{\text{PROFIT}}{\left( \frac{\text{BANKBAL}+\text{RECEIVABLES}+\text{OTHERCURRENTASSET}+\text{FIXEDASSET}+\text{OTHERASSET}}{} \right)} )</td>
</tr>
<tr>
<td>Return on Equity</td>
<td>( \frac{\text{PROFIT}}{\text{EQUITY}} )</td>
</tr>
<tr>
<td>Debt to Total Assets</td>
<td>( \frac{\left( \text{PAYABLES}+\text{CREDITCARDBAL}+\text{OTHERCURRENTLIAB}+\text{LONGTERMLIAB} \right)}{\left( \frac{\text{BANKBAL}+\text{RECEIVABLES}+\text{OTHERCURRENTASSET}+\text{FIXEDASSET}+\text{OTHERASSET}}{} \right)} )</td>
</tr>
<tr>
<td>Debt to Equity</td>
<td>( \frac{\left( \text{PAYABLES}+\text{CREDITCARDBAL}+\text{OTHERCURRENTLIAB}+\text{LONGTERMLIAB} \right)}{\text{EQUITY}} )</td>
</tr>
</tbody>
</table>

- For more information about this scorecard, see Financial Ratios Scorecard.
- For information about the underlying report, see the help topic Trial Balance Report.
- For a list of standard KPI IDs, see KPI IDs Available for Scorecard Formulas.
- For a list of standard KPIs and descriptions, see Standard Key Performance Indicators Table.
- For information about adding formulas to KPI scorecards, see Defining KPI Scorecard Formulas.
Report Snapshots Overview

NetSuite includes a large number of standard reports that you can run to obtain detailed information about your business. For immediate access to reports’ summary data, NetSuite enables you to add Report Snapshot portlets to your dashboard. Report Snapshot portlets offer quick looks at important business results every time you view your dashboard.

Each Report Snapshot portlet displays a high-level summary of a report’s results for a selected date or time period. You can configure the number and order of results, and choose the format that is most useful for you, including four different chart types, or a list. You can define the look and feel of each chart by setting its theme and background. Additionally, you can expand the portlet to full-screen view by clicking the double arrow icon. Each portlet also includes menu options to print content, to download content to a PNG, JPG, PDF, or SVG file, and to view the underlying report’s detailed data.

When you roll over a data point in a report snapshot chart, its value displays.

Adding Report Snapshots

For instructions for adding Report Snapshot portlets to your dashboard, see Adding a Report Snapshot Portlet. The available snapshots vary according to enabled features, and each user’s roles and permissions. They may include the following:

- **Standard Report Snapshots** - You can select from a list of predefined report snapshots. See Standard Report Snapshots Table.
- **Sales Management Report Snapshots** - You can choose to view sales management report summaries rolled up to different levels of management hierarchy. See Sales Management Snapshots.

Using Report Snapshots

After you have added a report snapshot to your dashboard, you can configure the data that is displayed.

- Click thumbnails in the portlet to try different chart types.
Adding a Report Snapshot Portlet

You can add Report Snapshot portlets to some dashboard pages. The report snapshots that are available for display in a dashboard portlet depend on your role and the features you have enabled. A report snapshot is available to you if you have permission to view the underlying report's data.

To add a Report Snapshot portlet to a page:

1. Click Personalize in the upper right corner of the dashboard. You can also use the Personalize Dashboard link in the Settings portlet.
2. On the Report Snapshots tab of the Personalize Dashboard palette, click the Report Snapshots icon or drag it onto the dashboard.
   - If the Report Snapshots tab does not display in the Personalize Dashboard panel, it means you cannot add Report Snapshot portlets to this page.
3. Click Set Up in the portlet's menu to select the report snapshot you want to be displayed in the portlet.

The snapshots you have added appear in portlets on the page. When you log in, the information in each portlet refreshes.

- You can manually refresh report snapshot data at any time by clicking the portlet's Refresh icon.
- You can click a thumbnail in the portlet to change the type of chart used to display data. For most snapshots, choices are line, bar, column, or pie charts.
- You can change the dates for displayed report snapshot data using the dropdown list in the portlet.
- You can expand the portlet to full-screen view by clicking the double arrow icon.
- You can select a menu option to print the portlet content, to download content to a PNG, JPG, PDF, or SVG file, or to view the underlying report.
- You may be able to change layout options for report snapshot data by clicking Set Up, if it is available. Layout options include whether to display report results in a list or a graph, the default chart type for the graph, the theme and background for the chart, how many results to display, and the order in which to display results. For more information, see Setting Up a Report Snapshot Portlet.

Notes:

- Comparative sales report snapshots have different setup options than other types of report snapshots. For details, see Setup Options for Comparative Sales Report Snapshots.
Adding a Report Snapshot Portlet

- Report snapshot list text truncates at 25 characters when the report snapshot portlet is in the left or right dashboard column. To avoid this truncation, place the portlet in the middle column. Also, report snapshot list amounts are rounded to the nearest whole number and do not display decimal places.

Standard Report Snapshots Table

The following table lists NetSuite standard report snapshots, in alphabetical order. You can see the snapshots available by clicking **Set Up** in the Report Snapshot portlet's menu and checking the Snapshot list. You may see a subset of snapshots listed in the following table, depending upon your role and the features you have enabled.

![Note:](Note.png) A report snapshot is only available to you if you have permission to view the underlying report's data.

<table>
<thead>
<tr>
<th>Report Snapshot</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaigns By Activity</td>
<td>This snapshot shows the top campaigns by percent of campaign messages viewed during the date range you choose.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the Campaign Response Summary Report.</td>
</tr>
<tr>
<td>Campaigns By Profitability</td>
<td>This snapshot shows the top campaigns by profitability during the date range you choose.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the Campaign ROI Analysis Summary Report.</td>
</tr>
<tr>
<td>Comparative Sales</td>
<td>This line graph compares the total income and reimbursed expenses for customers in the periods you choose. It excludes the following transaction types—Journal, Deposit, Credit Card, Credit Card Refund and Check.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the Comparative Sales report.</td>
</tr>
<tr>
<td></td>
<td>This snapshot offers different setup options from other standard snapshots. For information, see Setup Options for Comparative Sales Report Snapshots.</td>
</tr>
<tr>
<td>Comparative Sales (Orders)</td>
<td>This line graph compares the total income for sales orders in the periods you choose. It excludes the following transaction types—Journal, Deposit, Credit Card, Credit Card Refund and Check.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the Comparative Sales (Orders) report.</td>
</tr>
<tr>
<td></td>
<td>This snapshot offers different setup options from other standard snapshots. For information, see Setup Options for Comparative Sales Report Snapshots.</td>
</tr>
<tr>
<td>Comparative Sales (Orders Alt. Sales)</td>
<td>This snapshot shows a comparison of the total dollar values of sales orders, based on alternate sales amounts (ASA) in the two date ranges you select. These values exclude the following transaction types: journal, deposit, credit card, credit card refund, and check.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the Comparative Sales (Alt. Sales) report.</td>
</tr>
<tr>
<td></td>
<td>This snapshot offers different setup options from other standard snapshots. For information, see Setup Options for Comparative Sales Report Snapshots.</td>
</tr>
<tr>
<td>Customers By Balance</td>
<td>This snapshot shows the customers with the largest account balances due for the date range you select.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the A/R Aging Summary Report.</td>
</tr>
<tr>
<td>Customers By Forecast</td>
<td>This snapshot shows the top customers by forecast during the time period you select. The forecast includes:</td>
</tr>
<tr>
<td></td>
<td>- total income and reimbursed expenses</td>
</tr>
<tr>
<td></td>
<td>- total value of open estimates that are set to be included in the forecast and are expected to close in the period you have selected</td>
</tr>
<tr>
<td>Report Snapshot</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>■ total value of open opportunities that are expected to close in the period you have selected and do not include an estimate that is set to appear in the forecast Note: The values of the estimates and opportunities that are included in the forecast depend on the preferences you have set at Setup &gt; Sales &gt; Preferences &gt; Sales Preferences on the Forecasts subtab.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the <a href="mailto:forecast@netsuite.com">Forecast by Customer Summary Report</a>.</td>
</tr>
<tr>
<td>Customers By Forecast Outstanding</td>
<td>This snapshot shows the top customers by outstanding forecast during the time period you select. This snapshot includes:</td>
</tr>
<tr>
<td></td>
<td>■ total value of open estimates that are set to be included in the forecast and are expected to close in the period you have selected</td>
</tr>
<tr>
<td></td>
<td>■ total value of open opportunities that are expected to close in the period you have selected and do not include an estimate that is set to appear in the forecast Note: The values of the estimates and opportunities that are included in the forecast depend on the preferences you have set at Setup &gt; Sales &gt; Preferences &gt; Sales Preferences on the Forecasts subtab.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the <a href="mailto:forecastoutstanding@netsuite.com">Forecast (Outstanding) by Customer Summary Report</a>.</td>
</tr>
<tr>
<td>Customers By Hosted Page Hits</td>
<td>This snapshot shows the top customers by hosted page hits in your website during the date range you choose.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the <a href="mailto:hostedpagehits@netsuite.com">Hosted Page Hits by Customer Report</a>.</td>
</tr>
<tr>
<td>Customers By Page Hits</td>
<td>This snapshot shows the top customers by page hits in your website during the date range you choose.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the <a href="mailto:pagehits@netsuite.com">Page Hits by Customer Report</a>.</td>
</tr>
<tr>
<td>Customers By Pipeline</td>
<td>This snapshot shows the top customers by pipeline. The pipeline includes the projected amount of open opportunities and open estimates expected to close in the date range you choose. This excludes the total of opportunities with estimates set to be included in the forecast.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the <a href="mailto:pipeline@netsuite.com">Pipeline by Customer Summary Report</a>.</td>
</tr>
<tr>
<td>Customers By Profitability</td>
<td>This snapshot shows the most profitable customers for the date range you select. Profit is calculated by subtracting cost from revenue.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the <a href="mailto:profitability@netsuite.com">Customer Profitability Summary Report</a>.</td>
</tr>
<tr>
<td>Customers By Sales</td>
<td>This snapshot shows the top customers by sales during the time period you select.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the <a href="mailto:sales@netsuite.com">Sales by Customer Summary Report</a>.</td>
</tr>
<tr>
<td>Customers By Sales Orders</td>
<td>This snapshot shows the total of the approved sales orders for each customer during the date range you select.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the <a href="mailto:salesorders@netsuite.com">Sales Orders by Customer Summary Report</a>.</td>
</tr>
<tr>
<td>Customers By Total Pipeline</td>
<td>This snapshot shows the top customers by total pipeline. The total pipeline includes the projected amount of all opportunities and estimates that are open as of the date you choose. This excludes the total of opportunities with estimates set to be included in the forecast.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the <a href="mailto:totalpipeline@netsuite.com">Total Pipeline by Customer Summary Report</a>.</td>
</tr>
<tr>
<td>Earned Value</td>
<td>This snapshot shows the top projects by earned value as of the date you choose. This data illustrates the effectiveness of project resources.</td>
</tr>
<tr>
<td></td>
<td>This snapshot is based on the <a href="mailto:earnedvalue@netsuite.com">Earned Value by Project Report</a>, which includes data on the difference between projects' earned value and planned value, and the difference between projects' earned value and actual cost.</td>
</tr>
<tr>
<td>Report Snapshot</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Forecast By Status</td>
<td>This snapshot shows your forecast divided by customer statuses. This enables you to understand where sales are in the sales cycle. This snapshot is based on the Forecast by Status Summary Report.</td>
</tr>
<tr>
<td>Hosted Page Hits</td>
<td>This snapshot shows you the number of hits to Web pages hosted in your NetSuite File Cabinet during the date range you choose. This snapshot is based on the Hosted Page Hits Report.</td>
</tr>
<tr>
<td>Hosted Page Hits By Unique Visitor</td>
<td>This snapshot shows the top hosted pages by unique-visitor hits in your website during the date range you choose. This snapshot is based on the Hosted Page Hits Report.</td>
</tr>
<tr>
<td>Internal Search Hits</td>
<td>This snapshot shows the keywords that website visitors are using to search within your site and the search results being returned. This snapshot is based on the Internal Search Summary Report.</td>
</tr>
<tr>
<td>Inventory Sales</td>
<td>This snapshot shows the top selling items by amount of revenue generated. This snapshot is based on the Inventory Revenue Report.</td>
</tr>
<tr>
<td>Invoices</td>
<td>This snapshot shows the top open invoices by customer during the date range you choose. This snapshot is based on the Open Invoices Report.</td>
</tr>
<tr>
<td>Items By Qty Sold</td>
<td>This snapshot shows the top selling items by quantity sold. This snapshot is based on the Sales by Item Summary Report.</td>
</tr>
<tr>
<td>Items By Sales</td>
<td>This snapshot shows the top items by sales during the date range you choose. This snapshot is based on the Sales by Item Summary Report.</td>
</tr>
<tr>
<td>Items By Sales Orders</td>
<td>This snapshot shows the top items by sales order income during the date range you choose. This snapshot is based on the Sales Orders by Item Summary Report.</td>
</tr>
<tr>
<td>Keywords By Revenue</td>
<td>This snapshot shows the top keywords website customers enter in search engines by the revenue generated from customers who used those keywords during the date range you choose. This snapshot is based on the Search Engine Keywords Summary Report.</td>
</tr>
<tr>
<td>Keywords By Visitors</td>
<td>This snapshot shows the top keywords website customers enter in search engines and follow results to your site during the date range you choose. This snapshot is based on the Search Engine Keywords Summary Report.</td>
</tr>
<tr>
<td>Lead Sources By Activity</td>
<td>This snapshot shows the top lead sources by the quantity of lead records entered in NetSuite during the date range you choose. This snapshot is based on the Lead Source Analysis Summary Report.</td>
</tr>
<tr>
<td>Open Escalations</td>
<td>This snapshot shows the number of escalated cases during the range you choose grouped by employee. This snapshot is based on the Open Escalations report.</td>
</tr>
<tr>
<td>Open Estimates</td>
<td>This snapshot shows the estimates with the highest projected amounts expected to close during the date range you select. Open estimates have a probability between 0% and 100% and have not been closed by an order or actual.</td>
</tr>
<tr>
<td>Report Snapshot</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open Opportunities</td>
<td>This snapshot shows the opportunities with the highest projected amounts expected to close during the date range you select. Open opportunities have a probability between 0% and 100% and have not been closed by an order or actual. This snapshot is based on the Opportunities to Close Detail Report.</td>
</tr>
<tr>
<td>Open Sales Orders</td>
<td>This snapshot shows the top open sales orders by customer during the date range you choose. This snapshot is based on the Open Sales Orders Report.</td>
</tr>
<tr>
<td>Page Hits</td>
<td>This snapshot shows the top pages by hits in your website during the date range you choose. This snapshot is based on the Page Hits Report.</td>
</tr>
<tr>
<td>Page Hits By Unique Visitors</td>
<td>This snapshot shows the top pages by unique-visitor hits in your website during the date range you choose. This snapshot is based on the Page Hits Report.</td>
</tr>
<tr>
<td>Partners By Activity</td>
<td>This snapshot shows the top partners by the quantity of activities they have entered in NetSuite during the date range you choose. This snapshot is based on the Partner Activity Summary Report.</td>
</tr>
<tr>
<td>Partners By Customer Acquisition</td>
<td>This snapshot shows the top partners by the quantity of customers they acquired in the date range you choose. This snapshot is based on the Customers by Partner Summary Report.</td>
</tr>
<tr>
<td>Partners By Sales</td>
<td>This snapshot shows the top partners by sales during the period you choose. This snapshot is based on the Sales by Partner Summary Report.</td>
</tr>
<tr>
<td>Partners By Sales Orders</td>
<td>This snapshot shows the top partners by sales order totals during the date range you choose. This snapshot is based on the Sales Orders by Partner Summary Report.</td>
</tr>
<tr>
<td>Pipeline By Status</td>
<td>This snapshot shows the total of the open estimates and opportunities expected to close in the date range you choose grouped by status. This snapshot is based on the Pipeline by Status Summary Report.</td>
</tr>
<tr>
<td>Promotion By Sales Orders</td>
<td>This snapshot shows sales order income by promotion during the date range you choose. This snapshot is based on the Sales Orders by Promotion Code Summary Report.</td>
</tr>
<tr>
<td>Prospects</td>
<td>This snapshot shows the top prospects by projected value of estimates expected to closed during the date range you choose. This snapshot is based on the Prospect Analysis Summary Report.</td>
</tr>
<tr>
<td>Referrer By Revenue</td>
<td>This snapshot shows the top referring websites by the revenue they deliver during the date range you choose. This snapshot is based on the Referrer Summary Report.</td>
</tr>
<tr>
<td>Referrer By Visitors</td>
<td>This snapshot shows the top referring websites by the quantity of shoppers they deliver during the date range you choose. This snapshot is based on the Referrer Summary Report.</td>
</tr>
<tr>
<td>Report Snapshot</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sales Reps By Activity</td>
<td>This snapshot shows the top sales reps by the number of sales activities they have initiated during the time period you select. Activities include events, tasks, notes, messages, and campaigns. This snapshot is based on the Sales Activity by Sales Rep Summary Report.</td>
</tr>
</tbody>
</table>
| Sales Reps By Forecast          | This snapshot shows the top sales reps by forecast for the date range you select. The forecast includes:  
  - total income and reimbursed expenses from customers  
  - total value of open estimates that are set to be included in the forecast and are expected to close in the period you have selected  
  - total value of open opportunities that are expected to close in the period you have selected and do not include an estimate that is set to appear in the forecast  
  Note: The values of the estimates and opportunities that are included in the forecast depend on the preferences you have set at Setup > Sales > Preferences > Sales Preferences on the Forecasts subtab. This snapshot is based on the Alt. Sales and Billings Forecast vs. Quota Report. |
| Sales Reps By Pipeline          | This snapshot shows the top sales reps by pipeline. This snapshot includes open estimates and opportunities expected to close in the date range you select. This snapshot is based on the Pipeline by Sales Rep Summary Report.                                                                                                                                                                                                                     |
| Sales Reps By Sales             | This snapshot shows the top-selling sales reps for the date range you select. This snapshot is based on the Sales by Sales Rep Summary Report.                                                                                                                                                                                                                                                                                        |
| Sales Reps By Sales Orders      | This snapshot shows the top-selling sales reps by sales orders for the date range you select. This snapshot is based on the Sales Orders by Sales Rep Summary Report.                                                                                                                                                                                                                                                                                       |
| Sales Reps By Sales Orders Alt. Sales | This snapshot shows the sales reps with the greatest dollar amounts of sales orders, based on alternate sales amounts (ASA), for the date range you select. This snapshot is based on the Sales Orders by Sales Rep Summary Report.                                                                                                                                                                    |
| Sales Reps By Total Pipeline    | This snapshot shows the top sales reps by total pipeline. This snapshot includes all estimates and opportunities that are open as of the date you select on the snapshot. This snapshot is based on the Total Pipeline by Sales Rep Summary Report.                                                                                                                                                                       |
| Support Reps By Closed Cases    | This snapshot shows the top support reps by the quantity of closed cases during the date range you choose. This snapshot is based on the Closed Case Analysis Summary Report.                                                                                                                                                                                                                                                              |
| Support Reps By Open Cases      | This snapshot shows the top support reps by the quantity of open cases during the date range you choose. This snapshot is based on the Open Case Analysis Summary Report.                                                                                                                                                                                                                                                                    |
| Time by Employee                | This snapshot shows the employees who have the most time recorded during the date range you choose. This snapshot is based on the Time by Employee Summary Report.                                                                                                                                                                                                                                                                               |
| Time by Item                    | This snapshot shows the service items with the most time recorded against them during the date range you choose. This snapshot is based on the Time by Item Summary Report.                                                                                                                                                                                                                                                                              |
Adding a Report Snapshot Portlet

### Report Snapshot

<table>
<thead>
<tr>
<th>Report Snapshot</th>
<th>Description</th>
</tr>
</thead>
</table>
| Time by Project | This snapshot shows the projects with the most time recorded against them during the date range you choose.  
This snapshot is based on the *Time by Customer Summary Report*. |
| Total Open Estimates | This snapshot shows the estimates with the highest projected amounts that were open as of the date you select. Open estimates have a probability between 0% and 100% and have not been closed by an order or actual.  
This snapshot is based on the *Total Open Estimates Report*. |
| Total Open Opportunities | This snapshot shows the opportunities with the highest projected amounts that were open as of the date you select. Open opportunities have a probability between 0% and 100% and have not been closed by an order or actual.  
This snapshot is based on the *Total Open Opportunities Detail Report*. |
| Total Pipeline By Statuses | This snapshot shows the projected and weighted total of all the open estimates and opportunities for each customer status.  
Only estimates that are marked to be included in forecasts are included in this report.  
Only opportunities that have not been converted to estimates or other transactions are included.  
This snapshot is based on the *Total Pipeline by Statuses Summary Report*. |
| Utilization | This snapshot shows the employees with the highest productivity during the date range you choose.  
This snapshot is based on the Utilization by Employee report. |
| Web Items Ordered | This snapshot shows you the quantity of website orders by item during the period you choose.  
This snapshot is based on the *Item Orders Report*. |
| Web Items Ordered By Unique Visitors | This snapshot shows the top items by quantity that were ordered from unique visitors in your website during the period you choose.  
This snapshot is based on the *Item Orders Report*. |

### Setup Options for Comparative Sales Report Snapshots

Most report snapshots let you compare at most two date ranges. For Comparative Sales Report Snapshots, including Comparative Sales, Comparative Sales (Orders), and Comparative Sales (Orders Alt. Sales), you can choose whether to compare two or three date ranges in a snapshot line graph. For both two and three data point comparisons, a number of standard date range sets are provided. Additionally, you can define custom date ranges for either sort of comparison, of the type you choose: daily, weekly, monthly, quarterly, or yearly.

Report setup options are different for comparative sales report snapshots than for other report snapshots. Click **Set Up** in this type of portlet to open a popup where you can:

- Define the number of data points to be graphed in the snapshot (2 or 3).
- Select a set of standard date ranges, or select Custom to create your own set of date ranges, for comparison.
  - If you select Custom, you need to:
    - Select a time interval for date ranges in the Date Range Type dropdown list: daily, weekly, monthly, quarterly, or yearly. The following topics for lists of date range comparisons that are available:
- **Standard Two-Point Date Range Comparisons**
- **Standard Three-Point Date Range Comparisons**

  - Select specific date ranges in the grid below. (The grid's date range fields become dropdown list selectors after Custom is selected for Date Range.)
  - Select a default chart type for the portlet data. Note that comparative sales report snapshots support a different set of chart types than other report snapshots: Area, Line, Column, and Bar.
  - Select a chart theme to define the look and feel of chart data.
  - Select a chart background to define the display behind chart data.
  - Select the color for each date range. (If you do not make selections here, defaults for the selected chart theme are used.)

You also can select or change a standard date range comparison from a dropdown list in the portlet, and click portlet thumbnails to change the type of chart displayed.

### Standard Two-Point Date Range Comparisons

The following standard date range sets are available for two data point comparisons:

- Today vs Yesterday
- This Week vs Last Week
- This Month vs Last Month
- This Month vs Same Last Year
- This Month vs Same Last Qtr
- This Qtr vs Last Qtr
- This Qtr vs Same Last Year
- This Year vs Last Year
- Last Month vs Month Before Last
- Last Month vs Same Last Qtr
- Last Month vs Same Last Year
- Last Qtr vs Qtr Before Last
- Last Qtr vs Same Last Year
- Last Year vs Year Before Last

For more information, see [Setting Up KPI Comparisons](#).

### Standard Three-Point Date Range Comparisons

The following standard date range sets are available for three data point comparisons:

- Today vs. Yesterday vs. 2 Days Ago
- This Week vs. Last Week vs. Week Before Last
- This Month vs. Last Month vs. Month Before Last
- This Month vs. Last Month vs. Same Last Year
- This Month vs. Same Last Year vs. Same Year Before Last
- This Month vs. Same Last Qtr vs. Same Qtr Before Last
- This Month vs. Same Last Qtr vs. Same Last Year
- This Qtr vs. Last Qtr vs. Qtr Before Last
Adding a Report Snapshot Portlet

This Qtr vs. Last Qtr vs. Same Last Year
This Qtr vs. Same Last Year vs. Same Year Before Last
This Year vs. Last Year vs. Year Before Last
Last Three Months
Last Month vs. Same Last Qtr vs. Same Qtr Before Last
Last Month vs. Same Last Year vs. Same Year Before Last
Last Three Qtrs
Last Qtr vs. Same Last Year vs. Year Before
Last Three Years

For more information, see Setting Up KPI Comparisons.

Creating Custom Report Snapshots

If standard report snapshots are not providing the information that you need, you can create custom report snapshots to be displayed in dashboard portlets. To create a custom snapshot, customize a standard report that currently generates snapshots, and create a snapshot of the customized report when you run the report.

You can create custom report snapshots only from reports that currently are used to generate standard report snapshots. For a list of these reports, see Reports Available for Custom Report Snapshots.

To create a custom report snapshot:

1. Open the report you want to customize.
   For a list of reports you can use, see Reports Available for Custom Report Snapshots.
   - Go to Reports > Reports Overview, find the report to customize, point to it and click Customize next to its name.
   - If the report is displayed in a report snapshot portlet, click View Report in the portlet's menu, and then click Customize in the report's footer area.
2. Use the Report Builder to customize the report.
   For information about how to customize a report, see the help topic Report Customization.
   
   **Important:** By default, when users click a custom report snapshot link to view detailed data, drilldown goes to the standard detail report, not to a customized detail report.
3. Click Save or Run Report.
4. On the report results page, click the Create Snapshot icon.
   
   **Note:** The Create Snapshot icon is always visible, but is only enabled for custom reports that display results data.
   1. Enter a Portlet Title that will be displayed in the header bar of this snapshot's portlet.
      The title must be unique.
   2. On the List subtab, select the columns you want to display in the narrow and wide versions of the portlet.
      The narrow version of the portlet can display only two columns.
The wide version shows only when the portlet is positioned in the center column of the dashboard.

3. On the Graph subtab, select the columns of data to show in the graph’s X and Y axes.

6. Click Save.

This snapshot is now available for you to add to a dashboard portlet. For instructions, see Adding a Report Snapshot Portlet. When a custom snapshot is displayed in a portlet, you can click Edit to make changes.

**Note:** If you receive the error message “This record already exists” when you click Save, it means there is a previously created custom snapshot that has the same name. You can change your report snapshot title or delete the previously created snapshot. See Deleting a Custom Report Snapshot.

Deleting a Custom Report Snapshot

You can delete a custom report snapshot when it is displayed in a report snapshot portlet.

**To delete a custom report snapshot:**

1. Find the custom report snapshot on your dashboard.
2. Click the report snapshot dropdown list and select Edit.
3. From the Actions menu, select Delete.

Reports Available for Custom Report Snapshots

The only reports that you can customize to create custom report snapshots are reports that are used to generate standard report snapshots.

**Note:** The reports available to you in NetSuite depend upon your role and the features you have enabled.

The following reports can be customized to create custom report snapshots.

- Alt.Sales and Billings Forecast vs. Quota
- Campaign ROI Analysis Summary
- Campaign Response Summary
- Closed Case Analysis Summary
- Customers by Partner Summary
- Customer Profitability Summary
- Earned Value by Project
- Forecast (Outstanding) by Customer Summary
- Forecast by Item Summary
- Forecast by Sales Rep Summary
- Forecast by Status Summary
- Forecast by Customer Summary
- Hosted Page Hits Detail
- Hours & Earnings
Adding a Report Snapshot Portlet

Sales Management Snapshots

If you are a sales manager, administrator, or executive with access to sales reports, you can display sales management report snapshots in dashboard portlets. NetSuite provides the following sales management report snapshots:
Adding a Report Snapshot Portlet

- **Sales Managers by Sales Orders.** This snapshot shows the approved sales order totals for each manager and rep in a selected date range, and is based on the Sales Orders by Sales Rep Summary report.
- **Sales Managers by Forecast.** This snapshot shows the quota, actual sales, calculated forecast, and override forecast, for each manager and rep in a selected date range, and is based on the Alt. Sales and Billings Forecast vs. Quota report.
- **Sales Managers by Sales.** This snapshot shows the sales revenue by each sales manager in the selected period range, and is based on the Sales by Sales Rep report.

Sales management reports roll up and display data according to the sales management hierarchy. This hierarchy is based on the supervisors defined on employee records.

After you have added a sales management snapshot portlet, you can click **Set Up** to select the hierarchical level of data to display.

- For example, you may have four levels of hierarchy: the CEO, the sales VP, sales managers, and sales reps. If you select the 2nd level of hierarchy for a snapshot, you will see information for the CEO and the sales VP only. However, the totals include the corresponding subordinate's totals.
- In the Report Snapshot portlet, you can click a + or - sign next to a sales manager to display more or less data.

To display a sales management snapshot:

1. Click **Personalize** in the upper right corner of the dashboard. You can also use the **Personalize Dashboard** link in the **Settings** portlet.
2. On the **Report Snapshots** tab of the **Personalize Dashboard** palette, click the **Report Snapshots** icon or drag it onto the dashboard.
   - If the **Report Snapshots** tab does not display in the Personalize Dashboard panel, it means you cannot add Report Snapshot portlets to this page.
3. Click **Set Up** in the portlet's menu.
4. In the **Snapshot** dropdown list, select either of the following sales management snapshots:
   - Sales Managers by Forecast
   - Sales Managers by Sales
   - Sales Managers by Sales Orders
5. In the **Hierarchy Level** list, select the level of management data to display.
6. Click **Save**.

The snapshot portlet refreshes to display the selected level of hierarchy. From the portlet, you also can do the following:

- Change the date or period range to display results for a different time period.
- Click a + or - next to a manager's name to expand or collapse displayed data.
- Click **Refresh** to reload and update the portlet's data.
- Choose **Print**, **Download**, or **View Report** menu options.

Setting Up a Report Snapshot Portlet

When you have added a Report Snapshot portlet to your dashboard, you can configure the portlet to display data in the most useful manner.

To learn how to add a Report Snapshot portlet, see **Adding a Report Snapshot Portlet**.
To set up a Report Snapshot portlet:

1. In the report snapshot portlet, click ⋮ and select Set Up from the menu.

![Set Up menu](image)

2. The portlet setup window displays.

![Report Options window](image)

3. In the portlet setup window, you can:
   - For custom report snapshots, change the portlet title, or the name of the snapshot.
   - Use the Snapshot menu to select the report snapshot to display.
   - Use the As of or Date Range dropdown menu to change the time period for which data is displayed.
   - Choose a Display Type to indicate whether data should be displayed as a list or a graph.
Note the following about report snapshots that display lists:

- Report snapshot list text truncates at 25 characters when the report snapshot portlet is in the left or right dashboard column. To avoid this truncation, place the portlet in the middle column.
- Report snapshot list amounts are rounded to the nearest whole number and do not display decimal places.
- Graph-specific settings, including Default Chart Type, Chart Theme, Custom Series Color, and Background Type, are not available for lists.

Choose a Display Order.

- If you select Top, your data will be shown in order starting with the greatest value.
- If you select Bottom, your data will show in order starting with the lowest value.

From the How Many list, select the number of results to display. Choices include:

- Top 5
- Top 10
- Top 15
- Top 25
- Top 50

For graphs, use the Default Chart Type dropdown menu to set the default chart used for snapshot data. You can later change the chart type by clicking a thumbnail in the portlet itself.

- For comparative sales report snapshots, chart type options are Area, Line, Bar, and Column.
- For other report snapshots, chart type options are Line, Bar, Column, and Pie.

For graphs, use the Chart Theme dropdown menu to set a look and feel for chart data:

- Global Theme – uses the chart theme set in the Chart Themes section on the Home > Set Preferences page (the default). See the help topic Personal Preferences for Appearance.
- Basic – provides limited color contrast.
- Colorful – provides more color contrast.
- Match Color Theme - Bold – harmonizes with your choices in the Colors section on the Home > Set Preferences page, using bolder shades. See the help topic Personal Preferences for Appearance.
- Match Color Theme - Light – harmonizes with your choices in the Colors section on the Home > Set Preferences page, using lighter shades. See the help topic Personal Preferences for Appearance.

For graphs, use the Custom Series Color field to enter a hexadecimal value for the color you want to use for the graph. Please note that this option is provided for backwards compatibility with custom chart colors defined prior to the introduction of chart themes in Version 2012 Release 2.

For graphs, use the Background Type dropdown menu to set the background display behind chart data:

- Global Background – uses the background type set on the Set Preferences page (the default)
- Lines
- Bands
- Grid
4. When you have finished configuring the portlet, click **Save** to save your configuration.

**Note:** Some report snapshot portlets do not include a Set Up link because these snapshots do not offer choices for data display. For custom snapshots, an Edit link may be available that provides some of the same settings as those available from the Set Up link.
Workbooks Overview

The Analytics portlet enables you to view your workbook pivot tables and charts on your home dashboard. You can add up to 10 Analytics Portlets, and each portlet can display one chart or pivot table. You can select any workbook-based chart and pivot table available in your account. The list includes all your saved workbooks and any workbooks that have been shared with you by other users.

You can set layout options for the displayed portlets. For charts, you can set the portlet size and chart type. For pivot tables, you can set the height of the portlet by entering the number of visible rows you want to view at a glance. These settings apply only to the portlet.

You can also open workbooks through the portlet. If you do not own the workbook but you have the Analytics Administrator permission, you can view, edit, and delete workbooks created by other users in your NetSuite account. For more information about the Analytics Administrator, see the help topic The Analytics Administrator Permission.

Note: To set up the Analytics Portlet on your dashboard, the SuiteAnalytics Workbook feature must be enabled. For more information see the help topic Enabling SuiteAnalytics Workbook in Your NetSuite Account.

Adding an Analytics Portlet

You can add an Analytics portlet to a dashboard in the same manner that you add other portlets, but this portlet is not available unless the SuiteAnalytics Workbook feature has been enabled.

To add an Analytics portlet to a dashboard:

1. Click Personalize in the upper right corner your dashboard. You can also use Personalize Dashboard in the Settings portlet.
2. On the Standard Content tab of the Personalize Dashboard palette, click the Analytics icon or drag it onto the dashboard.

For more information about setting up the portlet, see Setting Up the Analytics Portlet.
Adding an Analytics Portlet

If the **Personalize Dashboard** palette does not include the Analytics portlet, the Analytics Workbook feature has not been enabled. See the help topic [Enabling SuiteAnalytics Workbook in Your NetSuite Account](#).

After adding an Analytics portlet, you must click **Set Up** in the portlet to select a workbook-based chart or pivot table and define the layout options. For more information, see [Setting Up the Analytics Portlet](#).

### Setting Up the Analytics Portlet

After you have added an Analytics portlet to your home dashboard, you must click the **Set Up** option in the upper right corner to select the chart or pivot table you want to view. You can select a unique chart or pivot table per portlet.

**To set up the Analytics Portlet:**

1. Click **Set Up** in your Analytics Portlet.
2. In the **Analytics** popup window, select the chart or pivot table by clicking one of the options available from the list on the left panel. Charts are represented by the **Chart** icon, and pivot tables are represented by the **Pivot** icon. Optionally, you can use one of the following options to identify the chart or pivot table:
   - From the **Portlet type** drop-down list, filter by charts or pivot tables by selecting one of the portlet types.
   - In the **Search** field, enter part of the name of the workbook, chart, or pivot table that you want to view.

3. After selecting the chart or pivot table, the **Settings** options are displayed on the right.
4. In the **Settings** panel, you can do the following:
   - For both pivot tables and charts, in the **Custom name** field, enter a title for the portlet. If you leave this field empty, the portlet displays the name of the workbook and the chart or pivot table, as defined in SuiteAnalytics Workbook. The title entered is for the portlet only. It does not apply to the workbook.
   - For charts, select the size of the portlet. Available sizes are **Short**, **Medium**, and **Tall**.
   - For pivot tables, enter the number of visible rows in the portlet. The portlet height is automatically resized to fit the number of rows entered. If the result rows exceed the number entered, a scroll bar appear in the right that you can use to see all results.
5. Click Save.
   The chart or pivot table appears in the portlet.

### Viewing the Workbook Data in the Analytics Portlet

After you have set up the Analytics portlet in your home dashboard, you can still change some layout options to view your data.

To view the workbook data in the Analytics portlet, you can do the following:

- **For both pivot tables and charts:**
  - Expand the view to full-screen by clicking the double arrow icon.
  - View any changes made in the SuiteAnalytics Workbook by clicking the refresh icon.
- **For charts only:**
  - In the upper-left corner of the portlet, change the chart type by clicking the drop-down arrow, and then click the thumbnail. Available chart types are as follows:
    - Basic – Column Chart, Bar Chart, Area Chart, and Line Chart.
    - Stacked – Column Chart, Bar Chart, Area Chart, and Area Chart.

For more information about the different chart types, see the help topic Chart Types.

### Opening Workbooks from the Analytics Portlet

After selecting a workbook-based chart or pivot table for the Analytics portlet, you can access and edit the associated workbook through the portlet.

**Note:** To edit workbooks that you do not own, you must have the Analytics Administrator permission. For information about the Analytics Administrator permission, see the help topic The Analytics Administrator Permission.

**To open a workbook from the Analytics portlet:**

1. Click the menu icon in the upper-right corner of the portlet.
2. Select Open in Workbook from the dropdown menu.

   The workbook opens in a new browser tab.

For more information about workbook pivot tables and charts, see the help topics Creating a Workbook and Workbook Charts.
Publishing Dashboards Overview

The NetSuite user interface is role-based, so that your role determines the set of tabbed pages, or center, that displays when you log in. Centers are tied to functional areas, such as Accounting, Marketing, Sales, and Support. NetSuite provides a default visual workspace, or dashboard, for each tabbed page, and lets you personalize your dashboards to fit your business. Administrators can share, or publish, their personalized dashboards to users logging in to the same center. A published dashboard can include one tabbed page, or multiple pages.

Published dashboards provide a consistent interface to users with related roles. This uniformity in dashboards' appearance can make it easier for users to work together, because they have ready access to the same data. Publishing dashboards also can save time, by allowing an administrator to set up dashboards for an entire team of users.

Permissions and Roles

To get started publishing dashboards, you need to understand the following:

- To publish dashboards, you must have the Publish Dashboards permission. A few administrative roles have this permission assigned by default, but most users do not. For more information, see Publish Dashboards Permission.
- When you have the Publish Dashboards permission, you can publish dashboards to other users, designated by role. You can only publish a dashboard to roles that tie to the same center in which you have personalized the dashboard. For example, if your role is set to Account Administrator when you personalize a dashboard, you can publish it only to roles tied to the Classic center. If your role is set to Sales Administrator, you can publish a personalized dashboard only to roles tied to the Sales center. For more information, see Publish Dashboards Permission.

Publishing a Dashboard

To publish a dashboard, you need to complete the following two steps:

1. **Personalize the dashboard you want to publish** – After you have verified that you have the Publish Dashboards permission, and logged in with the appropriate role, the next step to publishing a dashboard is to personalize one or more of your own tabbed pages to fit the team's business needs. Personalization can involve changes you make to the standard NetSuite tabs or the creation of custom tabs of your own. See Dashboard Personalization and Creating Center Tabs.

2. **Publish the dashboard** – When you have finished personalizing your own tabbed pages, you can publish one or more of them to appear on other users' tabs. See Publishing a Dashboard.

When you publish a dashboard, you make the following choices. Note that some choices can be changed after you have published the dashboard, and others cannot.

- The roles to which the dashboard should be published. (Can be changed later.)
- Whether the dashboard should be published to new users only or to both existing and new users, replacing existing users' dashboards. (Can be changed later.)
- The tabbed pages to include in the dashboard. **(Cannot be changed later.)**
- The restriction levels for users' dashboard personalizations. **(Cannot be changed later.)**

After you have published a dashboard, you can make further changes to it and copy your published dashboard to any of your accounts. See the following topics:
To make further changes to a published dashboard and apply these changes to users’ dashboards, see Applying Changes to Published Dashboards.

To copy a published dashboard to another of your accounts, see Copying a Published Dashboard to Another Account.

Publish Dashboards Permission

To publish dashboards, you must have the Publish Dashboards permission. A few administrative roles have this permission assigned by default, but most users do not. When you use the Publish Dashboard button, the dashboard will appear in the state of the dashboard for you and your corresponding role that is currently logged into NetSuite. If you make a change to a published dashboard, the dashboard will publish with those edits included. It is not possible to revert back to dashboard settings that were previously published.

If you have the Publish Dashboards permission, a Publish Dashboard link displays in the Settings portlet on your home page. If this link is not available, you do not have the permission.

For information, see the following topics:

- Roles with Publish Dashboards Permission
- Adding the Publish Dashboards Permission
- Can Publish to Own Center Only

Roles with Publish Dashboards Permission

By default, the Publish Dashboards permission is available to users assigned the following roles:

- Administrator – can publish dashboards to users assigned roles in the Classic Center.
- Intranet Manager – can publish dashboards to users assigned roles in the Ecommerce Management Center.
- Issue Administrator – can publish dashboards to users assigned roles in the Engineering Center.
- Marketing Administrator – can publish dashboards to users assigned roles in the Marketing Center.
- Product Manager – can publish dashboards to users assigned roles in the Support Center.
- QA Manager – can publish dashboards to users assigned roles in the Engineering Center.
- Sales Administrator – can publish dashboards to users assigned roles in the Sales Center.
- Support Administrator – can publish dashboards to users assigned roles in the Support Center.
- System Administrator – can publish dashboards to users assigned roles in the System Administrator Center.

Adding the Publish Dashboards Permission

If additional users require the Publish Dashboards permission, for example, in cases where centers do not have any existing roles with this permission, the account administrator can customize the users’ roles to add the permission, or create a custom role with the permission.

For example, to allow the publishing of a dashboard to roles that use the Advanced Partner Center role, the account administrator can create a customized Advanced Partner Center role, add the Publish Dashboards permission to it, and assign the role to the user who needs to publish the dashboard.
The Publish Dashboards permission is listed on the Setup subtab of each Role record’s Permissions subtab. For more information, see the help topic Customizing or Creating NetSuite Roles.

**Note:** If the Global Permissions feature is enabled, the account administrator can add the Publish Dashboards permission directly to employee records’ Global Permissions subtab, to be applicable to all of the employees’ assigned roles.

### Can Publish to Own Center Only

Be aware that even with the Publish Dashboards permission, you can publish dashboards only to other users with roles tied to the same center where you have personalized your dashboard, because only roles tied to the same center share the same set of tabbed pages. For example, if you are logged in as a sales administrator when you personalize a dashboard, only sales roles are available when you attempt to publish that dashboard.

The account administrator generally uses the Classic Center, which may not be shared with many other users. For this user to publish dashboards to users with roles in other centers, he or she must be assigned an additional role for each center where a published dashboard is needed. If any of these roles do not have the Publish Dashboards permission, it needs to be added. Then, this user can log in with each role to personalize and publish a dashboard to roles for the related center.

In other cases, it may make more sense for different users to publish dashboards to different centers. In all cases, you should be aware of the center for your role, know which other roles share your center, and ensure that you have the Publish Dashboards permission, BEFORE you personalize a dashboard that you want to publish.

**Note:** Dashboards published to the Advanced Partner Center are published to partner contacts as well as partners. If a partner or a partner contact modifies the dashboard content by, for example, adding a portlet, this change will appear on the dashboards of the partner and all partner contacts logged in using the same role.

### Publishing a Dashboard

You can share your personalized dashboard with other users in your center by publishing it. A published dashboard can consist of one tabbed page or of multiple pages. When you publish a dashboard, you define the roles for users who will see the published dashboard, and what changes users will be able to make to the published dashboard.

**Note:** The minimum required screen width size when using a three column layout is 1400 pixels.

Before you attempt to publish a dashboard:

- Verify that you have the Publish Dashboards permission by checking for the Publish Dashboard link in your home page Settings portlet.
- Verify that the role you are currently using shares the same center as the roles to which you want to publish the dashboard. Do not begin personalizing a dashboard until you are sure that your role can publish to the users you want!
  
  For more information, see Publish Dashboards Permission.
- Personalize the home page by adding portlets that you want to be part of the published home page dashboard. For more information, see Setting Up Dashboard Portlet Content.
**Note:** Please note that if your dashboard contains a calendar portlet that displays My Calendar, the published dashboard users will see their personal calendar, not the publisher’s one.

- Personalize one or more of your own tabbed pages to be part of the published dashboard. You can personalize a page by making changes to a standard NetSuite tabbed page, as described in [Dashboard Personalization](#). Or, you can create your own custom tabbed page, as described in [Creating Center Tabs](#).

When you create a custom tab, you select the centers where it will display. For example, for a tab used by sales reps, you would select the Sales Center, and for a tab used by accounting clerks, you would select the Accounting Center. You also have the option of making a tab display in all centers. However, be aware that tabs applied to all centers are not available in published dashboards.

**To publish a dashboard:**

1. Go to your home page, and in the **Settings** portlet, click **Publish Dashboard**.
2. On the Publish Dashboard page, enter a name for the dashboard in the **Name** field, and, if desired, descriptive text in the **Notes** field. These fields are for your reference only and are not exposed to other users.
3. If you want to prevent users from removing Shortcuts portlet links on the published dashboard's pages, check the **Lock Shortcuts** box.
   - When you enable this option, users still can add and reorder links in their Shortcuts portlets.
   - For information about the Shortcuts portlet, see **Shortcuts Portlet**.
4. To prevent users from removing Create New menu links on the published dashboard's page, check the **Lock New Bar** box.
   - When you enable this option, users still can add and reorder links in their Create New menu.
   - For information about the Create New menu, see the help topic **Using the Create New Menu**.
5. On the **Apply To Roles** subtab, select the roles to which you want to publish this dashboard and indicate whether to publish the dashboard to new users only or to both new and existing users.
   1. Select a role from the **Role** list.
      - Only roles tied to the center that your current role uses are listed here, because you can only publish a dashboard to roles that share your center. If a role is not listed here, you cannot publish the dashboard to it when you are logged in with your current role. You may be able to log in with a different role, personalize a dashboard, and publish it to additional roles. For more information, see **Publish Dashboards Permission**.
      - Roles that are inactive are not included in the list.
   2. By default, for a dashboard being published for the first time **Override existing user's settings** is set to **Yes**, indicating that this dashboard should be published to existing users with the selected role, replacing their current dashboards. Clear this check box if you want to publish the dashboard only to new users assigned the selected role.
   3. Click **Add**.
   4. Repeat the preceding steps for additional roles to which you want to publish the dashboard.
      - Only a part of the published dashboard content may be available to some users. Users can view only the dashboard content that their assigned roles give them permission to see.
6. On the **Apply To Tabs** subtab, select the tabbed pages that you have customized to be part of the published dashboard, and choose how you want to restrict users' changes to the published dashboard's pages.
1. Check the box in the **Apply** column next to each tabbed page you want to include in this dashboard.

2. In the **Mode** column, choose the level of restriction for users' changes to the selected page:
   - **Unlocked** – lets users make all changes to the selected page.
   - **Locked** – restricts users from making any changes to the selected page.
   - **Add/Move Content** – enables users to add and rearrange portlets on the selected page, and at the same time prevents them from removing portlets.

   ![Note:](image)
   The **Add/Move Content** option prevents users from removing not only portlets that were added as part of the published dashboard but also the portlets they added themselves.

   For more information, see Restricting Users’ Dashboard Personalizations.

   **Important:** After you have saved a published dashboard, you cannot redefine which tabbed pages are included or change their restriction modes, so make these choices very carefully.

7. Click **Save**.
   The published dashboard is applied to users assigned the selected roles. They may need to log out and log back in to the system for changes to be visible. They also may need to clear their browser cache.

### Assigning Published Dashboards to Users

You define the users for a published dashboard by selecting one or more roles when you first publish it. After the dashboard has been published, you can add or remove roles to change the users.

All of a published dashboard's information may not be available to all of its users. Users can view only the dashboard content that their assigned roles give them permission to see.

**To assign saved dashboards to users:**

1. Go to your home page, and in the Settings portlet, click **List** next to **Publish Dashboard**.
   A list of your dashboards appear.

2. Click **Edit** next to the name of the dashboard for which you want to change assigned users.

3. On the **Apply To Roles** subtab of the Published Dashboard page, you can:
   1. Add a role to which the dashboard should be published by placing the cursor in a blank line, selecting a role from the **Role** list, and clicking **Add**.
      By default, for a previously published dashboard **Override existing user's settings** is set to **No**, indicating that the dashboard will be published only to new users assigned the selected role. Check this box to change it to **Yes** if you want to publish the dashboard to existing users with the selected role, replacing their current dashboards.
   2. Remove a previously selected role from the published dashboard's list by selecting the role and clicking the **Remove** button.

4. Click **Save**.
   The published dashboard is applied to users with the selected roles. They may need to log out and log back in to the system for changes to be visible.
Restricting Users' Dashboard Personalizations

When you first publish a dashboard, you can set a restriction level that indicates the types of changes users can make to each tabbed page of the published dashboard.

You set this restriction level by selecting from the following three modes on the Publish Dashboard page's Apply To Tabs subtab:

- **Unlocked** – lets users make all changes to the selected page.
- **Locked** – restricts users from making any changes to the selected page.
- **Add/Move Content** – enables users to add and rearrange portlets on the selected page, and at the same time prevents them from removing portlets.

**Note:** The Add/Move Content option prevents users from removing not only portlets that were added as part of the published dashboard but also the portlets they added themselves.

When selecting a mode for each tabbed page, or tab, included in the published dashboard, you can specify different modes for each tab.

After you have saved a published dashboard, you cannot modify these modes, so make your selections very carefully!

**Note:** Each Publish Dashboard page has options for locking the Shortcuts portlet and the New Bar so that users cannot remove links. These options can be changed after a dashboard has been published.

Applying Changes to Published Dashboards

When you make changes to a personalized dashboard that you have published, you can apply these changes to the dashboards of all or some of the users for the published dashboard, based on users' assigned roles.

**To change a published dashboard:**

1. Log in with the role you were using when you published the dashboard.
2. Make changes to one or more of your dashboards that you previously published to other roles.
3. Go to your home page, and in the Settings portlet, click List next to Publish Dashboard.
4. Click Edit next to the dashboard you want to reapply to other roles.
5. On the Apply To Roles subtab of the Publish Dashboard page, you can apply your changed dashboard to users’ dashboards based on their roles.
   
   For each role to which you want to apply the changed dashboard, check the box in the Override existing user's settings column.
   
   If you checked this box for a role when you initially published the dashboard, this box is not checked now. If you want to apply these changes to that role, you must check this box again.
6. Click the Save and Update Content button.

**Note:** If you click the Save button, the dashboard definition is saved, but the changes are not applied to users' dashboards.

Your changes to this published dashboard are applied to users assigned the selected roles. They may need to log out and log back in to the system for changes to be visible. Depending on your browser’s...
caching settings, users may need to manually refresh the page for each dashboard that has been updated.

Applying Updates for Bundled Published Dashboards

Changes to a dashboard installed by a bundle may be applied automatically, as part of bundle updates, to the dashboards of users with roles to whom the dashboard was previously published.

Whether these automatic updates to users’ dashboards occur depends upon the setting for a related bundle preference. The user who updates the bundle in your account can indicate whether bundled dashboard updates should be applied only to the dashboard definition, or to both the definition and to the dashboards of all users with roles to which the dashboard was previously published.

If the updates are applied only to the dashboard definition, you can follow steps 2-6 above to apply updates to users’ dashboards as desired. For information about the bundle update process, see the help topics Installed Bundle Updates, Reviewing the Preview Bundle Update Page, and Set Bundle Update Preferences.

Copying a Published Dashboard to Another Account

After you have published a dashboard, you can copy it to another of your accounts.

You can use SuiteCloud Development Framework (SDF) to manage published dashboards as part of file-based customization projects. For information about SDF, see the help topic SuiteCloud Development Framework Overview.

You can use the Copy to Account feature to copy an individual published dashboard to another of your accounts. Each published dashboard page has a clickable Copy to Account option in the upper right corner.

Note: Only supported portlets in a dashboard are copied. See the help topic Customizations Supported by SuiteCloud Development Framework.

Before you copy a dashboard to another account, you must complete the following two steps:

1. Check that the NetSuite accounts you want to copy to and from meet specific requirements. See the help topic Copy to Account Overview.
2. Enable the Copy to Account feature. See the help topic Setting Up Copy to Account.

To copy a published dashboard to another account

1. Go to your home page, and in the Settings portlet, click List next to Publish Dashboard.
   A list of your dashboards appears.
2. Click Edit next to the name of the dashboard that you want to copy.
3. To start the Copy to Account process, click the Copy to Account option in the upper right corner and follow the steps described in Using Copy to Account.
FAQ: Dashboards

See the questions and answers below for information on Dashboards.

What is a dashboard?

The collection of tabbed pages in your NetSuite user interface is your dashboard. This collection includes a Home page, and other pages that vary according to the role you use to log in to NetSuite. Your dashboard content is displayed in portlets, dynamic data display windows. See Dashboards Overview.

You can personalize your dashboard pages to include the portlets you need to make decisions and complete tasks. See Dashboard Personalization.

If you have sufficient permissions, you can publish a personalized dashboard to other users, so you all have a consistent user interface. See Publishing Dashboards Overview.

See the following topics.

- Adding a Portlet to a Dashboard
- Arranging Dashboard Portlets
- Setting Up Dashboard Portlet Content
- Publishing a Dashboard

Why can't I publish my dashboard to all of the roles I want to use it?

To publish dashboards, you must have the Publish Dashboards permission. A few administrative roles have this permission assigned by default, but most users do not. For information about this permission, see Publish Dashboards Permission.

When you have this permission, you can personalize a dashboard and publish it to a subset of users. This subset consists of the users that log into the same center that you do with the role you are using when you personalize the dashboard. Centers are tied to functional areas, such as Accounting, Marketing, Sales, and Support. For example, if you are logged in with the Sales Administrator role, you can personalize your dashboard and publish it to all other users that log in to the Sales Center.

If you want to publish dashboards to users of multiple centers, you need to log in with a role that uses each center to create the dashboard to be published to each center’s users.

See the following topics.

- Publishing Dashboards Overview
- Publishing a Dashboard

How can I set up my NetSuite interface to see the same tabs and organization as an administrator?

NetSuite centers have been designed to display different tabs for different roles to accommodate the workflow of different users. For example, a sales person role displays the Sales Center when logged in, which includes tabs for Leads, Prospects, and Customers.

NetSuite provides a Use Classic Interface option to let users see the same tab navigation as an administrator. This navigation includes the following tabs: Home, Activities, Transactions, Lists, Reports, Setup, and Support tabs, followed by any custom tabs. Note that the functions available to a role do not change according to the interface being used; only the presentation of tabs and the organization of functions within tabs are affected.
To switch your interface to show the same tabs and organization as an administrator role:

1. Navigate to
2. Click the Appearance subtab.
3. Under Centers & Dashboards, check the Use Classic Interface box.
4. Click Save.

**Note:** The Use Classic Interface option is not available for the administrator and full access roles, because these roles already use the classic interface.

See the following topics.

- Centers Overview
- The Classic Center
- Setting Personal Preferences
- Personal Preferences for Appearance

How can I change the fields available in my Quick Add portlet?

The fields in the Quick Add portlet for each standard record type are based on the Quick Add fields defined for the user's preferred record type form. Quick Add fields on standard forms are system-defined. Quick Add fields on custom forms can be modified. Users with sufficient permissions can customize a form by clicking its Customize button, or by going to Customization > Forms > Entry Forms (or Transaction Forms for Opportunity), and selecting Edit for the form. To indicate that a field should be included in the Quick Add portlet, check its box in the Quick Add column on the subtabs of the Fields subtab (or Screen Fields subtab for Opportunity).

By default, only the Name field is provided for custom record Quick Add portlet data entry. To allow data entry for other custom record custom fields, you can enable the per field Allow Quick Add option. Each field with this option enabled displays in the Quick Add portlet. By default, this option is not enabled.

For more information, see **Quick Add Portlet**.

See the following topics.

- Custom Records
- Custom Forms
- Adding a Portlet to a Dashboard
- Quick Add Portlet

How do I create custom KPIs?

NetSuite's standard KPIs may not include some data that you would like to display in summary form, as a key performance indicator, on your dashboard. In this case, you can find a preexisting saved search that compiles this data or create a new saved search for this purpose. Selecting an Existing Search to be a Custom KPI and Creating a New Search to be a Custom KPI.

After you have identified or created a saved search with the data you want, you can define the saved search as a custom KPI to be displayed in the Key Performance Indicators portlet.

**To display a saved search as a custom KPI in the Key Performance Indicators portlet:**

1. Click Set Up in the Key Performance Indicators portlet.
2. On the **Key Performance Indicators** subtab of the Set Up Key Performance Indicators page, click **Add Custom KPIs**.

3. Find and click on the saved search that you want to show as a KPI in the portlet, then click **Done**.

4. Click **Save**.

You can display up to ten custom KPIs in each Key Performance Indicators portlet. For more information, see **Adding a Custom KPI to the Key Performance Indicators Portlet**.

You also can display saved searches as custom KPIs in these other portlets:

- You can define up to ten custom KPIs to be used in each KPI scorecard's calculations. See **Using a Custom KPI in a KPI Scorecard**.
- Custom KPIs displayed in the Key Performance Indicators portlet also are available for display in KPI Meter portlets. You can display up to three KPI meters on a dashboard. See **KPI Meters**.
- You can add up to five Trend Graph portlets to a dashboard. Any or all of these can display custom KPI data. See **Setting Up Trend Graph Portlets**.

Custom KPI definitions for individual KPI scorecards, the Key Performance Indicators portlet, and Trend Graph portlets are all independent of each other.

See the following topics:

- **Custom KPIs**
- **Saved Searches**
- **Key Performance Indicators Overview**
- **Trend Graphs**
- **KPI Scorecards Overview**

**How can I compare KPI results for more than two date ranges or periods?**

For each KPI that you choose to display in the Key Performance Indicators portlet, you can select two date ranges or periods for which to display summary results. This capability enables you to compare results for two date ranges or periods. See **Setting Up KPI Comparisons**.

If you want to display KPI results for more than two date ranges or periods, you should create a KPI scorecard. Each scorecard can include multiple lines of KPI data, and thus comparisons for multiple data ranges or periods. See **Creating a KPI Scorecard**.

See the following topics:

- **KPI Scorecards Overview**
- **Key Performance Indicators Overview**

**How can I fix unexpected errors in the Key Performance Indicators portlet?**

If you log into NetSuite and find an unexpected error in your Key Performance Indicators portlet, the problem may be related to custom KPIs you have set up. Typically the error message indicates the KPI that is causing the error. You can remove the custom KPI from the portlet, then review the saved search to correct the problems.

**To remove the unexpected error:**

1. Click **Set Up** in the Key Performance Indicators portlet.
   
   If there is no Set Up link, copy and paste the following URL into a new tab or window:
FAQ: Dashboards

https://system.netsuite.com/app/center/setup/snapshots.nl?kpigrp=KPI&sectionid=-29&qelem=servercontentneg62

2. Click the x button next to the problematic KPI and click Save.
3. Back on your Home dashboard, you should now be able to see your KPIs in the Key Performance Indicators portlet.

**Note:** If you continue to get an unexpected errors even after logging out of NetSuite, clearing your cache, and logging back in, then please contact Netsuite Customer Support for further investigation.

**To review the saved search on which the custom KPI is based:**

1. Navigate to . Try running the saved search used in the custom KPI to see if the error reproduces.
2. If the error reproduces, try to rebuild the saved search and see if the problem persists.

See the following topics.

- Setting Up the Key Performance Indicators Portlet
- Custom KPIs
- Accessing a Saved Search
- Dashboard Personalization

**Why are shortcuts duplicated when I publish a dashboard?**

When a user publishes a dashboard to other users, NetSuite always retains each user's personal shortcuts in each destination dashboard, even if the publisher has enabled the option to override existing user's settings. Some users may have created personal shortcuts identical to those in the published dashboard. The published dashboard's shortcuts are added to each user's personal shortcuts rather than overwriting them, so shortcuts may be duplicated for some users when a dashboard is published.

If you have duplicate shortcuts in your dashboard, you can remove your personal shortcuts to eliminate duplicates.

**To remove a shortcut:**

1. Click **Set Up** in the Shortcuts portlet to open the Set Up Shortcuts popup.
2. Clear the **Enable** box next to each shortcut that you want to remove.
   
   Note that shortcuts that were created when a dashboard was published to you appear with asterisks. The publisher may have restricted these shortcuts so that you cannot remove them.
3. Click **Save**

For more information, see the help topic, Setting up Shortcuts Portlets.

See the following topics.

- Publishing a Dashboard
- Assigning Published Dashboards to Users
- Dashboard Personalization

**How can I display search results on my home dashboard?**

If you have access to a saved search, either because you created it, the saved search is public, or you are a member of its audience, you can display the saved search results in a Custom Search portlet on your
dashboard. Each Custom Search portlet displays results for a saved search that you select. Results are updated every time the page loads. The portlet also has a Refresh link that you can click to update search results.

**To add a Custom Search portlet to your dashboard:**

1. On the page where you want to display saved search results, click **Personalize Dashboard**.
2. In the Add Content panel, under the Standard Content folder, click or drag and drop the Custom Search item.
3. In the Custom Search portlet, click **Set Up**.
4. In the Custom Search Setup window:
   1. Select a saved search from the Search dropdown list.
   2. In the **Results Size** field, enter the number of results you want displayed at one time in the portlet. If the total number of results exceeds this number, a From-To dropdown list appears in the footer that you can use to navigate among results pages.
   3. In the **Drill Down** field, select whether to open an individual result in the portlet or in a new page when you click **Edit** or **View**.
   4. (If the Inline Editing feature is enabled) Check or clear the **Allow Inline Editing** box to indicate whether records returned as search results can be edited directly in the portlet.
5. Click Save.

**To provide quick access to saved searches:**

If you do not need access to full search results on your dashboard, you can use the following alternatives for quick access to saved searches:

- Include summary results for saved searches on your dashboard, by defining them as custom KPIs, and displaying them in Key Performance Indicators, KPI Scorecard, KPI Meter, or Trend Graph portlets. See **Custom KPIs**.
- Add links to saved search results pages in your dashboard Shortcuts portlet. See the help topic **Creating Shortcuts to Saved Search Results**.

See the following topics.

- Displaying Saved Search Results on Your Dashboard
- Displaying Multiple Saved Searches on Your Home Page
- Key Performance Indicators Overview
- Dashboard Personalization

**How can I display results from more than three saved searches on my dashboard?**

You can display saved search results on your dashboard by adding a Custom Search portlet. Currently, you can add only three Custom Search portlets to a home page dashboard. However, if you would like to display results for more than three saved searches on this page, you can do one of the following:

- Display an additional saved search in a list portlet
- Set up a custom tab for your standard home page where you can add more search portlets
- Create a new custom tab and designate it to be your landing page instead of the standard home page.

For information, see the help topic **Displaying Multiple Saved Searches on Your Home Page**.
FAQ: Dashboards

See the following topics.

- Displaying Saved Search Results in Dashboard Portlets
- Setting Up a Custom Tab for a Standard Page
- Creating a New Custom Tab

How can I prevent users from inline editing search results in Custom Search portlets?

If the Inline Editing feature is enabled in your account, inline editing is available by default for all records displayed in Custom Search portlets. However, each Custom Search portlet has an Allow Inline Editing setup option that you can use to enable or disable inline editing for specific portlets.

To disable inline editing for a Custom Search portlet:

1. Click Set Up in the Custom Search portlet.
2. In the Custom Search Setup window, clear the Allow Inline Editing check box.

To limit other users’ inline editing of custom search portlets, you can disable the Allow Inline Editing option for these portlets in personalized dashboards that you publish to users. See Publishing Dashboards Overview.

See the following topics.

- Q:
- Displaying Saved Search Results in Dashboard Portlets
- Publishing Dashboards Overview
- Using Inline Editing

What can I do when a custom reminder error prevents my Reminders portlet from displaying?

It is possible that an error for a custom reminder that you have added to the Reminders portlet prevents the proper display of the Reminders portlet, so that its Set Up link is not available.

In this case, to remove the reminder from the portlet, you can edit the related saved search, clearing the Available for Reminders box. After you save this change, the problematic reminder should be removed and the portlet should be able to display.

If a custom reminder causes an error that prevents the Reminders portlet from displaying properly, edit the saved search for the reminder to clear the Available for Reminders box. After you save this change, the problematic reminder should be removed and the portlet should be able to display. (Note that you may need to do some refreshing.)

See the following topics.

- Setting Up Reminders
- Creating Custom Reminders